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Basics of SchoolTool
SchoolTool has a very straightforward design that utilizes modules, sub-modules, and
sub-module tabs (or, simply, tabs) to navigate throughout the entire application. This
hierarchy that is used for navigation is the key to using every screen within the system.
Once familiar with the basics, the consistent nature of SchoolTool allows a user to
comfortably move anywhere in the application.

Historical

SchoolTool is a historical application that holds all permanent record information on an
individual student by school year. SchoolTool also allows you to view past information
such as classes, grades, attendance, medical, and discipline information for future use
or trending. Historically, SchoolTool also keeps records for state reporting purposes.

Real-time

SchoolTool is a real-time application, which means users may experience brief pauses
while the system updates itself from screen to screen, record to record, or tab to tab. Be
sure to watch your browser’s progress bar or "spinner" to see when the refresh is
complete. In some cases, you will see a difference in the way information is
represented. In others, the refresh simply updates the database, though the screen
continues to look the same, giving you the most up-to-date information.

Web-Based

SchoolTool is a web-based application. This means it can be accessed from any
Internet connection anywhere in the world if you know your URL. This also means that if
there is no Internet connection, you cannot access SchoolTool.

Important Notes about Browser Usage:

l Using multiple tabs within a browser to access SchoolTool is not recommended,
as this can cause unexpected behavior.

l Always use the buttons and links within the SchoolTool interface, and not those of
your browser. If you use the toolbar buttons and/or menus of your browser, this
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may cause errors and impact your work. As a general rule, do not use the Back but-
ton on your browser as this will halt your connection to the database.

l All navigation buttons are accessed with a single click, not a double click. Double
clicking may not produce the desired results.

l SchoolTool uses several pop-up windows for calendars, alerts, confirmations, and
reports. Please make sure to disable your pop-up blocker for the SchoolTool URL.

Centralized

Because SchoolTool is a web-based application, districts have the ability to have all their
important information centralized even though all the grades may be in separate
buildings. This centralization allows for easy state reporting and grading during marking
periods.

Logging In
1. Open your browser and navigate to the SchoolTool URL for your district.

2. Enter the username and password provided by your district. Remember that
passwords are case sensitive.

3. Click the Login button to login.
4. If your district allows Google login, you can click the "Sign in with Google" but-

ton and enter your Google account credentials instead.
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5. If your district has enabled integration with Microsoft 365, you will see the
"Sign in with Microsoft" button. Users with district-managed Microsoft 365
accounts can use this button to sign in with their Microsoft account.

Note: If your district has enabled the "Allow Forgot Password on Login" in Maintenance
> District > District Options, users will see a link that will allow them to request a new
password (note that users must have a district-created account for this to work).

Note: When you log in, you will see the Home > My Home view by default. Based on your
user role, you will see a customized My Home view that gives the access to the sub-
modules, tabs, and reports needed to perform daily tasks. This is described in more
detail in the Home User Guide.

Navigation
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SchoolTool is structured hierarchically. Users have access to modules, which contain
sub-modules. These modules and sub-modules, and any tabs available from the sub-
module screens, are used to perform a wide variety of tasks. Much of SchoolTool
centers around the Person Records (most often, this is the Student Record). A person
record contains multiple sections, each with its own set of tabs, where information is
displayed. Depending on permissions and other factors, information may be editable or
it may be presented in read-only mode.

Modules and Side Menu Navigation

Modules and Sub-Modules

SchoolTool is divided into several modules, which organize the collection and
storage of data. Each module (Attendance, Discipline, etc.) contains a number
of sub-modules which contain the actual screens within SchoolTool.

Depending on your role within the district, you may have access to different
modules. Some users will have many items in the navigation menu while others
might have only a few.

Using the Side Menu to Navigate

All SchoolTool navigation is accomplished through the menu on the left side of
the screen. By default the menu is expanded; you can click on the Menu button

in the upper right portion of the screen to collapse it.

Once the side menu is collapsed, you can click again to expand it. SchoolTool
will remember the last menu setting you used and will automatically expand or
collapse it for you the next time you log in.



Teacher User Guide Page 11 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

Note: When the menu is collapsed, you can quickly access it by hovering the
mouse over the module icons. The menu will expand temporarily so you can
select a screen to navigate to, and will return to its collapsed state once your
mouse moves away from the menu area.

To navigate, use the menu on the left side of the screen to click on a module or
expand it to see a list of sub-module links. The active module will be indicated
with a dark blue bar on the left of the menu and the active sub-module will be
highlighted in blue to indicate your current location. While using the side menu
to navigate, menu items will be highlighted in a lighter blue when hovering over
them; to navigate, simply click on the desired link while it's highlighted.

The currently active module will be expanded by default. Use the
Expand/Collapse arrows to show or hide more navigation links within a module.
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Note that when using the menu in "slim mode" all modules will be collapsed
automatically; use the Expand arrows to see the navigation links for any module
while hovering over the menu.

Tabs

Tabs are used extensively throughout SchoolTool. For example, your My Home
view will have tabs near the upper left part of the screen which give access to
additional information. However, if you are viewing a student record through a
specific module or sub-module, tabs may be located in the middle of the screen
or towards the bottom of the screen. No matter where you see them, they work
the same.

A typical Teacher's My Home with Classes and other tabs

To access information in a tab, click once on the tab label to open the tab
window/screen. When the window has opened, the tab name will change to
show bold and underlined, letting you know which tab you are using.

Basic Navigation Tips
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Users navigate through SchoolTool by using navigation buttons and/or keyboard
shortcuts. Each button in SchoolTool uses a mouse-over tool tip to display the button’s
title or function. The following sections provide an overview of the navigation features
found in SchoolTool.

Navigation Buttons

SchoolTool uses simple navigation buttons that allow you to perform basic
functions with a single click of the mouse. The specific tool tips associated
with each button may give more descriptive text than shown below, but the
basic functionality remains the same.

Add/Create New Print or Report Cancel

Edit or Details Save/Submit Remove or Delete

Select or Details Update/Save/Refresh Check Spelling

Dashboard Email Alert flag

History Next Up or Show/Hide

Show/Hide Help Previous Down or
Show/Hide

Keyboarding Tips

SchoolTool’s user interface provides several options to accommodate your
working style and preferences. The modules, menus, and point-and-click
options for entering fields are available for users who prefer “mousing.”

If you are more comfortable using the keyboard, you can advance through many
fields on data entry screens by using the Tab key, and Shift +Tab keys.

Note that SchoolTool is web-based; each screen may have multiple hyperlinks
and navigation buttons to help you complete tasks. Because of this, the Enter
and Return keys on your keyboard may not always have the desired result and
may cause unexpected behavior. Always make sure to use the mouse to single
click the appropriate navigation button to perform the task at hand.

Tool Tips (Mouseovers)
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Throughout the application, you will find tool tips which are text boxes of
information that appear when you mouse over a button. For example, if you
mouse over a print button, without clicking, a box will appear telling you what
kind of report will be generated.

In other cases, hovering over an icon will provide additional information and/or
button controls.

Paging Through Lists

In some cases, when you are viewing a list of records, you will have access to
multiple screens of data. SchoolTool allows you to move through the pages by
using the linked numbers at the top of the column heading bar.

Paging buttons are either bold (pages you can click to) or not bold (indicating
the page you are on).

Organizing Data Tables with Columns
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In many lists, column headings may be used to reorder the list. Click once on a
column heading and the list will sort in ascending order, using the data in that
column. Click again and the data sorts in descending order. If a column heading
can be sorted, your mouse pointer will become a hand when held over the
column heading, which indicates that the column can be sorted.

For example, if you clicked the heading for First Name, the information would
appear in ascending alphabetical order of first names. Click First Name again,
and the list sorts in descending alphabetical order of first names.

Note: SchoolTool often uses a simple sort where numbers are treated as text.
For this reason, numeric columns can be sorted, but may display the data in an
unexpected order. For example, you may see grades 1, 10, and 11 listed before
grade 2, because the list sorts on the first digit then the second.

Additionally, search results may be printed as a simple list by clicking on the
Print icon in the upper left corner of the results list. The report will be
generated in a new window, which may then be saved or printed as needed. The
report will respect any on-screen sort order and will display all columns as
shown on the screen.

Field Types

There are several field types that appear throughout SchoolTool. Read the
following descriptions for examples of each type of field.

Date Fields

Fields that contain dates appear throughout SchoolTool. Every date field can be
used the same way and can be populated either by typing the date in the
mm/dd/yyyy format or by using the pop-up calendar accessed by single-
clicking the calendar icon next to the field.

To use the pop-up calendar:
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1. Single-click the calendar icon next to the date field.

2. Select the correct year by using the and arrow buttons on the out-
side of the month/year bar.

3. Select the correct month by using the and arrow buttons on either
side of the month/year bar.

4. Single click on the day you want to populate the field.
5. Click the button to jump to the current date.
6. Use the button to jump to September of the current school year,

and the button to jump to June of the current school year.
7. Click to close the pop-up date picker.

Required Fields

Many of the screens have at least one required field that must be completed
before saving. These fields are indicated either by the color pink or a red outline
around the field; a record cannot be saved until all the required fields are filled
in.

An error message displays if any required fields have been left blank.

Note: In some areas information in drop down fields may also be required,
though the fields do not appear in pink. SchoolTool will prompt you to make a
selection before allowing you to save your work.

Drop-down Lists

Drop down lists are used throughout SchoolTool when a field value comes from
a list of known values (like school, grade, or ethnicity). Clicking on the arrow of
these fields expands the list so a single item may be selected.
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l Your browser may also allow "type ahead" for longer lists, allowing you to
type the first several letters of the desired selection to help navigate
quickly through the list.

l Once a drop down list is open, you can also use your keyboard’s up and
down arrow keys to move through the list.

l If your mouse has a roller feature, you may also use that to scroll through
the values in a drop down list.

Radio Buttons

In several SchoolTool screens, radio buttons (or "radio options") allow you to
choose a single value from several options. These might be presented
horizontally or vertically but in either case these represent a "choose one"
scenario where only a single selection can be made with any group of radio
buttons.

Check Boxes

In several screens you may see check boxes as options. These options may be
used as "Yes/No" choices or to allow you to select multiple items. Click once in
a check box to select it and a check mark will appear. To uncheck a box you’ve
already checked, single click in the box and the check mark will disappear.

When a list of checkboxes is presented, the very top checkbox can be used to
either select or deselect all list items at the same time.
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Font Size and Banner View
All users have the ability to adjust font size within SchoolTool by clicking on the font
size buttons in the bottom left of the system banner area.

Changing the font size will increase or decrease text throughout SchoolTool. Note that
not all images, icons, or buttons are scalable and therefore may not resize when the font
size is changed. In future releases of SchoolTool these elements will respect the
selected font size as well.

Collapsing/Expanding the System Banner

Some districts provide information to users in the system banner area. This might
include general announcements, helpful links, and more. If your district has an active
banner message, this will be displayed in the banner area by default. You can collapse
this area by clicking on the Collapse button at the bottom right of the message area.
Note that this will collapse the banner during your active SchoolTool session only; the
next time you log in the banner will automatically be expanded again.

When the banner is collapsed, you will still see a white bar at the top of the screen where
you can access the font size buttons or expand the banner content at any time.
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Running Reports
The SchoolTool Report Viewer includes several features that allow users to easily
navigate through the report, as well as print or export report data.

The following features are available from within the Report Viewer window:

l Print: Allows users to send the report to a printer.
l Refresh: Allows users to regenerate the report. If pre-screen settings have been

modified in SchoolTool, the report results will be updated to reflect these changes.
l Export: Allows users to export the report data to a number of different formats.

Certain reports may be more suited to certain export types, depending on the
nature of the data and the way it is presented in a given report.

Export Dialog:
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Options include:
l PDF: PDF format is a page-based format. The exported documents are

intended for printing and redistribution. PDF format will export both layout
and formatting in a manner that is consistent with how the report looks on
the Preview tab.

l Microsoft Excel (97-2003): Microsoft Excel format is a page-based format
that converts your report contents into Excel cells on a page-by-page basis.
Contents from multiple pages are exported to the same Excel worksheet. If a
worksheet becomes full and there is more data to export, the export program
creates multiple worksheets to accommodate the data. This export format
retains most of the formatting, but it does not export line and box objects
from your report.

l Microsoft Excel (97-2003) Data-only: Microsoft Excel (97-2003) Data-only is
a record-based format that concentrates on data. However, this format does
export most of the formatting as well. Unlike the Microsoft Excel format, this
format does not merge cells; each object is added to only one cell. The data-
only format can also export certain kinds of summaries (SUM, AVERAGE,
COUNT, MIN, and MAX) in Crystal Reports as Excel functions.

l Microsoft Excel Workbook Data-only: Microsoft Excel Workbook Data-only
(.xlsx) is a record-based format that concentrates on data. However, this
format does export most of the formatting as well. The data-only format
does not merge cells; each object is added to only one cell. The data-only
format can also export certain kinds of summaries (SUM, AVERAGE, COUNT,
MIN, and MAX ) in Crystal Reports as Excel functions.

l Microsoft Word (97-2003): Microsoft Word is a page-based, exact format
that produces an RTF (Rich Text Format) file. The exported file contains text
and drawing objects to represent report objects. Individual objects are
placed in text frames. Almost all of the formatting is retained in this export
format. Text objects cannot, however, be placed outside the left edge of the
page. Therefore, if you have text objects in your report that are placed before
the left edge of the printable area, they will be pushed right. (This is most
noticeable in reports with wide pages.)

l Microsoft Word (97-2003) – Editable: The Microsoft Word - Editable format
is different from the Microsoft Word format; it is a page-based format, but
not all of the layout and formatting are preserved in the output. This format
converts all of the report object contents to text lines. Unlike Microsoft Word
format, this format does not use text frames. Text formatting is retained, but
attributes such as background color, fill pattern, and so on may not be
retained. All images in your report are inlined with the textual content and,
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therefore, the images automatically shift to accommodate text when the
document is edited in Microsoft Word. This format does not export line and
box objects from your report. As well, the special fields Page Number and
Page N of M do not work when exported in this format. The Microsoft Word -
Editable format has an option to insert page breaks at the end of each report
page. This option may not correspond to the page breaks created by
Microsoft Word; the option is used mainly to separate your report-page
contents

l Rich Text Format (RTF): The Rich Text Format (RTF) format is similar to the
Microsoft Word (97-2003) format.

l Character Separated Values (CSV): The Separated Values format is a
record-based, data-exchange format. It exports the report object contents as
a set of values separated by separator and delimiter characters that you
specify. Like record-style formats, the Separated Values format also creates
one line of values for each record in your report. The Separated Values
format cannot be used to export reports with cross-tabs or OLAP grids; nor
can it be used to export reports with subreports in Page Header or Page
Footer sections.

l Find/Search: Allows users to locate specific text within the
report. Enter text in the “Find…” box and press enter (or click the Search button)
to located the specified text within the report. The viewer will jump to the next
match and will highlight the text on the screen.

l Page Forward/Back: or Allows users to navigate
to a specific page within the report. Use the icons to move forward or backward by
a single page, enter a page number in the text box and press Enter to navigate to a
specific page, or use the arrow to jump directly to either the first or last page in
the report.

Some reports may not display the number of pages when the report is first loaded.
In that case, the Page field will display “1 of 1+”, “2 of 2+”, etc. until the user has
navigated to the last page of the report. Users can still use the Page Forward/Back
buttons and the arrow to navigate through the report.

l Zoom: Allows users to change the zoom level of the report to make view-
ing easier.

l Group Tree: Allows users to view the grouping of data within the report. For stu-
dent-based reports, for example, the group tree can be expanded to display each
student listed in the report, allowing users to quickly navigate to a specific student
as desired. When the group tree is expanded, the tree will be expanded. To col-
lapse it, simply click the arrows to hide the pane.



Teacher User Guide Page 22 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

My Home: Teacher View
When you log into SchoolTool, the default view is the Home > My Home sub-module. If
you are a teacher and have current classes, your default My Home tab will be the
Classes tab. If you do not currently have classes, you will be directed to the Search tab
instead.

If your district uses the Discussions feature, you will see an indicator in the upper left
corner showing the total number of unread messages. Clicking on this icon will navigate
you directly to the Home > Discussions sub-module.

The other tabs available a teacher’s My Home sub-module typically include Search,
Campus, Reports, and Actions. These are available for most user roles but are provided
based on district preferences. More information on each of these tabs is available in the
Home Module User Guide.

Depending on permissions, other icons may be available.
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l Google Classroom Sync icon – allows teachers to sync all class rosters to
Google Classroom.

l Dashboards icon – opens the Faculty View dashboard for the current user.

Account Tab
The Account tab is only visible to local users. This tab allows local users to change the
password they use to log into SchoolTool and displays a list of the user’s login history.

To change a local password, simply click on the Account tab, enter the existing
password, then the new desired password (twice).  Click on the Change Password
button to finalize the change.

We recommend creating a new password that has the following characteristics,
although your district may have different password requirements:

l Greater than or equal to eight (8) characters.
l Combination of letters, numbers, and symbols (including upper and lower case let-

ters)
l Something that can be remembered easily

Good passwords do not have to be hard to remember.  "Late2School!", for instance, is a
good password that has upper and lowercase letters, a number, a symbol, and is greater
than 8 characters long but still easy to remember.

Actions Tab
The Actions tab in SchoolTool allows faculty to communicate with students and parents
in three ways:
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l Email messages can be generated that are sent to the contacts of each student
l Mailings can be generated with student-specific information (merge fields)
l Push notifications can be sent to multiple students' mobile phones

To send an email message or merge letter to any group of students, or their contacts,
you must first choose an action and search for students:

1. Click on the Actions tab in the Home > My Home sub-module to begin.

2. Select the Send Email, Create Document, or Send Notification option

3. Search for students

Note: There are two search options on this screen, By Class using the class
roster or Advanced Search using the batch selector. Not all users will have
access to both methods. If both methods are available, you may use the radio
buttons to select either one method or the other to search for students.

A. Search By Class
i. If you are a teacher and have classes, a list of courses will

appear on the screen. Select the class(es) you wish to
include using the checkboxes for each class.

B. Search with Advanced Search (Batch Selector)
i. If you have the appropriate rights, you may also be able to

select the Advanced Search option to locate students using
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the Batch Selector.

ii. Select the appropriate terms to locate the desired students
(see the Batch Selector User Guide documentation for more
detailed information on how to use this feature.)

4. Click on the Search button. The results of the search will appear on the bottom
of the screen.

5. Select individual students using the checkboxes to choose the students for this
mailing.

6. Click the Continue button

Depending on the option selected at the beginning of this process, you will be
presented with one of three screens:  the Send Email screen, the Create
Document screen, or the Send Direct Notification screen.

Send Email

Once you have selected "Send Email" as your initial option and have performed the
appropriate search steps, you will be presented with the standard SchoolTool email
screen (along with additional contact options):
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1. To send an email message, simply fill in the form, starting at the top:
A. From – Your name and email address will appear in this field (if avail-

able). This field is pre-filled and cannot be modified.
B. To – This field will be pre-filled with your name and email address (if

available). You may enter additional email addresses here, separated
by commas or semicolons. In addition to the recipients you select at
the bottom of the screen, each email address in the To field will
receive a this email.

C. BCC – You may send blind carbon copies using this field. All valid
email addresses in this list will receive a Blind Carbon Copy of the
message. Multiple email addresses may be entered here, separated
by commas or semicolons. Recipients listed in the BCC field will not
be able to see any other recipients’ email addresses or names when
they receive the email.

D. Subject – This is the subject of the email message. Any text may be
entered here.

E. Body – The body of the email message contains the full content of
the message you would like to send. Formatting is minimal to pre-
serve compatibility with many email systems.

F. Importance – This is set to Normal importance by default; this can be
changed to High or Low using the drop-down to send messages
flagged with the desired level of importance.
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G. Attachment – To attach a file, such as a homework assignment, click
on the Browse button, locate the file with the standard Microsoft
browse window, and click OK. Click the Upload button to load the file
into the SchoolTool email message. The name of the attachment will
display at the bottom of the screen once it has been successfully
uploaded. Repeat these steps for each file to be attached. The selec-
ted attachment(s) will be sent to all recipients when Send Email is
clicked.

Note: Each attached file must be 10MB or smaller in size. If a user
attempts to upload a file larger than 10MB, an error message will
display and the attachment will be discarded.

2. Select the recipients
A. Use the checkboxes to specify contacts as recipients based on rela-

tionship flags defined in Census. To add additional contacts to the
recipients list, simply check the appropriate checkbox option. These
options are mutually exclusive; each option adds contacts to this list,
regardless of whether or not a contact meets multiple checkbox cri-
teria.

B. The following options are available for adding contacts:
l Student:  Includes all students in the selected group.
l Primary:  Includes all adult contacts listed as Primary Contact

 for each student.
l Receives Mail:  Includes all adult contacts that have the

Receives Mail  flag checked in Census for each student.
l Parent Portal Access:  Includes all adult contacts that have the

Parent Portal Access  flag checked in Census for each stu-
dent.

Note: Any individual who does not have an email address listed
in their Personal Record will not receive an email, regardless of
whether or not they appear in this list.

C. As checkboxes are selected, a student’s contacts will be added to the
list below, with a separate row for each contact. This means a student
may appear in the list more than once, although if “Student” is
checked, a student will only receive a single copy of the email regard-
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less of how many times the student appears in the list.

3. Click on the Send Email button. The email message will be delivered to all des-
ignated recipients.

Note: There are additional options on this screen as well as those described above:

l There are two left-pointing arrows on this screen. The upper button is the Back
button, while the lower button is the Done button.

l The Back  button (top) will return the user to the previous search results
screen, allowing them to re-select the specific students desired to receive
this email message.

l The Done  button (bottom) will exit the Actions tab entirely, returning the
user to their default My Home screen without sending the email.

l The Cancel  button will cancel this operation, returning the user to the first screen
of the Actions tab without sending the email.

l The Spell Check  button will spell check the document before it is sent out.

Create Document

The Create Document screen allows users to create merge documents using a
combination of configurable options and keywords. Document options include Letter
and Label formats. You can also create spreadsheets using Excel (when merging, these
will be treated as a Letter format).

Note: You should always save .XML files in 97-2003 XML format (compatibility mode) to
ensure proper functionality. In addition, you must turn your Microsoft Word spell check
off, as this will interfere with keywords.
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l

Creating Letters (Word)

1. Create a new document, including any standard text.
2. Add any generic Actions keywords to the body of the document.
3. Create tables for Data Set keywords if application

A. Insert a table with the appropriate number of columns
for the data to be displayed.

B. Specify a header row, if desired (header rows are
optional for data set keyword tables)

i. Right click on the table and select Table Prop-
erties

ii. Click on the Row tab and check the "Repeat as
header row at the top of each page" option.

C. Enter data set keywords as appropriate in the table row
(s); if using a header row the keywords should be
entered in the row(s) below the header.

D. Tables using additional data sets may be added to the
document, as long as they are separated by a para-
graph mark. Tables may be formatted as desired and
additional text may be added before saving as XML.

Example of the XML document template using generic keywords and
keywords from the Schedules data set:
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Example of the merged document:

l

Creating Labels (Word)

1. Go to the Envelopes & Labels area in Microsoft Word, select the
template to use for labels (using the Options button), and enter
the keyword “[%Label%]” in the Address portion as shown below:

2. Click the New Document button. A new document, based on the
selected label type, will open.
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3. Delete the “[%Label%]” keyword from the first cell only (the cell
the upper left corner). Enter the appropriate keywords in this cell.
Add any punctuation or other formatting as appropriate.

4. When all appropriate keywords have been added and formatted
as desired, save the document in XML format.

Notes/Recommendations:

l When using Address keywords, it is generally recommended that the
keywords for Line 1 and Line 2 be separated by a comma, rather
than placed on separate lines.

l Do not resize the cells when working in this document, or the labels
will not print properly on the label sheet.

l It is recommended that you review the final merge output before
printing labels to verify that the all information fits appropriately on
the label. Any necessary changes to keywords or formatting may be
made by modifying the master document and repeating the Merge.

Example of a mailing label format using keywords:

Example of the merged label document:
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l

Creating Spreadsheet Merge Files (Excel)

1. Use a spreadsheet application, or a simple text editor, to create
columns of text that all represent key words. You can type your
document exactly as you would like it to look with specific
columns and rows with keyword indications replaced by
SchoolTool.

2. Your document may look like this:

3. Once the document is created, save the file as a CSV file type.

l

Supported File Formats

l Documents using only the generic Actions keywords can be saved
as .RTF, .XML, or .CSV files

l Documents using data sets can be saved as .XML or .CSV files
l Labels must be saved as .XML files

Once you have decided on a document format (letter, label, or spreadsheet), the next
step is to create a master "template" document with keyword placeholders. When
merging, these keywords will be replaced with student-specific data.

l Generic Keywords: The generic Actions Tab keywords can be used in any XML
merge document, including any Actions documents or labels as well as area-spe-
cific letters (Attendance Policy letters and Discipline letters).
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l

Generic Actions Tab Keywords

These are all “generic” keywords that may be used in any of the
area-specific XML merge documents in SchoolTool. For more
information on using these keywords in area-specific XML letters,
see the related documentation for Attendance Policy Letters and
Discipline Letters.

Additionally, all of the “generic” keywords are listed here:

Keyword Definition
[%StudentFirstName%] First name

[%StudentMiddleName%] Middle name
[%StudentMiddleInitial%] Middle initial
[%StudentLastName%] Last name

[%StudentName%] First name Last name
[%StudentEmail%] Email address

[%StudentSalutation%] Salutation

[%SonDaughter%]
The word "son", "daughter", or "child" is

returned based on gender

[%HeShe%]
The word "he", "she", or "they" is returned

based on gender

[%HisHer%]
The word "his", "her", or "their" is returned

based on gender

[%ContactSalutation%]
Salutation of primary contact that receives

mail

[%ContactFirstName%]
First name of primary contact that receives

mail

[%ContactLastName%]
Last name of primary contact that receives

mail

[%ParentName%]
Full name of the primary contact (displays

as “Salutation FirstName LastName”)

[%ContactEmail%]
Email address of primary contact that

receives mail

[%ContactCellPhone%]
Cell Phone of primary contact that receives

mail

[%ContactWorkPhone%]
Work Phone of primary contact that

receives mail

[%ContactWorkPhoneExtension%]
Work Phone Extension of primary contact

that receives mail
[%ContactPager%] Pager of primary contact that receives mail
[%MoveInDate%] Date student was added to that address
[%UnitNumber%] Unit Number

[%Address%] Address

[%Address1%]
Student’s residence address line 1

(includes Unit #)
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[%Address2%] Student’s residence address line 2
[%CityStateZip%] City State Zip

[%City%] City
[%State%] State
[%Zip%] Zip

[%County%] County
[%PhoneNumber%] Phone number at student’s address

[%StudentID%] StudentID

[%Gender%]
State code corresponding with the gender

of the student (M/F/X)
[%DOB%] Date of Birth

[%DOB_Day%] Date of Birth Day
[%DOB_Month%] Date of Birth Month
[%DOB_Year%] Date of Birth Year

[%OriginOfBirth%] Origin Of Birth
[%PrimaryLanguage%] Primary language

[%Ethnicity%] Ethnicity
[%DateRegistered%] Date Registered

[%Grade%] Current grade
[%Homeroom%] Homeroom

[%HomeroomTeachers%]
Homeroom teacher(s), displayed as Last
Name (without salutation) and separated

by a “/” for multiple teachers

[%HomeroomTeachersWithSalutation%]
Homeroom teacher’s name with salutation
(displays as “Mrs. Johnson”), with multiple

teachers separated by a “/” character

[%Team%]

Student’s current team assignment (when
students are assigned to multiple teams, a
separate letter will be generated for each

different team assignment)

[%PreviousTeam%]

Last year’s team (when students are
assigned to multiple teams, a separate

letter will be generated for each different
team assignment)

[%NextTeam%]

Next year’s team (when students are
assigned to multiple teams, a separate

letter will be generated for each different
team assignment)

[%Locker%] Locker number
[%LockerCombo%] Locker combination

[%CounselorSalutation%] Salutation of Counselor
[%CounselorFirstName%] First name of Counselor
[%CounselorLastName%] Last name of Counselor

[%DiplomaType%] Diploma Type
[%Cohort%] Cohort

[%ClassOf%]
Class Of (Expected Graduation School

Year)
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[%EnrollmentType%] Enrollment Type
[%BuildingName%] Building Name
[%SchoolLevel%] School Level
[%HomeDistrict%] Student’s home district assignment

[%MailingUnitNumber%]
Student’s Mailing Unit Number (primary

contact)

[%MailingAddress%]
Student’s Mailing Address (lines 1 and 2
combined) (based on primary contact)

[%MailingAddress1%]
Student’s mailing address line 1 (includes

Unit #), based on primary contact’s mailing
address

[%MailingAddress2%]
Student’s mailing address line 2, based on

primary contact’s mailing address

[%MailingCityStateZip%]
Student’s Mailing City State Zip (based

primary contact)

[%MailingCity%]
Student’s Mailing City (based primary

contact)

[%MailingState%]
Student’s Mailing State (based primary

contact)

[%MailingZip%]
Student’s Mailing Zip (based primary

contact)

[%WorkAddress%]
Work address of primary contact that

receives mail

[%WorkAddress1%]
Work address line 1 (includes Unit #) for

primary contact who receives mail

[%WorkAddress2%]
Work address line 2 for primary contact

who receives mail

[%WorkCity%]
Work City of primary contact that receives

mail

[%WorkState%]
Work State of primary contact that receives

mail

[%WorkZip%]
Work Zip of primary contact that receives

mail

[%Recipient.Name%]

Recipient's full name, including salutation
(always returns data, can be multiple

names, ex: Mr. And Mrs. William Budd)*
(see note)

[%Recipient.FirstName%]
Recipient’s first name (only returns data

when single recipient)

[%Recipient.LastName%]
Recipient's last name (only returns data

when single recipient)

[%Recipient.Salutation%]
Recipient's salutation (only returns data

when single recipient)

[%Recipient.MailingAddress1%]
Recipient’s mailing address (line 1)*(see

note)

[%Recipient.MailingAddress2%]
Recipient’s mailing address (line 2) *(see

note)
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[%Recipient.MailingCity%] Recipient’s mailing city *(see note)
[%Recipient.MailingState%] Recipient’s mailing state *(see note)

[%Recipient.MailingZipCode%] Recipient’s mailing zip code *(see note)
[%Recipient.PhoneNumber%] Recipient’s phone number *(see note)

[%Recipient.Address1%] Recipient’s residence address (line 1)
[%Recipient.Address2%] Recipient’s residence address (line 2)

[%Recipient.City%] Recipient’s residence city
[%Recipient.State%] Recipient’s residence state

[%Recipient.ZipCode%] Recipient’s residence zip code

Note: If your recipient list is set to One per Household, you may only
use the recipient keywords indicated with an asterisk (*) in the table
above. “One per Household” merges are intended for mailing labels
or for “mass mailing” letters that do not contain student-specific
information.

l Data Sets: Actions tab merge letters also include “data sets” which allow users to
retrieve student-specific information from across SchoolTool within a single doc-
ument. Each data set has its own set of keywords and corresponding configurable
options that must be set in the UI prior to generating the final merge output. These
keywords are available only from the Actions tab, and the corresponding data sets
must be configured from the Create Document screen.

Note: When using data set keywords in XML files, those keywords must be
inserted in a table.

l

Data Set Keywords and Options

Data sets allow users to create merge documents with student-
specific information. Users may include data set keywords in XML
or CSV merge documents and select the options from the
appropriate Data Sets on the Create Document screen.

Note:  Access to data sets is controlled by individual permissions
for each data set. Users will only see data sets for which they have
permissions enabled.

The Data Sets portion of this screen allows users to specify how
information should be displayed when using data set keywords.
These data sets work in conjunction with their respective keywords;
each section needs to be expanded in order for those keywords to
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be functional. If options are set and the section is then “collapsed,”
that information will not be included in the document.

Note: Data Sets can only be used with files saved in .XML or .CSV
format.

When using data sets, users have the option to further specify the
data returned when the merge action is performed by checking the
“When data sets are expanded, only return students that have data
to display” checkbox. By default, this option is checked. If no data
sets are expanded, this option will not impact data in the merge
document.

The following data sets and options are available:

1. Contacts Data Set

The Contacts Data Set allows users to specify the
type of contacts returned by this merge based on
relationship settings in Census.
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1. Parent
A. Yes: Include only parents
B. No: include only non-parents
C. Both: Include both parents and

non-parents
2. Custodial

A. Yes: Include only those living
with the student

B. No: Include only those not living
with the student

C. Both: Include contacts
regardless of address

3. Primary
A. Yes: Include only primary

contacts
B. No: Include only non-primary

contacts
C. Both: Include both primary and

non-primary contacts
4. Receives Mail

A. Yes: Include only mail recipients
B. No: Include only non-mail

recipients
C. Both: Include both mail

recipients and non-mail
recipients

5. Pickup
A. Yes:  Include only those with

pickup rights
B. No:  Include only those without

pickup rights
C. Both:  Include contacts

regardless of pickup rights
6. Custody Alert

A. Yes:  Include only those with
custody alerts

B. No:  Include only those without
custody alerts
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C. Both:  Include contacts
regardless of custody alerts

7. Parent Portal
A. Yes: Include only those with

Parent Portal access
B. No: Include only those without

Parent Portal access
C. Both: Include contacts

regardless of Parent Portal
access

8. Restricted View
A. Yes:  Include only those with

restricted view
B. No:  Include only those without

restricted view
C. Both:  Include contacts

regardless of restricted view
9. Print Order

A. Primary and Parents First (the
default)

B. Relationship
C. Contact Name

Contacts Data Set Keywords

Keyword Definition

[%Contact.Name%] The contact’s full
name (Salutation,
First Name, and Last
Name)

[%Contact.FirstName%] Contact’s first name

[%Contact.MiddleName%] Contact’s middle
name

[%Contact.MiddleInitial%] Contact’s middle
initial

[%Contact.LastName%] Contact’s last name

[%Contact.Salutation%] Contact’s salutation

[%Contact.ResidenceUnitNumber%] Unit number for the
contact’s residence
address
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[%Contact.ResidenceAddress%] Combined address
for contact’s
residence address.
Includes Line 1
(house number and
street) and Line 2 of
the address on a
single line.

[%Contact.ResidenceAddress1%] Line 1 of the
contact’s residence
address (displays
house number and
street)

[%Contact.ResidenceAddress2%] Line 2 of the
contact’s residence
address (is blank if
no information exists
in this field)

[%Contact.ResidenceCity%] City for the contact’s
residence address

[%Contact.ResidenceState%] State for the
contact’s residence
address

[%Contact.ResidenceZipCode%] Zip code for the
contact’s residence
address

[%Contact.MoveInDate%]
Date student was
added to that
address

[%Contact.MailingUnitNumber%] Unit number for the
contact’s mailing
address

[%Contact.MailingAddress%] Combined address
for contact’s mailing
address. Includes
Line 1 (house
number and street)
and Line 2 of the
address on a single
line.

[%Contact.MailingAddress1%] Line 1 of the
contact’s mailing
address (displays
house number and
street)
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[%Contact.MailingAddress2%] Line 2 of the
contact’s mailing
address (is blank if
no information exists
in this field)

[%Contact.MailingCity%] City for the contact’s
mailing address

[%Contact.MailingState%] State for the
contact’s mailing
address

[%Contact.MailingZipCode%] Zip code for the
contact’s mailing
address

[%Contact.WorkUnitNumber%] Unit number for the
contact’s work
address

[%Contact.WorkAddress%] Combined address
for contact’s work
address. Includes
Line 1 (house
number and street)
and Line 2 of the
address on a single
line.

[%Contact.WorkAddress1%] Line 1 of the
contact’s work
address (displays
house number and
street)

[%Contact.WorkAddress2%] Line 2 of the
contact’s work
address (is blank if
no information exists
in this field)

[%Contact.WorkCity%] City for the contact’s
work address

[%Contact.WorkState%] State for the
contact’s work
address

[%Contact.WorkZipCode%] Zip code for the
contact’s work
address

[%Contact.PhoneNumber%] Contact’s home
phone number (the
phone number
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associated with the
contacts residence
address)

[%Contact.WorkPhone%] Contact’s work
phone number

[%Contact.WorkPhoneExtension%] Contact’s work
phone number
extension

[%Contact.CellPhone%] Contact’s cell phone
number

[%Contact.Pager%] Contact’s pager
number

[%Contact.Email%] Contact’s email
address

[%Contact.Relationship%] Relationship
between the contact
and student

[%Contact.IsParent%] Indicates whether or
not the contact is
designated as a
parent for that
student (displays as
“yes” or “no”)

[%Contact.IsCustodial%] Indicates whether or
not the contact
shares the same
home address as the
student (displays as
“yes” or “no”)

[%Contact.IsPrimary%] Indicates whether or
not the contact is
designated as a
primary contact for
that student
(displays as “yes” or
“no”)

[%Contact.IsReceivesMail%] Indicates whether or
not the contact has
rights to receive mail 
for that student
(displays as “yes” or
“no”)

[%Contact.IsPickup%] Indicates whether or
not the contact has
pickup rights for that
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student (displays as
“yes” or “no”)

[%Contact.IsParentPortal%] Indicates whether or
not the contact has
rights to access the
Parent Portal for that
student (displays as
“yes” or “no”). Note:
this is only an
indication of whether
or not the Parent
Portal option is
checked in Census
and does not reflect
any local accounts or
related settings in
Maintenance.

[%Contact.IsCustodyAlert%] Indicates whether or
not the contact is
designated as having
a custody alert for
that student
(displays as “yes” or
“no”)

[%Contact.IsRestrictedView%] Indicates whether or
not the contact has
the Restricted View
option checked for
that student
(displays as “yes” or
“no”)

[%Contact.CustodyType%] The custody type
assigned to that
relationship, if
defined.

[%Contact.CustodyNotes%] Displays the text in
the Custody Notes
field for that
relationship, if
entered.

[%Contact.StartDate%] Start date of the
contact/student
relationship

2. Custom Alerts Data Set
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The Custom Alerts data set allows users to
retrieve data about students’ custom alerts
records based on the options selected on the
Create document screen. 

Options include:

1. Does Not Have (checkbox): Returns data
for students who either have or do not
have the specified alerts. This option is
unchecked by default to locate students
who have the appropriate alerts.

2. Alert drop-down: The specific custom
alert(s) to return (users may select All or
choose a specific custom alert; the list is
defined by the alerts defined in
Maintenance)

3. Flag drop-down: The color flag(s) to
return (users may select All or choose
one of the colors listed)

Custom Alerts Data Set Keywords

Keyword Definition
[%CustomAlert.Text%] The custom alert text as

defined in Maintenance >
Custom Alerts

[%CustomAlert.Category%] The selected flag color for the
custom alert as defined
Maintenance > Custom Alerts
(e.g., White, Red, Black)

3. Daily Attendance Data Set
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The Daily Attendance data set allows users to
retrieve information about students’ daily
attendance records for the specified school year
specified in the Create Document UI.

Options available on the Create Document screen
include the following:

1. Type: The type of absence records to
return (users may select All, Absences,
Late Arrivals, or Early Dismissals)

2. Reason: The absentee reasons to return
(users may select All or choose any value
in the list, which is defined based on the
absentee reasons defined in
Maintenance)

3. Quantity: Use this option to specify a
number of absence records. Data for
students meeting the numeric criteria will
be returned appropriately. Select Greater
Than, Less Than, Exactly, or Between, and
type in a value or range of values (when
using the “Between” option to search
based on a range of values, both values
are inclusive; if a user selects “Between 2
and 5” the results will include students
with record counts of 2 as well as 5).

4. Date Range (From…To): Select a date
range to limit the data to a specific
timeframe. These fields are set to the
start and end dates of the current school
year by default.

5. Print Order: The order in the courses will
be sorted in the table. Options include:
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l Date Absent Ascending
l Date Absent Descending

Daily Attendance Data Set Keywords

Keyword Definition
[%Attendance.Daily.DateAndTime%] Date and time

for the daily
absence
record

[%Attendance.Daily.Date%] Date of the
daily absence
record

[%Attendance.Daily.Time%] Time of the
daily absence
record

[%Attendance.Daily.Type%] Absence type
(In, Out, Early
Dismissal, Late
Arrival, or
Absent)

[%Attendance.Daily.Reason%] Value selected
for the
“Reason” on
the daily
absence
record

[%Attendance.Daily.HowExcused%] Value selected
for the
“Excused by”
field on the
daily absence
record.

[%Attendance.Daily.Comments%] Text entered in
the
“Comments”
field on the
daily absence
record

[%Attendance.Daily.CountAsAbsentInOut%] Indicates
whether or not
the selected
absentee
reason on the
daily absence
record is
counted as
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absent/in/out
(displays as
“yes” or “no”)

[%Attendance.Daily.Code%] The code
corresponding
with the
selected
absentee
reason for the
daily absence
record

[%Attendance.Daily.IncludeInAttendancePolic
y%]

Indicates
whether or not
the selected
absentee
reason on the
daily absence
record is
included in the
attendance
policy
(displays as
“yes” or “no”)

[%Attendance.Daily.Excused%] Indicates
whether or not
the selected
absentee
reason on the
daily absence
record is
marked as
“Excused”
(displays as
“yes” or “no”)

[%Attendance.Daily.Fundable%] Indicates
whether or not
the selected
absentee
reason on the
daily absence
record is
marked as
“Fundable”
(displays as
“yes” or “no”)

[%Attendance.Daily.LocaterText%] Displays the
text that
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appears in the
Student
Locator for the
selected
absentee
reason on the
daily absence
record

[%Attendance.Daily.Returning%] Indicates
whether or not
the “Returning”
checkbox is
checked on an
Out record.

4. Discipline Data Set

The Discipline data set allows users to retrieve
information about students’ discipline incidents for
the specified school year specified in the Create
Document UI.

Options available on the Create Document screen
include the following:

1. All Offender Referrals for:  Select a year
from the school year drop-down. Use this
option to return all offender referrals for
the selected school year without
specifying any further criteria.

2. Specify:
A. Offender/Victim radio buttons: 

Use these to limit the data to the
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appropriate type of referral to
those where the student was
listed as an Offender, a Victim,
or both an Offender and a Victim
on the same referral.

B. Date Range (From…To):  Select a
date range to limit the data to a
specific timeframe. By default,
the From date is set to the start
of the current school year and
the To date is set to the current
date.

i. Radio buttons allow the
user to specify whether
these dates should
reflect the incident
date, the assigned date,
or the served date
(assigned and served
will only return records
that have a disposition
with a corresponding
assigned or served
date).

C. Offense options: Use these
options to specify which
offenses should be returned.

i. Offense drop-down:
Select “Any” or choose
a value from the
Offense drop-down to
return only the selected
offense.

ii. SSEC Offenses Only:
Use this radio button to
return only those
offenses that are
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designated as SSEC
offenses in
Maintenance >
Discipline > Discipline
Type (for incidents
occurring on or after
July 1, 2017; for
offenses occurring
prior to that date, use
the VADIR and/or DASA
options below)

iii. VADIR Offenses Only:
Use this radio button to
return only those
offenses that are
designated as VADIR
offenses in
Maintenance >
Discipline > Discipline
Type (for incidents
occuriong prior to the
2017-2018 school year
only; for offenses
occurring after that
date, use the SSEC
option above).

D. Disposition options: Use these
options to specify which
dispositions should be returned.

i. Disposition drop-down:
Select “Any” or choose
a value from the
Disposition drop-down
to return only the
selected disposition.

ii. Disposition Category:
Select the Disposition
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Category radio button
to return data based on
a category rather than a
specific disposition.
The checkboxes
available for discipline
categories include the
following: Is
Counseling or
Treatment, Is Teacher
Removal, Is Detention,
Is ISS, Is OSS, Is
Involuntary Transfer to
an Alternate
Placement, is Law
Enforcement (post-July
1, 2017 offenses only),
Is Juvenile Justice or
Criminal Justice
System (post-July 1,
2017 offenses only), is
Community Service,
and Is Law
Enforcement or
Juvenile Justice (pre-
July 1, 2017 offenses
only).

3. Print Order: The order in the courses will
be sorted in the table. Options include:

l Date of Incident Ascending
l Date of Incident Descending
l Date Seen Ascending
l Date Seen Descending

Discipline Data Set Keywords

Keyword Definition
[%Discipline.IncidentDate%] Incident date
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(formatted
mm/dd/yy)

[%Discipline.IncidentTime%] Incident time
(formatted
hh:mm
A/PM, blank
if midnight or
if marked as
“unknown”)

Note: Not all
districts use
this option
on referrals.

[%Discipline.CreatorSalutation%] Discipline
referral
creator
salutation

[%Discipline.CreatorFirstName%]

Discipline
referral
creator first
name

[%Discipline.CreatorLastName%]

Discipline
referral
creator last
name

[%Discipline.ReportedOnDate%]

The date the
referral was
created in
SchoolTool
(formatted
mm/dd/yy)

[%Discipline.DuringSchoolHours%] Indicates
whether or
not incident
occurred
during
school hours
(displayed as
“yes” or “no”)

[%Discipline.PersonType%] Indicates
whether the
student was
the offender,
victim, or
both.

[%Discipline.Building%] Building
associated
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with the
incident

[%Discipline.SchoolLevel%] School level
associated
with the
incident

[%Discipline.SeenDate%] Date Seen as
recorded on
Referral
(formatted
mm/dd/yy)

[%Discipline.FacultyFirstName%] First name of
faculty
member
listed on
referral

[%Discipline.FacultyLastName%] Last name of
faculty
member
listed on
referral

[%Discipline.FacultySalutation%] Salutation for
faculty
member
listed on
referral

[%Discipline.Location%] Location of
incident

[%Discipline.LocationType%] Location type
of incident
(displays
“School
Property,”
“Transportati
on,” “Off
Campus,” or
"School
Function Off
Grounds)

[%Discipline.Incidents%] Offense(s)
on referral
(comma
delimited
string of
offenses)

Note: These
keywords

[%Discipline.IsSSEC%] Indicates
whether or
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should be used
only for

incidents
occurring

during or after
to the 2017-
2018 school

year.

not the
incident is an
SSEC
offense
(displayed as
“yes” or “no”)

[%Discipline.SSECCode%] Code of most
severe SSEC
offense
listed on
referral

[%Discipline.SSECDescripti
on%]

Description
of most
severe SSEC
offense
listed on
referral

[%Discipline.SSECInvolving
Alcohol%]

Indicates
whether or
not the most
severe SSEC
incident is
marked as
“Involving
Alcohol”
(displayed as
“yes” or “no”)

[%Discipline.SSECInvolving
Drugs%]

Indicates
whether or
not the most
severe SSEC
incident is
marked as
“Involving
Drugs”
(displayed as
“yes” or “no”)

[%Discipline.SSECWithWea
pons%]

Indicates
whether or
not the most
severe SSEC
incident is
marked as
“With
Weapons”
(displayed as
“yes” or “no”)
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[%Discipline.SSECWeapo
n%]

Displays the
selected
weapon if
SSEC
incident is
marked as
“With
Weapons”

[%Discipline.SSECGangRela
ted%]

Indicates
whether or
not the most
severe SSEC
incident is
marked as
“Gang
Related”
(displayed as
“yes” or “no”)

[%Discipline.SSECBiasRelat
ed%]

Indicates
whether or
not the most
severe SSEC
incident is
designated
as “Bias
Related”
(displayed as
“yes” or “no”)

Note: These
keywords

should be used
only for

incidents
occurring prior

to the 2017-
2018 school

year.

[%Discipline.IsVadir%] Indicates
whether or
not the
incident is a
VADIR
offense
(displayed as
“yes” or “no”)

[%Discipline.VadirCode%] Code of most
severe VADIR
offense
listed on
referral

[%Discipline.VadirDescriptio
n%]

Description
of most
severe VADIR
offense
listed on
referral
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[%Discipline.InvolvingAlcoh
olDrugs%]

Indicates
whether or
not the most
severe VADIR
incident is
marked as
“Involving
Alcohol/Drug
s” (displayed
as “yes” or
“no”)

[%Discipline.WithWeapon
s%]

Indicates
whether or
not the most
severe VADIR
incident is
marked as
“With
Weapons”
(displayed as
“yes” or “no”)

[%Discipline.Weapon%] Displays the
selected
weapon if
VADIR
incident is
marked as
“With
Weapons”

[%Discipline.GangRelated%] Indicates
whether or
not the most
severe VADIR
incident is
marked as
“Gang
Related”
(displayed as
“yes” or “no”)

[%Discipline.BiasRelated%] Indicates
whether or
not the most
severe VADIR
incident is
marked as
“Bias
Related”
(displayed as



Teacher User Guide Page 57 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

“yes” or “no”)
[%Discipline.Dispositions%] Disposition

(s) on
referral
(comma
delimited
string of all
dispositions)
If a shared
disposition is
included it
will be
labeled as
“Shared.”

[%Discipline.DispositionDates%] Disposition
date(s) for
dispositions
on referral
(comma
delimited
string of
disposition
dates).

[%Discipline.DispositionsAllWithDates%] All
dispositions
assigned to a
referral and
the dates for
which each
disposition is
assigned.
Each
disposition
will be
separated by
a comma,
with the date
(s) assigned
for each
disposition
displayed in
parentheses
(multiple
dates for a
disposition
will be
separated by
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a comma
within the
parenthese
s). If a
shared
disposition is
included it
will be
labeled as
“Shared.”

[%Discipline.ParentContactedDate%] Date parent
was
contacted
(formatted
mm/dd/yy)

Note: Not all
districts use
this option
on referrals.

[%Discipline.ParentContactedTime%] Time parent
was
contacted
(formatted
hh:mm
AM/PM)

Note: Not all
districts use
this option
on referrals.

[%Discipline.Description%] Description
of incident
on referral

[%Discipline.BehaviorOccurredBefore%] Indicates
whether or
not the “Has
this behavior
occurred
before?”
option is set
to Yes or No
(displayed as
“yes” or “no”)

Note: Not all
districts use
this option
on referrals.
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[%Discipline.HowManyTimes%] If behavior is
marked as
having
occurred
before, this
will return the
number
selected
from the
“How many
times?” drop-
down.

Note: Not all
districts use
this option
on referrals.

[%Discipline.HasFBA%] Indicates
whether or
not the
“Student has
an FBA” field
was checked
on the
referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
this option
on referrals.

[%Discipline.HasIEP%]

Indicates
whether or
not the
“Student has
an IEP” field
was checked
on the
referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
this option
on referrals.

[%Discipline.Has504%]

Indicates
whether or
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not the
“Student has
a 504” field
was checked
on the
referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
this option
on referrals.

[%Discipline.ReasonForReferral%] The text
entered in
the “Reason
for Referral”
field on the
referral

Note: Not all
districts use
this option
on referrals.

[%Discipline.WarningLectures%] Indicates
whether or
not the
“Warning and
lectures”
option is
checked
under the
“Corrective
Steps”
section on
the referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
the
“Corrective
Steps” option
on referrals.

[%Discipline.SpecialSeating%] Indicates
whether or
not the
“Special
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seating”
option is
checked
under the
“Corrective
Steps”
section on
the referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
the
“Corrective
Steps” option
on referrals.

[%Discipline.TimeOutOffice%] Indicates
whether or
not the “Time
out at the
office” option
is checked
under the
“Corrective
Steps”
section on
the referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
the
“Corrective
Steps” option
on referrals.

[%Discipline.ClassroomDetention%] Indicates
whether or
not the
“Classroom
detention”
option is
checked
under the
“Corrective
Steps”
section on
the referral
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(displayed as
“yes” or “no”)

Note: Not all
districts use
the
“Corrective
Steps” option
on referrals.

[%Discipline.CounselorContacted%] Indicates
whether or
not the
“Counselor
contact”
option is
checked
under the
“Corrective
Steps”
section on
the referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
the
“Corrective
Steps” option
on referrals.

[%Discipline.ParentContacted%] Indicates
whether or
not the
“Parent
contact”
option is
checked
under the
“Corrective
Steps”
section on
the referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
the
“Corrective
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Steps” option
on referrals.

[%Discipline.PreviousActionsTaken%] The text
entered in
the “Previous
Actions
Taken” field
on the
referral
(displayed as
“yes” or “no”)

Note: Not all
districts use
this option
on referrals.

[%Discipline.Comments%] Text entered
in the
Comments
field of the
referral

[%Discipline.NumberNonDistrictVictims%] The number
of non-
district
victims on
the referral

[%Discipline.NumberNonDistrictOffenders%] The number
of non-
district
offenders on
the referral

[%Discipline.Victims%] Lists all other
victims on
the referral
(comma
delimited list
of first and
last name,
ordered
alphabeticall
y by last
name). The
student for
whom the
merge
document is
being
generated
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will not
appear in this
list.

[%Discipline.Offenders%] Lists all other
offenders on
the referral
(comma
delimited list
of first and
last name,
ordered
alphabeticall
y by last
name). The
student for
whom the
merge
document is
being
generated
will not
appear in this
list.

[%Discipline.NumberOfDispositionPoints%] The sum of
all
disposition
points for
this referral

Note: Not all
districts use
Disposition
Points on
referrals.

[%Discipline.NumberOfIncidentPoints%] The sum of
all offense
points for
this referral

Note: Not all
districts use
Offense
Points on
referrals.

[%Discipline.NumberOfPoints%] The total
number of
discipline
points
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(disposition
points +
offense
points) for
this referral

Note: Not all
districts use
points on
referrals.

[%Discipline.NumberOfISSDays%] The number
of ISS days
assigned for
this referral
(partial day
suspensions
are counted
as 1 day)

[%Discipline.NumberOfOSSDays%] The number
of OSS days
assigned for
this referral
(partial day
suspensions
are counted
as 1 day)

[%Discipline.NumberOfDetentionDays%] The number
of detention
days
assigned for
this referral

[%Discipline.NumberOfIncidents%] The number
of offenses
on this
referral

[%Discipline.NumberOfDispositions%] The number
of
dispositions
on this
referral

5. Grades (Permanent Record) Data Set

The Grades (Permanent Record) data set allows
users to retrieve data for students’ submitted
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grades (as seen on the Counseling > Grades tab)
based on the options defined on the Create
Document screen. Assessment data is returned
based on keywords corresponding with the
settings defined in the Maintenance > Counseling
> Assessment Type Mappingarea (see below for
details on assessment type mapping).

Note:  Data will always reflect the user’s security
rights for the “Respect Marking Period Publish
Date” and “Respect Progress Report Publish Date”
permissions in the Security Tree in Maintenance.

Options on the Create Document pre-screen
include the following:

1. School Year (radio buttons):  Determines
the timeframe for which data will be
returned.

A. All:  When All is selected, data
meeting the specified criteria
will be returned for all school
years for which the student has
grades.

B. Year Drop-down:  When a
specific year is selected, data
will be returned for that school
year only. By default, this option
is set to the current year.

2. Department (drop-down):  This allows
users to return data for all departments or
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limit it to a single department. This is set
to All by default.

3. Only Show Courses Marked as “Include in
Transcript” (checkbox):  This option
specifies whether data is returned for all
courses that meet the specified criteria,
or for only those marked as “Include in
Transcript” in the Course Catalog. This
option is unchecked by default.

4. Multiple Assessment Scores (drop-
down):  This option allows users to
specify how data is returned when
multiple scores exist for the same
assessment. Choices include the
following:

A. Show Highest Score (selected
by default):  The data will return
a single record for that
assessment type and will
display only the assessment
with the highest score.

B. Show Most Recent Score:  The
data will return a single record
for that assessment type and
will display only the score from
the most recent instance of the
assessment.

C. Show All Scores:  The data will
return records for each instance
of the assessment type and will
display the score for each as
appropriate. In XML documents
each instance will be presented
on a new line. In CSV files all
instance will be presented in a
single cell, and each instance
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will be separated by a “|” (pipe)
character.

5. Show Withdrawn Courses (drop-down): 
This option allows users to specify how
data is returned for withdrawn courses.
Choices include the following:

A. No (selected by default): 
Withdrawn courses will not be
included in the merge
document.

B. Withdraw Code:  Withdrawn
courses will be included in the
merge document, along with the
appropriate withdrawal code.

C. Final Grade if Overridden: 
Withdrawn courses will be
included in the merge document,
with the final grade if one was
entered by a Counselor.  If the
final grade was not overridden,
the withdrawal code will display
instead.

6. Include:  These options determine which
data is included for the specified criteria
(School Year, Department, Include in
Transcript, Multiple Assessments, and
Withdrawn Course options).

A. Completed Courses (checked by
default):  When checked, data
will include all courses that have
been completed for the selected
criteria. Courses are considered
“completed” when the student
has received either a final grade
or a grade note.

B. Courses that are marked as
dropped or withdrawn, or
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courses that are designated as
Summer School, are not
included regardless of whether a
final grade or grade note has
been assigned.

C. In-progress Courses for Current
Year (checked by default): 
When checked, data will include
all courses that are in-progress
for the current year. This option
should only be checked if the
School Year option is set to All
or to the current year; if School
Year is set to any value other
than “All” or the current year, this
option will be ignored.

D. Courses are considered “in-
progress” for the current year
when the course is currently in
session, has received at least
one marking period grade, and
has not yet received a final
grade or grade note. Courses
that are marked as dropped or
withdrawn, or courses that are
designated as Summer School,
are not included regardless of
whether a final grade or grade
note has been assigned.

E. In-progress Courses for
Previous Years:  When checked,
data will include all courses that
are in-progress for previous
years. This option should only be
checked if the School Year is set
to “All” or to any year other than
the current school year; if School
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Year is set to the current year,
this option will be ignored.

F. Courses are considered “in-
progress” for previous years
when the course has not
received a final grade or grade
note. Courses that are marked
as dropped or withdrawn, or
courses that are designated as
Summer School, are not
included regardless of whether a
final grade or grade note has
been assigned.

G. Dropped Courses:  When
checked, data will include any
course marked as “dropped” for
the selected criteria.

H. Future Courses:  When checked,
data will include all future
courses (future courses are
courses that are scheduled but
have not yet started and have
not yet received any grades).

I. Summer School Courses:  When
checked, data will include
courses designated as Summer
School courses.

J. Standalone Assessments as
Courses:  When checked,
standalone assessments
(exams not linked to courses)
will be included.  Any exam not
linked to a course will show the
assessment name in the Course
Name field and the Assessment
Name field. The Assessment
score will be shown in the
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Course Final field and the
Assessment Score field.

7. Print Order:  Determines the order in
which data will be presented for each
selected student. Options include:

A. Course Name (alphabetical)
B. Course ID (ascending numeric)
C. Department/Course Name

(alphabetical by department,
then alphabetical by course
name)

D. Department/Course ID
(alphabetical by department,
then ascending numeric by
course ID)

E. School Year/Course Name
(ascending school year then
alphabetical by course name)

F. School Year/Course ID
(ascending school year then
ascending numeric by course ID)

G. School Year/Department/Course
Name (ascending school year
then alphabetical by department
then alphabetical by course
name)

H. School Year/Department/Course
ID (ascending school year then
alphabetical by department then
ascending numeric by course ID)

Grades (Permanent Record) Data Set Keywords

The Grades (Permanent Record) data set allows
users to retrieve data about students’ grades (from
the Counseling > Grades tab) based on the
options selected on the Create document screen.



Teacher User Guide Page 72 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

Keywords for the Grades (Permanent Record) data
set include several pre-defined keywords, as
described in the list below. In addition, this data
set also uses several dynamic keywords to allow
users to retrieve data based on their school’s
school year configuration and assessment type
mapping. These keywords must be entered by the
user based on the rules described below.

Marking Period Keywords:

The Grades (Permanent Record) data set allows
users to retrieve marking period scores and
comments for up to eight (8) marking periods.
Marking period scores and comments may be
retrieved using the following keyword formats: 
[%Grade.Course.MP1Score%] for marking period
score and [%Grade.Course.MP1Comment%] for
marking period comments. The keywords should
be modified to indicate the appropriate marking
period by changing “MP1” to “MP2”, “MP3”, and so
on, up to “MP8”, to retrieve the corresponding
marking period data.

Note: If multiple comments exist for a given
marking period, all comments will be returned for
that marking period. In XML documents each
comment will be presented on a new line. In CSV
files all comments will be presented in a single
cell, and each comment will be separated by a “|”
(pipe) character.

Progress Report Keywords:

As with marking period keywords, progress report
scores and comments may be retrieved using
dynamic keywords. Progress report keywords
accept up to twelve (12) progress intervals, using
the following keyword formats: 
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[%Grade.Course.PR1Score%] for progress report
score and [%Grade.Course.PR1Comment%]  for
progress report comments. The keywords should
be modified to indicate the appropriate progress
interval by changing “PR1” to “PR2”, “PR3”, and so
on, up to “PR12”, to retrieve the corresponding
progress report data.

Note: If multiple comments exist for a given
progress report, all comments will be returned for
that progress report. In XML documents each
comment will be presented on a new line. In CSV
files all comments will be presented in a single
cell, and each comment will be separated by a “|”
(pipe) character.

Assessment Keywords:

Assessments are returned based on the Data Set
Mapping defined in Maintenance > Counseling >
Assessment Type Mapping, with the exception of
midterms and any assessment type that is either
not mapped or is mapped to “None.” To reflect
each assessment type, users must enter the
appropriate keyword based on the following
format:  [%Grade.Course.<TYPE><FIELD>%], where
<TYPE> is the name of the screen and <FIELD> is
the name of the field.

The assessment Type should be entered exactly
as it is defined in Maintenance, including any
spaces as well as the appropriate capitalization
and/or punctuation within the Type name.

The following Fields are available for unmapped
assessments:

l Name:  Returns the Assessment Name
l Score:  Returns the Assessment Score
l Date:  Returns the Assessment Date



Teacher User Guide Page 74 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

l Time:  Returns the Assessment Time
l Code:  Returns the Assessment Code

(Absent/Unscorable/Exempt)
l NoteCode:  Returns the Assessment Note

Short Code (as defined in Maintenance)
l NoteText:  Returns the Assessment Note

Text (as defined in Maintenance)

For example, to retrieve data for the “Local” and
“Component Retests” assessment types, users
may enter the following keywords:

[%Grade.Course.LocalName%]

[%Grade.Course.LocalScore%]

[%Grade.Course.LocalDate%]

[%Grade.Course.LocalTime%]

[%Grade.Course.LocalCode%]

[%Grade.Course.LocalNoteCode%]

[%Grade.Course.LocalNoteText%]

[%Grade.Course.Component RetestsName%]

[%Grade.Course.Component RetestsScore%]

[%Grade.Course.Component RetestsDate%]

[%Grade.Course.Component RetestsTime%]

[%Grade.Course.Component RetestsCode%]

[%Grade.Course.Component RetestsNoteCode%]

[%Grade.Course.Component RetestsNoteText%]

Fixed keywords are pre-defined and should not be
modified. These include the following keywords:

Keyword Definition
[%Grade.Course.SchoolYear%] Course’s school
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year
[%Grade.Course.Department%] Course’s

department
[%Grade.Course.CourseID%] Course ID

[%Grade.Course.CourseName%] Course name
[%Grade.Course.Description%] Course description

(as defined in the
course catalog)

[%Grade.Course.SectionNumber%] Section number to
which the student
was assigned

[%Grade.Course.Semesters%] Semesters to which
the course was
assigned

[%Grade.Course.Days%] Days on which the
course met

[%Grade.Course.StartPeriod%] Start period for the
course

[%Grade.Course.EndPeriod%] End period for the
course

[%Grade.Course.StartTime%] Start time for the
course

[%Grade.Course.EndTime%] End time for the
course

[%Grade.Course.Room%] Room where the
course met

[%Grade.Course.Team%] Team to which the
course was
assigned

[%Grade.Course.Teachers%] Teachers assigned
to the course

[%Grade.Course.CreditAttempted%] Credit value
assigned to the
course (as defined
in the course
catalog)

[%Grade.Course.EarnedCredit%] Actual credit earned
by the student for
the course

[%Grade.Course.FinalGrade%] Final grade
submitted for the
course

[%Grade.Course.NoneName%] For assessments
not mapped to a
Dataset Mapping or
those mapped to
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“None,” the name of
the assessment.

[%Grade.Course.NoneScore%] For assessments
not mapped to a
Dataset Mapping or
those mapped to
“None,” the score
received on the
assessment.

[%Grade.Course.NoneDate%] For assessments
not mapped to a
Dataset Mapping or
those mapped to
“None,” the date of
the assessment.

[%Grade.Course.NoneTime%] For assessments
not mapped to a
Dataset Mapping or
those mapped to
“None,” the time of
the assessment.

[%Grade.Course.NoneCode%] For assessments
not mapped to a
Dataset Mapping or
those mapped to
“None,” the code for
the assessment.

[%Grade.Course.NoneNoteCode%] For assessments
not mapped to a
Dataset Mapping or
for those mapped
to “None,” the
Assessment Note
Short Code (as
defined in
Maintenance)

[%Grade.Course.NoneNoteText%] For assessments
not mapped to a
Dataset Mapping or
for those mapped
to “None,” the
Assessment Note
Text (as defined in
Maintenance)

[%Grade.Course.MidtermName%] The name of the
midterm

[%Grade.Course.MidtermScore%] The score received
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on the midterm
[%Grade.Course.MidtermDate%] The date of the

midterm
[%Grade.Course.MidtermTime%] The time of the

midterm
[%Grade.Course.MidtermCode%] The code for the

midterm
[%Grade.Course.MidtermNoteCode%] The Assessment

Note Short Code
(as defined in
Maintenance)

[%Grade.Course.MidtermNoteText%] The Assessment
Note Text (as
defined in
Maintenance)

[%Grade.Course.SummerSchool%] Indicates whether
or not the course is
designated as
“Summer School”
(displays “Summer
School” if
appropriate,
otherwise is blank)

[%Grade.Course.TransferredIn%] Indicates whether
or not the course is
designated as
“Transferred In”
(displays
“Transferred in” if
appropriate,
otherwise is blank)

[%Grade.Course.InProgressAverage%] The in progress
average for the
course

[%Grade.Course.WithdrawDate%] The date the course
was withdrawn, if
any

[%Grade.Course.DropDate%] The date the course
was dropped, if any

6. Program Services Data Set

The Program Services data set allows users to
retrieve information about students’ program
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service records for the specified school year
specified in the Create Document UI.

Options available on the Create Document screen
include the following:

1. Program Service: The program service for
which data will be returned. Select “All” or
choose a specific program service from
the list. If a specific program service is
selected, additional options appropriate
to that service will appear.

2. Currently Active / Active Between: Use
these radio buttons to specify which
program service records should be
included.

A. Currently Active: This option
includes only program service
records that are currently active.

B. Active Between:  Enter a start
date and end date to search for
any records that were active
during a specific date range.

3. Print Order: The order in the records will
be sorted in the table. Options include:

l Start Date Ascending
l Start Date Descending

Program Services Data Set Keywords

Data is returned based on the options set on the
Create Document screen; therefore, if a specific
program service keyword is used in the master
document, but a different program service is
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selected on the Create Document screen, the
merge will not return any data for the keyword.

Keyword Definition

[%PS.Name%]
Program service
name

[%PS.Type%]
Program service
type

[%PS.StartDate%]
Program service
start date

[%PS.EndDate%]
Program service
end date

[%PS.Provider%]
Program service
provider

AIS Keywords:

[%PS.AIS.Name%]
Program service
name (AIS)

[%PS.AIS.Type%] AIS service type

[%PS.AIS.StartDate%]
AIS service start
date

[%PS.AIS.EndDate%]
AIS service end
date

[%PS.AIS.Provider%] AIS service provider

[%PS.AIS.EntryReason%]
AIS service entry
reason

[%PS.AIS.ExitReason%]
AIS service exit
reason

[%PS.AIS.SubjectArea%]
AIS service subject
area

[%PS.AIS.SupportService%]
AIS service support
service

[%PS.AIS.FrequencyIntensity%]
AIS service
frequency/intensity

[%PS.AIS.FacultyLastName%]
AIS service faculty
last name

[%PS.AIS.FacultyFirstName%]
AIS service faculty
first name

[%PS.AIS.InterventionType%]
AIS service
intervention type

[%PS.AIS.Comments%]
AIS service
comments

Alternate Assessment Keywords:

[%PS.AltAssessment.Name%]
Program service
name (Alternate
Assessment)
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[%PS.AltAssessment.Type%]
Alternate
Assessment
service type

[%PS.AltAssessment.StartDate%]
Alternate
Assessment
service start date

[%PS.AltAssessment.EndDate%]
Alternate
Assessment
service end date

[%PS.AltAssessment.Provider%]
Alternate
Assessment
service provider

CIP Keywords:

[%PS.CIP.Name%]
Program service
name (CIP)

[%PS.CIP.Type%] CIP service type

[%PS.CIP.StartDate%]
CIP service start
date

[%PS.CIP.EndDate%]
CIP service end
date

[%PS.CIP.Provider%] CIP service provider

[%PS.CIP.ExitReason%]
CIP service exit
reason

[%PS.CIP.Mode%] CIP service mode

[%PS.CIP.Intensity%]
CIP service
intensity

Disability Keywords:

[%PS.Disability.Name%]
Program service
name (Disability)

[%PS.Disability.Type%]
Disability service
type

[%PS.Disability.StartDate%]
Disability service
start date

[%PS.Disability.EndDate%]
Disability service
end date

[%PS.Disability.Provider%]
Disability service
provider

[%PS.Disability.ExitReason%]
Disability service
exit reason

Exempt LEP/ELL Keywords:

[%PS.ExemptLEPELL.Name%]
Program service
name (Exempt
LEP/ELL)

[%PS.ExemptLEPELL.Type%]
Exempt LEP/ELL
service type
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[%PS.ExemptLEPELL.StartDate%]
Exempt LEP/ELL
service start date

[%PS.ExemptLEPELL.EndDate%]
Exempt LEP/ELL
service end date

[%PS.ExemptLEPELL.Provider%]
Exempt LEP/ELL
service provider

Funding Keywords:

[%PS.Funding.Name%]
Program Service
name (Funding)

[%PS.Funding.Type%]
Funding service
type

[%PS.Funding.StartDate%]
Funding service
start date

[%PS.Funding.EndDate%]
Funding service
end date

[%PS.Funding.Provider%]
Funding service
provider

IEP Keywords:

[%PS.IEP.Name%]
Program service
name (IEP)

[%PS.IEP.Type%] IEP service type

[%PS.IEP.StartDate%]
IEP service start
date

[%PS.IEP.EndDate%]
IEP service end
date

[%PS.IEP.Provider%] IEP service provider
LEP/ELL Keywords:

[%PS.LEPELL.Name%]
Program service
name (LEP/ELL)

[%PS.LEPELL.Type%]
LEP/ELL service
type

[%PS.LEPELL.StartDate%]
LEP/ELL service
start date

[%PS.LEPELL.EndDate%]
LEP/ELL service
end date

[%PS.LEPELL.Provider%]
LEP/ELL service
provider

[%PS.LEPELL.Program%]
LEP/ELL service
program

[%PS.LEPELL.ExitReason%]
LEP/ELL service
exit reason

Level of Integration Keywords:

[%PS.LOI.Name%]
Program service
name (Level of
Integration)
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[%PS.LOI.Type%]
Level of Integration
service type

[%PS.LOI.StartDate%]
Level of Integration
service start date

[%PS.LOI.EndDate%]
Level of Integration
service end date

[%PS.LOI.Provider%]
Level of Integration
service provider

Other Program Services Keywords:

[%PS.OtherProgram.Name%]
Program service
name (Other)

[%PS.OtherProgram.Type%] Other service type

[%PS.OtherProgram.StartDate%]
Other service start
date

[%PS.OtherProgram.EndDate%]
Other service end
date

[%PS.OtherProgram.Provider%]
Other service
provider

Section 504 Keywords:

[%PS.504.Name%]
Program service
name (Section 504)

[%PS.504.Type%]
Section 504 service
type

[%PS.504.StartDate%]
Section 504 service
start date

[%PS.504.EndDate%]
Section 504 service
end date

[%PS.504.Provider%]
Section 504 service
provider

Section 504 Safety Net Keywords:

[%PS.Section504SafetyNet.Name%]
Program service
name (Section 504
Safety Net)

[%PS.504SafetyNet.Type%]
Section 504 Safety
Net service type

[%PS.504SafetyNet.StartDate%]
Section 504 Safety
Net service start
date

[%PS.504SafetyNet.EndDate%]
Section 504 Safety
Net service end
date

[%PS.504SafetyNet.Provider%]
Section 504 Safety
Net service provider

Special Program Keywords:
[%PS.SpecialProgram.Name%] Program service



Teacher User Guide Page 83 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

name (Special
Program)

[%PS.SpecialProgram.Type%]
Special Program
type

[%PS.SpecialProgram.StartDate%]
Special Program
start date

[%PS.SpecialProgram.EndDate%]
Special Program
end date

[%PS.SpecialProgram.Provider%]
Special Program
provider

[%PS.SpecialProgram.Frequency%]

Special Program
frequency (number
of times per
interval); only
applies to Special
Programs that are
billed weekly.

[%PS.SpecialProgram.FTE%]

Special Program
FTE (full time
equivalent) value;
only applies to
Special Programs
that are billed
yearly.

[%PS.SpecialProgram.GroupOrIndividua
l%]

Special Program
group or individual
designation

[%PS.SpecialProgram.FacultyFirstNam
e%]

Special Program
faculty first name

[%PS.SpecialProgram.FacultyLastNam
e%]

Special Program
faculty last name

[PS.SpecialProgram.AssociatedProgra
m%]

Program
associated with the
Related Service
record

7. Schedules Data Set

The Schedules data set allows users to retrieve
data about student schedules for the year
specified in the Create Document UI. Depending on
how the options are configured in the UI, courses
that were selected but not scheduled can be
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included using this data set.

Options available on the Create Document screen
include the following:

1. School Year: The school year for which
data will be returned.

2. Include Missing Courses: When checked,
the output will include students’ course
selections that have not yet been
scheduled.

3. Print Order: The order in the courses will
be sorted in the table. Options include:

l Course Name (the default)
l Course ID
l Department/Course Name (sorts

first by department, then by course
name)

l Department/Course ID (sorts first
by department, then by course ID)

l Semester/Period (sorts first by
semester, then by period)

l Period/Semester (sorts first by
period, then by semester)

l Teacher(s)

Schedules Data Set Keywords

Keyword Definition
[%Schedule.Department%] Department

[%Schedule.CourseID%] Course ID
[%Schedule.CourseName%] Course name

[%Schedule.StartTime%] Time at which course starts
[%Schedule.EndTime%] Time at which course ends

[%Schedule.StartPeriod%] Period in which course starts
[%Schedule.EndPeriod%] Period in which course ends
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[%Schedule.Days%] Days course is scheduled

[%Schedule.Semesters%]
Semesters course is
scheduled

[%Schedule.Room%] Room where course is held
[%Schedule.Teachers%] Teacher(s) assigned to course
[%Schedule.Section%] Course section number
[%Schedule.Team%] Team

[%Schedule.Description%] Course description
[%Schedule.Credit%] Course credit value

8. Selections Data Set

The Selections data set allows users to retrieve
information about students’ course selections for
the specified school year specified in the Create
Document UI.

Options available on the Create Document screen
include the following:

1. School Year: The school year for which
data will be returned.

2. Print Order: This is order in the records
will be sorted in the table. Options
include:

l Course Name (the default)
l Course ID
l Department/Course Name (sorts

first by department, then by course
name)

l Department/Course ID (sorts first
by department, then by course ID)

Selections Data Set Keywords

Keyword Definition
[%Selection.CourseName%] Course name
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[%Selection.CourseID%] Course ID
[%Selection.Department%] Department
[%Selection.Description%] Course description

[%Selection.Credit%] Course credit value

9. Transportation Data Set

The Transportation data set allows users to
retrieve data about students’ transportation
schedules as defined on the student record from
within the Transportation module. Because this
information is not stored on a per-school year
basis, the Create Document screen does not
include any filters for this data set. When the
Transportation data set is expanded, the user will
see a message to indicate that this data set is
active.

Transportation Data Set Keywords

Student transportation schedules include
individual selections for both AM and PM
transportation for all school days. Because a
student may have different selections for each one
of these combinations (e.g., Monday AM vs.
Tuesday PM), keywords must reflect both the day
of the week, AM or PM, and the field name.
Therefore, the Transportation data set keywords
are defined according to the following format:
[%Transportation.<DAY><TIME><FIELD>%], where
<DAY> represents the day of the week, <TIME>
represents either AM or PM, and <FIELD>
represents the fields as indicated in the table
below.

For the sake of simplicity, this table includes only
Monday AM keywords. The <DAY> and <TIME>
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portions of these keywords may be replaced with
any other combination of school day and AM or
PM to retrieve data for additional days/times. To
obtain a student’s full transportation schedule, the
master document should contain all combinations
of days and times (e.g., enter
[%Transportation.MondayAMMode%],
[%Transportation.MondayPMMode%], …,
[%Transportation.FridayAMMode%],
[%Transportation.FridayPMMode%] to return the
student’s mode of transportation for the entire
week).

Using the keywords as described above, users can
retrieve the following information:  Mode, Location,
Phone Number, Address, and Dwelling Type.

Keyword Definition
[%Transportation.MondayAMMode%] Student’s mode

of
transportation
for Monday AM.
This shows
either the bus
name or the
selected mode
of
transportation
(as defined in
Transportation
> Maintenance
> Other).

[%Transportation.MondayAMLocation%] Student’s
selected
location for
Monday AM.
This shows
either the
contact name,
the location
name (as
defined in
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Transportation
> Maintenance
> Location), or
the free text
entered in the
“Other
Location” field

[%Transportation.MondayAMPhoneNumbe
r%]

Phone number
tied to the
location (or
contact)
Monday AM
Location. This
will be blank if
the location is a
free text “Other
Location.”

[%Transportation.MondayAMAddress%] Address tied to
the location (or
contact)
assigned to the
Monday AM
Location, which
displays
“Address Line 1,
Unit #, Address
Line 2” as a
single field. 
This will be
blank if the
location is a
free text “Other
Location.”

[%Transportation.MondayAMAddress1%] Address line 1
(including Unit
#) tied to the
location (or
contact)
assigned to the
Monday AM
Location. This
will be blank if
the location is a
free text “Other
Location.”
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[%Transportation.MondayAMAddress2%] Address line 2
tied to the
location (or
contact)
assigned to the
Monday AM
Location. This
will be blank if
the location is a
free text “Other
Location.”

[%Transportation.MondayAMUnit%] Unit # tied to
the location (or
contact)
assigned to the
Monday AM
Location. This
will be blank if
the location is a
free text “Other
Location.”

[%Transportation.MondayAMCityStateZip%] City, State, and
Zip tied to the
location (or
contact)
assigned to the
Monday AM
Location, which
displays “City,
State Zip” as a
single field. 
This will be
blank if the
location is a
free text “Other
Location.”

[%Transportation.MondayAMCity%] City tied to the
location (or
contact)
assigned to the
Monday AM
Location. This
will be blank if
the location is a
free text “Other
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Location.”
[%Transportation.MondayAMState%] State tied to the

location (or
contact)
assigned to the
Monday AM
Location. This
will be blank if
the location is a
free text “Other
Location.”

[%Transportation.MondayAMZipCode%] Zip code tied to
the location (or
contact)
assigned to the
Monday AM
Location. This
will be blank if
the location is a
free text “Other
Location.”

[%Transportation.MondayAMDwellingTyp
e%]

Dwelling type
associated with
the address of
the location (or
contact)
assigned to the
Monday AM
Location. This
will be blank if
the location is a
free text “Other
Location.”

10. User Defined Assessments Data Set

The User Defined Assessments data set allows
users to retrieve data about students’ User Defined
Assessment records. Data is returned based on
the options set on the Create Document screen;
therefore, if a specific user defined assessment
keyword is used in the master document, but a



Teacher User Guide Page 91 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

different user defined assessment is selected on
the Create Document screen, the merge will not
return any data for the keyword.

Data set options include:

l User Defined Assessment (drop-down):  This
drop-down provides a list of all User Defined
Assessments to which the user has access.
Select the appropriate value from the list to
return data for that assessment. The screen
will display all fields defined (including any
inactive fields) for the selected assessment
to allow the user to further specify which
records should be returned.

l School Year (drop-down): Use this drop-
down to specify a school year for which User
Defined Assessments records should be
included (or select ANY to show records for
any school year).

l User Defined Assessment-specific fields: All
active fields for the selected User Defined
Assessment will appear here and will display
the field type. The user may enter text or
numbers, select radio button options, or
select values from drop-downs as
appropriate to return records matching the
specified criteria. Any fields marked as
“inactive” in Maintenance for that User
Defined Assessment will be available here,
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allowing users to include historical data as
needed.

l Any drop-downs configured in Maintenance
for this User Defined Assessment will also
appear in this data set, and the user may
select any item from the drop-down to return
records matching that value.

l For User Defined Assessments using alpha
grading scales, values for those fields will be
returned as the symbol for that value rather
than the full text (for example, a score of
“Exceeds Expectations” might display “4+”
instead). This is based on Grading Scale
settings defined in Maintenance.

l Print Order: The order in the records will be
sorted in the table. Options include:

l School Year Ascending
l School Year Descending

User Defined Assessments Data Set Keywords

Because the User Defined Assessments keywords
are specific to the selected user defined
assessment, the keywords for this data set are not
pre-defined and must be entered by the user
according to the following format:
[%UDA.<ASSESSMENT>.<FIELD>%], where
<ASSESSMENT> is the name of the assessment
and <FIELD> is the name of the field. Both the
assessment name and the field names should be
entered exactly as they are defined in
Maintenance, including any spaces or punctuation.

For example, records for a user defined
assessment called “AP Readiness” might have
fields titled “Exam Name”, “Date”, “Score”,
“Approved?” and “Notes”.  The keywords for this
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user defined assessment would be defined as
follows:

[%UDA.AP Readiness.Exam Name%]

[%UDA.AP Readiness.Date%]

[%UDA.AP Readiness.Score%]

[%UDA.AP Readiness.Approved?%]

[%UDA.AP Readiness.Notes%]

In addition to the fields defined in Maintenance, all
user defined screen records are associated with a
school year, which may also be used as a
keywords.  The school year keyword should
always be entered using “SchoolYear” without
spaces, as the field name (for example, [%UDA.AP
Readiness.SchoolYear%] would be the keyword for
the AP Readiness assessment).

11. User Defined Screens Data Set

The User Defined Screens data set allows users to
retrieve data about students’ User Defined Screens
records. Data is returned based on the options set
on the Create Document screen; therefore, if a
specific user defined screen keyword is used in
the master document, but a different user defined
screen is selected on the Create Document screen,
the merge will not return any data for the keyword.

Options include:
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1. User Defined Screen (drop-down):  This
drop-down provides a list of all User
Defined Screens to which the user has
access. Select the appropriate value from
the list to return data for that screen. The
active fields for the selected screen will
appear to allow the user to further specify
which records should be returned.

2. Currently Active / Active Between: Use
these radio buttons to specify which User
Defined Screen records should be
included.

l Currently Active: This option
includes only records that are
currently active.

l Active Between:  Enter a start date
and end date to search for any
records that were active during a
specific date range (these dates
both default to the current date
when this option is selected).

3. User Defined Screen-specific fields: All
active fields for the selected User Defined
Screen will appear here and will display
the field type. The user may enter text or
numbers, or may select radio button
options, as appropriate to return records
matching the specified criteria.

Any drop-downs configured in
Maintenance for this User Defined Screen
will also appear in this data set, and the
user may select any item from the drop-
down to return records matching that
value.

4. Print Order: The order in the records will
be sorted in the table. Options include:
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l Date Ascending
l Date Descending

User Defined Screens Data Set Keywords

Because the User Defined Screens keywords are
specific to the selected user defined screen, the
keywords for this data set are not pre-defined and
must be entered by the user according to the
following format: [%UDS.<SCREEN>.<FIELD>%],
where <SCREEN> is the name of the screen and
<FIELD> is the name of the field. Both the screen
name and the field name should be entered exactly
as they are defined in Maintenance, including any
spaces.

For example, records for a user defined screen
called “Parking Assignment” might have fields
titled License Plate, Parking Lot, and Parking
Permit Number. The keywords for this user
defined screen would be defined as follows:

[%UDS.Parking Assignment.License Plate%]

[%UDS.Parking Assignment.Parking Lot%]

[%UDS.Parking Assignment.Parking Permit
Number%]

In addition to the fields defined in Maintenance, all
user defined screen records have Start Date and
End Date fields, which may also be used as
keywords, using “StartDate” and “EndDate,”
without spaces, as the field name (for example,
[%UDS.Parking Assignment.StartDate%] would be
the keyword for the Parking Assignment screen).

Users may set their own Print Order and can determine the appropriate recipients for the
communication based on either pre-defined options defined by the district or by
selecting options in a “user defined” configuration area.



Teacher User Guide Page 96 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

A subset of the Actions keywords are referred to as "Recipient Keywords"; some of
these keywords are only available when using “One per Student” recipient options rather
than “One per Household” options.

l

Basic Merge Options

The basic merge options allow you to select your document format and
specify behavior for that format.

l Letter Format / Label Format (radio buttons): Select the appropriate
radio button to indicate the format of the master document.

l Insert Page/Document Break (checkbox):  When checked, a
page break will be inserted between each student record (or, if
the same student is included multiple times, between each indi-
vidual instance of that record).

l Repeat each label … times (numeric field): the number of times
each label should be duplicated. When sending to multiple con-
tacts for the same student, this will duplicate labels for each
contact. This field is unavailable when “Letter Format” is selec-
ted.

l Print Order (drop-down): The order by which labels are sorted when
the document is generated. Options include Student Last Name (the
default), Student ID, Homeroom, Counselor Last Name, Grade, Mail-
ing Zip Code.

Note: The Merge button is on the right side of the screen in this area.
Clicking this button completes the merge based on the keywords included
in your document, and creates the final output. The Merge button should
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be used only once all other options on this page have been set properly
and you are ready to complete the merge.

l

Recipient Keywords and Options

The recipient section allows the user to determine which contact types
should be included as recipients. Users may have access to a drop-down
of pre-defined recipient lists, which are defined by the district in the
Maintenance module. Users may also be able to configure their own set
of recipients by selecting the “User Defined” recipient option. This “User
Defined” option contains a series of drop-down lists where users may
select options based on relationship settings in the Census module.

Access to the various components in the Recipient area is controlled by
user permissions, so users may not see all of the options described in this
section.

1. Pre-Defined option: This drop-down contains a list of pre-defined
recipient types. These values are pre-defined by the district in the
new Maintenance > District > Recipient Lists area. 

2. User Defined option:  This option allows users to specify the type
of recipients to use for this merge based on relationship settings
in Census.

A. Primary Contact
i. Yes: Include only primary contacts
ii. No: Include only non-primary contacts
iii. Both: Include both primary and non-primary

contacts
B. Receives Mail

i. Yes: Include only mail recipients
ii. No: Include only non-mail recipients
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iii. Both: Include both mail recipients and non-
mail recipients

C. Parent
i. Yes: Include only parents
ii. No: include only non-parents
iii. Both: Include both parents and non-parents

D. Custodial
i. Yes: Include only those living with the student
ii. No: Include only those not living with the stu-

dent
iii. Both: Include contacts regardless of address

E. Parent Portal
i. Yes: Include only those with Parent Portal

access
ii. No: Include only those without Parent Portal

access
iii. Both: Include contacts regardless of Parent

Portal access
F. Quantity to Print:

i. One per household: Selecting this option will
print a letter or label for each household,
regardless of the number of students in that
household. The term "household" refers to the
actual address; if the selected recipients
include multiple contacts for a student, a sep-
arate letter or label will be generated for each
contact living at a different address.

This type of mailing is used to create letters or
labels for mass mailings that are not student-
specific (general school announcements, for
example). Merge documents using this option
may only use the following keywords, as these
keywords refer to the recipient rather than to a
specific student:

l [%Recipient.Name%]
l [%Recipient.MailingAddress1%]
l [%Recipient.MailingAddress2%]
l [%Recipient.MailingCity%]
l [%Recipient.MailingState%]
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l [%Recipient.MailingZipCode%]
l [%Recipient.PhoneNumber%]

ii. One per student: Selecting this option will print
a letter or label for each student. If multiple
recipients are included, a separate letter or
label will be generated for each contact selec-
ted for each student (regardless of where each
recipient lives).

This type of mailing allows users to create
documents using keywords to retrieve student-
specific data. All Actions keywords, recipient
keywords, and data set keywords are available
for this type of merge.

Basic Workflow:

1. Create your merge document, including any keywords, and apply formatting as
desired. Save in appropriate file format.

2. Navigate to Home > My Home > Actions, select the Create Document option,
and select the appropriate students.
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3. On the Create Document screen, set your merge options:
l Set basic merge options (document format, print order, page breaks, etc.)

l Specify recipients using pre-defined or user-defined options

4. Expand data sets and specify options as appropriate.

5. Scroll to the top of the screen and upload the merge document.

6. Click the Merge button. This completes the merge based on the keywords
included in your document and creates the final output. The Merge button
should be used only once all other options on this page have been set properly
and you are ready to complete the merge.
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Depending on the amount of data being included in the merge, it may take a few
moments for the merge to finish. Once complete, the merge file will be downloaded
automatically. To open it, simply locate the XML file that was downloaded and double
click to open it.

Send Direct Notification

Once you have selected "Send Notification" as your initial option and have performed
the appropriate search steps, you will be presented with the Send Direct Notification
screen:

To send a direct push notification to students' mobile devices, type the message you
wish to send. Messages are required and limited to 255 characters. Users can also
create a title, if desired.

Please note that only students who are configured to receive push notifications will
receive the messages sent. The list of selected students on the Send Direct Notification
page will indicate the number of students who will receive the notification. Each student
who will are able to receive the notification will have a mobile phone icon next to their
name.
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Once the message is ready, click Send. Users will receive a confirmation message with
the amount of students who received the message, and a list of their names.

Campus Tab
All users see this tab. This tab lists any pertinent school information, cycle days,
announcements, etc.

Messages Tab
This tab displays any available messages. These messages may contain text, links,
images, or attachments. If the message has an attachment, an icon and the attachment
filename will be displayed at the bottom of the message. To download an attachment,
simply click on the icon beside the filename.

The Home > My Home > Messages tab will display a green circle when a new message
has been published on the current date.
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Classes Tab
If you are a teacher and have classes, a list of your currently active courses will appear
on the screen, on the Classes tab. If the Master Schedule is unlocked, you will only be
able to see your Homeroom in the current year’s list, if you have one. To view only
classes that meet on the current cycle day this semester, select the “Today” option. You
may also select another year by selecting the “All Years” and choosing a year from the
drop-down list. Depending on your district’s configuration, you may be unable to view
class and/or homeroom information until after schedules have been published.

Note: Selecting a past year’s course will allow you to see that course’s grade book, if one
exists. If the grading interval is currently locked, the grade book will appear in read-only
mode.

Teachers can take period attendance for multiple course sections that meet
simultaneously by choosing the appropriate time from the drop-downs and clicking the
Take Attendance button above the class list. Please refer to the section on Taking
Attendance for Multiple Sections for more information on using this feature.

Depending on permissions, other icons may be available.

l Google Classroom Sync icon – allows teachers to sync all linked class rosters
to Google Classroom. To link rosters, navigate to that course roster and select a
Google Classroom to link to.

l Dashboards icon – opens the Faculty View dashboard for the current user.

The list of classes will also include several icons, which allow you to perform a variety of
tasks. These icons act as shortcuts to the Teacher Tabs, which exist for each class.
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Clicking on any of the icons will bring you directly to the corresponding tab for that
class.

l Select button – select that class and refresh the screen with new information.
Depending on the status of the selected class, you may be brought directly to the
Grade Book view, or you may be prompted to enter or select other information.
You may also see additional tabs, such as Attendance, Roster, Alerts, and Seating
Chart.

l Roster icon – see additional information about the students enrolled in that
class. The Roster list may also display certain student alerts, depending on district
settings.

l Grade Book icon – jump directly to the Grade Book for that particular class. The
icon will not appear for classes, such as Homeroom, that do not use a Grade Book.

l Seating Chart icon – view or edit the seating chart for any of the classes listed.
l Teacher Page icon – view the Teacher Page, including any teacher notes and/or

daily notes, for that section.
l Alert Flag icon – shows any existing Attendance alerts. If the Flag appears, it

means there are existing attendance alerts. Typically alerts are used to indicate
that attendance has not been taken for this course for a given number of days (as
defined by your district).

Note: When you use any of the icon buttons, you will see several additional Teacher
Tabs. These additional tabs are described in the next section of this document, although
the availability of specific tabs may vary depending on the type of class selected.

If you have been assigned any Faculty Duties, these will be listed below the Class List.

If your district uses the Discussions feature, you will see an indicator in the upper
right corner of the screen showing the total number of unread messages. Clicking on
this icon will navigate you directly to the Home > Discussions sub-module.

Teacher Tabs Overview

Once you have logged in and selected a class, a new set of tabs will appear. These tabs
provide information specific to the selected class. Available tabs include Info,
Attendance, Roster, Grades, Alerts, and Seating Chart.

Attendance Tab: When teachers log in and select a class, the Attendance tab will
automatically open as the default if attendance is required for the selected class. This



Teacher User Guide Page 105 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

tab allows teachers to take attendance for this class, if appropriate for your school or
district. See the section on My Home > Classes > Attendance Tab for more information.

Roster Tab: The Roster tab shows a list of all students who are in this section of this
class for the entire duration of the class, regardless of the marking period. It also shows
icons for student alerts (AIS alerts, IEP Viewer alerts, and Medical alerts). See the
section on My Home > Classes > Roster Tab for more information.

Grades Tab: The Grades tab is where all grading tasks are completed. You may create
grade books and grade daily assignments here, as well as complete other tasks such as
entering progress reports, marking period report card grades, final exam grades, and any
state assessment grades.
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Info Tab: The Info tab shows you information about the class you have selected, such
as days when the class meets, the room where the class meets, a description, etc. This
tab provides information in read-only mode, and is only available when you have
selected a general education class, a special education class, or a subject-area class
such as Art or Music.

Alerts Tab: The Alerts tab shows you messages about tasks that have not been
completed, such as submitting attendance.

Seating Chart: The Seating Chart tab allows you to organize all of your students’ photos
in a manner that reflects their seats in the class. The seating chart allows teachers to
drag and drop photos to rearrange seating charts, see only students that are scheduled
for class on the specified day, and create printable seating layouts in either portrait or
landscape mode. Teachers can also print out any day’s seating chart for use by a
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substitute teacher. See the section on My Home > Classes > Seating Chart Tab for more
information.

My Home > Teacher Pages

Teacher Pages allow teachers to provide information and communicate with their
students, such as posting announcements, course expectations, etc. for individual
course sections.

To access Teacher Pages as a teacher’s, navigate to the My Home > Classes tab and
click on the Teacher Pages icon for the appropriate section.

Currently, Teacher Pages show course information for that section, including teacher
name(s), section number, cycle days, semesters, section number, and room number.
They also show any notes the teacher has entered for that course section.

Editing Teacher Notes

Teachers with edit permissions can also modify the Teacher Notes section. To update
Notes, click the Edit button and enter the desired text.
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Click the Save button to apply the changes or click Cancel to return to the Teacher Page
without saving.

Once changes have been saved, they will be visible in read-only mode on the Teacher
Page.

Daily Notes

Below the teacher notes is an area for Daily Notes. When teachers add daily notes, the
most recent note will always be displayed at the top.

To post a daily note, simply click the Add Daily Note button and enter the desired text.
Depending on district settings, teachers may have the ability to control whether or not
posts are visible, whether or not students can respond to a daily note, and whether or
not those responses are moderated. These options are specific to individual daily notes,
and are unchecked by default.
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Allow Responses: When this option is turned on (checked), students will see the Reply
box below that daily note. Keep in mind that all notes and any responses will be visible
to anyone who has access to this Teacher Page (this may include teachers, students,
and parents).

Enable Moderation: When this option is turned on, students' responses must be
approved before they become visible to other users. When moderation is turned on,
students will see a message that their posts are awaiting approval. Teachers will see an
Approve button next to posts that are awaiting approval, but other users will not see the
post until after it is approved.
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Teachers can also delete any responses; simply click the Delete button to the left of
the response you want to remove. A message will display indicating that a response has
been deleted.

My Home > Classes > Roster Tab

The Roster tab shows a list of all the students who are in this section of the selected
class. This list may be filtered by semester, scheme, and/or cycle day (the Scheme drop-
down may or may not be available depending on the district’s cycle day configuration).
Depending on district settings and permissions, you may also see students' home
district assignments and/or nicknames (note that the Nickname field is an optional,
free-text field that is managed from within the Census module; it may or may not be
populated with data).

From the Roster you may view student alerts and access students’ Personal Information
Records (the ability to see alert icons is permission-based, so not all users will see these
icons). Refer to the section on Student Alerts for details on what each icon means.

To view the Student Record for any student, simply click on the student's name in the
list. For details on viewing the Student Record, refer to the My Home > Student Record
section.
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In addition, you may print a roster by clicking on the Roster Report icon. The report will
respect the selected Semester, Scheme, and Day filters when generating the report.

Teachers whose districts use SchoolTool Premier may also have access to the Roster
Average Dashboard icon in the upper right of the screen.

The dashboard will open in a new window, allowing the teacher to view each chart as an
average of all students on that roster. A section filter is available at the top of the
screen; to see data for other sections, simply select the section(s) to view and click the
Update Page Data button.

Depending on district settings, users may be able to sync their rosters to Google
Classroom using the Google icon on the top right of the screen.
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If the class roster has not been previously synced to Google Classroom, a window will
appear, asking to either create a new classroom in Google to send the roster to, or to
add to an existing class.

Click Sync to send the roster. A message will appear if the sync was successful.

The same icon can also unlink a previously sent roster from Google Classroom. After
clicking Unlink and confirming you wish to unlink, a confirmation message will appear if
it was successful.

There are several types of alerts that may be visible on a teacher's class roster and also
on individual students' Personal Information Records. In addition, the alert icons may
provide more information on the specific alert, which displays in a text box that appears
when the user holds the mouse over an alert icon.

Available alerts include the following icons and corresponding mouse-over text:

AIS Program
Service

Icon:

IEP Viewer

Icon:

Medical
Alerts

Icon:

Custom Alerts

Icon:

Send
Notification

Icon:

Mouse-over
text:

Mouse-over
Text:

Mouse-over
text:

Note: Custom
Alerts are
indicated by a
flag or other
image and
may be any
color defined
by the district.

Clicking this
icon opens a
pop-up
where users
can enter a
message to
send to this
student via
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The mouse-
over text will
display the
name of the
custom alert
as defined in
Maintenance.

direct noti-
fication in
the
SchoolTool
mobile app

Student RTI
Information

Icon:

View
Shared
District
Data

Icon:

Student
Dashboard
Viewer

Icon:

WebEdge
Student
Portfolio
Viewer

Icon:

Hovering the
mouse over
this icon will
display a list
of that
student's
active RTI
records.

Clicking
this icon
opens a
window to
display
student
data shared
by another
district.

This icon
appears
only when
districts
have
configured
data
sharing.

Clicking this
icon opens
a window to
display the
Student
View
dashboard
for that
student.

Clicking this
icon opens a
window to
display the
WebEdge
Student
Portfolio for
that student.

The visibility of these alerts is controlled by district permission settings. Users may be
able to see the alert icon only, the mouse-over text description only, both, or none of
these, depending on their user permissions. Separate permissions also control whether
users may see these icons on a teacher's Roster.

The Send Notification button appears for students who have opted to receive direct
notifications in the SchoolTool mobile app (this also requires that the district has
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configured that building school level to allow direct notifications). Click the Send
Notification button and enter a title and message to send to the student, then click
Send. The message will be delivered as a notification on the student’s mobile device.

Users with permission to view students' SchoolTool Premier dashboards may see a
SchoolTool Dashboard Viewer icon for students who have a Student ID and have ever
had an in-district enrollment. If this icon appears, users can click on the Viewer icon to
view that student's dashboard in a new window.

If shared data is available from another SchoolTool district, a View District Data icon
may appear on in the alerts area. This will allow the user to view data from another
district that has been configured for district-to-district data sharing (most likely between
a BOCES and home district). To view shared data (or shared report cards and/or
transcripts), hover over the District Data icon and Select the desired option (View
District Data, View District Report Card, or View District Transcript) from the dropdown.
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If the user has View or Edit rights, corresponding buttons will be available for each
record (either an Edit icon, for users with Edit permissions, or a Select icon, for
users with View permissions).

or

Viewing RTI Records

Users with View rights only will see Select icons for each record in the list.

Select a record to view details in read-only mode. Click the Back button to return to the
student record. Click the RTI Detail Report icon to print the RTI record and its
associated intervention details.
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Editing RTI Records

Users with Edit rights can click the Edit button for any of the RTI records listed.

Click the Edit icon for any record to open it in edit mode. Make changes as needed
and click Save to return to the student record. Please note that any number of
interventions may be edited or added, but the top section of the RTI record cannot be
changed from this screen. Click the RTI Detail Report icon to print the RTI record and
its associated intervention details.

My Home > Classes > Seating Chart Tab

Any teacher that has classes assigned to them has access to a Seating Chart tab that
will allow all of their students' photos to be organized in a manner that reflects their
seats in the class. The seating chart will enable teachers to:
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l Drag and drop photos to rearrange seating charts
l See only students that are scheduled for class on the specified day
l Print any day's seating chart for use by substitute teachers
l Create printable seating layouts in either portrait or landscape mode

Viewing a Seating Chart

To use the seating chart navigate to Home > My Home > Seating Chart.

The Seating Chart screen contains the following components:

l Date Field – the Date field will default to the current date, and will cause the seat-
ing chart to display only students for that date. To view students for a different
date, enter the desired date, or use the date selector to do so, and click on the
Select Dates button to refresh the screen.

l Print – the Report button in the upper right corner of the screen will open a new
window to that displays the seating chart and course information only. This report
is displayed as an HTML page and does not utilize the standard report viewer. To
print the Report, locate your browser's print button in the Report window, and print
as you would a normal web page.

l Edit – the Edit button allows the changing of student seat locations within the
window. See below for specifics.

l Back – the Back button returns the user to their Home > My Home screen.

Modifying a Seating Chart

Any seating chart can be modified by a teacher:

1. Select the desired date, and click the Select Dates button to refresh the
screen if necessary.

2. Click the Edit button
3. Select either the Portrait or Landscape option as desired. This changes the

overall orientation of the "classroom" to vertical (portrait) or horizontal (land-
scape). Changing this will alter how the Seating Chart is displayed and printed.
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l It is possible to have student images outside of the border when chan-
ging from one of these options to the other. If this happens, simply drag
the student image back toward the center of the screen.

4. Drag and drop the student photos, one at a time, to a location on the screen
that reflects the classroom layout.

5. Save all changes with the Save button, or use the Cancel button to cancel
any modifications.

For all days, past and present, each student will remain in the same "seat" until moved.
New student images will be displayed as students enter the course, and students
leaving the course will no longer display.

My Home > Classes > Attendance Tab

The Attendance tab respects the school calendar, as set up in Maintenance. This
includes grade-specific calendar entries, such as days where all students in a certain
grade level are scheduled to be out of school (all ninth graders are on a school trip, or
Regents testing days, for example).

Taking Daily Attendance

New York State requires teachers to take daily attendance. This could be through an
assigned homeroom or general education class, or via a period which has been
designated to drive daily attendance, such as period 1. Attendance taken in homeroom
or a designated period can affect the entire day’s attendance based on your district
preferences. For example, if a student is marked absent, they will appear absent to every
other teacher who has them in a class throughout the day. Use this section to become
familiar with taking daily (i.e. full day) attendance.

From your Class list (in My Home), select your Homeroom or choose the period which
drives daily attendance.
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The Attendance tab will automatically open, displaying a list of students with radio
buttons or check boxes next to their pictures/names.

HOMEROOM ATTENDANCE PERIOD ATTENDANCE

A message letting you know whether or not you have submitted attendance yet displays
above the date field.

The date field allows you to view and/or submit attendance for previous days.
Attendance cannot be submitted for future dates.

1. Take attendance for each student: click once on the appropriate radio button to
show if a student is:

l P for present (the default), or
l A for absent, or
l T for tardy, or
l K for known absence (this will only appear if you are taking daily attend-

ance during a period course – see below right and if your district allows
it.)
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The availability of these radio button options is a district preference. If
you are only allowed to mark a student Absent, radio buttons do not
appear; instead you will use a check box to mark students absent.

Note: For certain types of student visits, “Absent” may be pre-selected if
the visit spans the entire period.

2. In addition, users who have permission to submit period attendance minutes
will see an additional “Minutes” column on the Period Attendance screen (not
shown in these screen shots).

l To submit period attendance minutes, select the appropriate attendance
option (P, A, T, or K, if applicable) and enter the appropriate numeric value
in the Minutes field to specify the number of minutes the student atten-
ded the course that day/period. The Minutes value will default to the full
course minutes as defined in the Course Catalog. When a student is
marked Absent, the Minutes value will default to zero (0). Depending on
your district’s configuration, these values may or may not be allowed to
exceed the maximum number of course minutes.

l Users with permission to batch enter minutes will see a Batch Adjust
Minutes icon in the Minutes column header. Clicking on this icon
allows the user to enter a value to copy to all rows.

Note: Period attendance minutes are not available for courses defined as
using subject-based minute calculations.

3. Period Reason: If that building school level allows teachers to resolve period
absences and/or period tardies, an additional “Reason” column will display on
this screen.

When a student is marked Absent or Tardy, a drop-down will appear in the
Reason column, allowing the teacher to select from a pre-defined list of



Teacher User Guide Page 121 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

reasons. Once attendance is submitted, the period absence or tardy will be
resolved with the selected reason.

Note: The Reason drop-down will not appear when a student is marked Absent
if this period drives daily attendance or when a student is expected to be
absent due to a daily absence, student visit, ISS/OSS, etc.

A. When you have finished marking each student’s attendance, click
once on the green Submit Attendance icon in the upper right corner
of the tab. The tab will refresh, showing a confirmation message in
the upper left corner of the window indicating that the attendance has
been submitted successfully and is saved.

B. Repeat the steps above for each subsequent course until you have fin-
ished taking attendance.

Note: The Attendance sub-module respects the school calendar, as
set up in Maintenance. This includes grade-specific calendar entries,
such as days where all students in a certain grade level are scheduled
to be out of school (all ninth graders are on a school trip, or Regents
testing days, for example).

4. When you have finished taking attendance, click the Save button in the upper
right corner to update the attendance record. When attendance has been suc-
cessfully saved, you will receive a confirmation message that “Attendance has
been submitted.”

Note: District policy dictates whether homeroom attendance can be
updated/re-submitted after it has been initially saved. If your district allows
this, the save button remains on the screen for the rest of the day; if this is not
allowed, the save button will disappear after the record is saved.

Additional Options
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The information and options displayed on attendance screens is dependent on district
settings, so these screens may look slightly different from the screenshots below.

For example:

l Custom Alerts: If your district has configured custom alerts for display on attend-
ance screens, you may see a column at the far left that shows the available cus-
tom alerts for that student. This column is provided for informational purposes
only. Hovering over a custom alert image will display the name of the alert.

l Remote Attendance: If your district is using Remote Attendance options, you may
see one or two columns with checkboxes to indicate whether a student was In Per-
son or Remote (Out) and/or if the student received In Person or Remote instruc-
tion on that day. These options are used for tracking and reporting purposes only
and should be used in conjunction with the present/absent options.

l Submitting Daily Attendance from Period Screens: Depending on district settings,
users may also have the ability to submit daily attendance from this screen (this is
most often used in BOCES environments or in other situations where a dedicated
attendance clerk does not exist).

1. To submit daily attendance (absences, ins, or outs), simply click the Add
button in the Daily Reason column.

2. Using the pop-up, specify the details of the daily attendance record and
click Save.
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3. To modify daily attendance or enter additional records, hover over the
Edit button for a student's daily record and choose the appropriate
Add , Edit , or Delete option as desired.

Taking Period Attendance

New York State requires secondary teachers to take period attendance for each period
of the day. Use this section to become familiar with taking period attendance.

From your My Home view, select the class period you wish to take attendance for by
clicking the Select button to the left of the class. The Attendance tab will automatically
open, displaying a list of students with radio buttons or check boxes next to their
names.
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Note: Teachers can also take period attendance for multiple course sections that meet
simultaneously by choosing the appropriate time from the drop-downs and clicking the
Take Attendance button above the class list. Please refer to the section on Taking
Attendance for Multiple Sections.

RADIO BUTTONS FOR ATTENDANCE CHECK BOXES FOR ATTENDANCE

A message letting you know whether or not you have submitted attendance displays
above the date.

The date field allows you to submit attendance for today, and view attendance for
previous days.

Submitting Attendance

1. Present/Absent Options: To take attendance for each student, click once on
the appropriate radio button to the right of each student to show if the student
is:

l P for present (the default)
l A for absent (does not appear in class)
l T for tardy (arrives to class late)
l K for known absence (student has a legitimate reason for not being in the

period)

The availability of these radio button options is a district preference. If
you are only allowed to mark a student Absent or Present, radio buttons
do not appear; instead you will use a check box to mark students absent.

Students who have a scheduled student visit that spans the entire period
or does not have an end time will be set to “Absent” by default.
Additionally, if a student has a scheduled visit during a period that drives
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daily attendance and is marked absent in that period, a daily attendance
record will not be generated.

2. Minutes: In addition, users who have permission to submit period attendance
minutes will see an additional “Minutes” column on the Period Attendance
screen (not shown in these screen shots).

l To submit period attendance minutes, select the appropriate attendance
option (P, A, T, or K, if applicable) and enter the appropriate numeric value
in the Minutes field to specify the number of minutes the student atten-
ded the course that day/period. The Minutes value will default to the full
course minutes as defined in the Course Catalog. When a student is
marked Absent, the Minutes value will default to zero (0). Users may
enter any numeric value between 0 and 999 (values must be non-negative
whole numbers).

l Users with permission to batch enter minutes will see a Batch Adjust
Minutes icon in the Minutes column header. Clicking on this icon
allows the user to enter a value to copy to all rows.

Note: Period attendance minutes are not available for courses defined as
using subject-based minute calculations.

3. Period Reason: If that building school level allows teachers to resolve period
absences and/or period tardies, an additional “Reason” column will display on
this screen.

When a student is marked Absent or Tardy, a drop-down will appear in the
Reason column, allowing the teacher to select from a pre-defined list of
reasons. Once attendance is submitted, the period absence or tardy will be
resolved with the selected reason.
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Note: The Reason drop-down will not appear when a student is marked Absent
if this period drives daily attendance or when a student is expected to be
absent due to a daily absence, student visit, ISS/OSS, etc.

4. When you have finished taking attendance, click the Save button to update
the attendance record. You will receive a confirmation message that “Attend-
ance has been submitted” indicating a successful save.

Note: District policy dictates whether period attendance can be updated/re-
submitted after it has been initially saved. If your district allows this, the save
button remains on the screen; if not, the save button will disappear after the
record is saved.

Additional Options

The information and options displayed on attendance screens is dependent on district
settings, so these screens may look slightly different from the screenshots below.

For example:

l Custom Alerts: If your district has configured custom alerts for display on attend-
ance screens, you may see a column at the far left that shows the available cus-
tom alerts for that student. This column is provided for informational purposes
only. Hovering over a custom alert image will display the name of the alert.

l Remote Attendance: If your district is using Remote Attendance options, you may
see one or two columns with checkboxes to indicate whether a student was In Per-
son or Remote (Out) and/or if the student received In Person or Remote instruc-
tion on that day. These options are used for tracking and reporting purposes only
and should be used in conjunction with the present/absent options.
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l Submitting Daily Attendance from Period Screens: Depending on district settings,
users may also have the ability to submit daily attendance from this screen (this is
most often used in BOCES environments or in other situations where a dedicated
attendance clerk does not exist).

1. To submit daily attendance (absences, ins, or outs), simply click the Add
button in the Daily Reason column.

2. Using the pop-up, specify the details of the daily attendance record and
click Save.

3. To modify daily attendance or enter additional records, hover over the
Edit button for a student's daily record and choose the appropriate
Add , Edit , or Delete option as desired.

Taking Attendance for Multiple Sections

Teachers can take period attendance for multiple course sections that meet
simultaneously from the Home > My Home > Classes Tab.
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This feature applies only to period-based courses, so this option may not be visible for
all users and cannot be used for supplemental courses/homerooms.

1. To use this feature, choose the appropriate time from the drop-downs and click
the Take Attendance button. The time is set to the current time by default.

2. The teacher will be redirected to an attendance screen that displays all stu-
dents who are scheduled for classes that meet at the selected time on that
day. The tab at the top of the screen will indicate the time that was selected.
This screen does not allow users to enter attendance for any day other than the
current date.

Note: Teachers will not be able to access any section-specific tabs, such as the
Roster or Grades tab, from this screen.

3. Use the radio buttons or checkboxes to enter the attendance for each student
and click the Save button to submit attendance for these students.

4. All building school level attendance options and period structures will be
respected when taking attendance for multiple sections. Therefore, some
options may not be available for some students. In addition, if the selected
time corresponds with a period that is used to drive daily attendance for any
students on this screen, a daily absence will be automatically recorded for
those students as appropriate.

5. Attendance may still be taken for each section individually if desired by nav-
igating to the appropriate section from the list on the Classes tab.
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Note: If sections include students from multiple building/school levels,
teachers must have the appropriate rights for each of these buildings and/or
school levels to see all students.

The information and options displayed on attendance screens is dependent on
district settings, so these screens may look slightly different from the
screenshots below.

For example:

l If your district has configured custom alerts for display on attendance
screens, you may see a column at the far left that shows the available
custom alerts for that student. This column is provided for informational
purposes only. Hovering over a custom alert image will display the name
of the alert.

l If your district is using Remote Attendance options, you may see one or
two columns with checkboxes to indicate whether a student was In Per-
son or Remote (Out) and/or if the student received In Person or Remote
instruction on that day. These options are used for tracking and reporting
purposes only and should be used in conjunction with the present/absent
options.

My Home > Classes > Alerts Tab

The Alerts tab shows a list of attendance alerts for that class. Here, the teacher will see
a separate alert for each day on which course attendance was not submitted.
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Clicking on the Select button for an individual alert will take the user directly to the
attendance screen for the specified day, where the teacher may then submit attendance
as appropriate.

My Home > Classes > Info Tab

The Info tab shows a summary of that course’s details. This tab includes the following
information:

l Course number and name
l School Level: The school level for this course
l Department: The department for this course
l Gender: The gender assigned to this course (Male, Female, or Co-Ed)
l Description: The description of this course as defined by the course catalog
l Prerequisites: Lists any prerequisites required for this course
l Days: The days on which this course meets
l Period: The period in which this course meets
l Room: The room assigned to this course
l Marking Periods: The semester(s) during which this course is held
l Teachers: The teacher(s) assigned to this course

My Home > Classes > Recommendations Tab

The Recommendations tab allows teachers to submit course recommendations for the
following school year for each of their students. Submitted recommendations can be
reviewed by the appropriate scheduling/counseling staff and can be approved as



Teacher User Guide Page 131 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

appropriate. Once recommendations are approved, students will receive course
selections for the recommended courses.

Note: Access to the Recommendations tab is controlled by user permissions, so not all
users will have the ability to submit recommendations.

In course sections that have multiple teachers assigned to the section, each teacher can
submit his or her own recommendations. If a student has already received one or more
recommendations for other courses within that department, a "More Information" icon
will be displayed next to the student's name. Hover over the icon to see more details on
other recommendations.

Recommendations can only be submitted during the submission window defined for
that building school level, but can be updated and resubmitted at any time between the
start and end dates of that submission window. To enter recommendations, use the
drop-downs to select the appropriate course recommendation(s) for each student. If
you'd like to add more than one recommendation for a student, click the Add button to
create a new row and select the appropriate recommendation using the dropdown(s)
provided.

To enter the same recommendation for multiple students, click the Mass Enter Course
Recommendations button.
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In the pop-up that appears, select the appropriate course(s) and choose whether to
apply that recommendation to all students or only to those who do not yet have any
recommendations.

To remove all of the recommendations you have entered for these students in a single
operation, click the Clear All Course Recommendations button. This will set all of the
recommendations to "NONE" for all students on this screen.

Once recommendations have been entered, click the Save button to submit. A
confirmation message will appear at the top of the screen indicating that
recommendations have been submitted successfully.
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Note: Depending on permissions, users may be able to submit course recommendations
for other departments and building school levels. See help for Scheduling > Course
Catalog > Course Details for more information.

Grade Book Overview

SchoolTool includes a grade book feature which allows teachers to log and track daily
assignments, tests, quizzes, etc, for each student, for each subject or course that they
teach. Grade books are specific to each course and must be set up for each course
individually.

Grade books are also available for ungraded courses, such as study halls, lunches, and
linked courses. When a teacher navigates into an ungraded course, they will have the
option to create a grade book for the purpose of tracking class assignments, progress,
participation, and more. The only options within the Grades tab that will be available for
these courses are the grade book editor, reports, and setup; all submit options and
grade override options will be unavailable for ungraded courses.

Note: Since many of the grading tasks require a grade book to already be set up, the
instructions generally assume that a grade book has already been created and set up for
the selected class. If the grade book is not set up for a particular class, you should refer
to the Initial Grade Book Setup section for instructions.

1. To access the grade book, Select a class from the list in the Home > My
Home > Classes tab.

Note: You may also click the Grade Book icon on the Classes tab to navigate
directly to a course’s grade book.

2. The screen will refresh to display additional tabs specific to that course. The
Attendance tab is the default for most courses.
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3. To access that course’s active grade book, click on the Grades tab.
4. The Grade Book Editor view will appear. If the grade book has been set up, the

grade book editor will display.

5. If the grade book has not been set up, the Grade Book Setup screen will appear.

6. Users can “Jump” to any other active grade book using the “Jump to” drop-
down, which is available on all Grade Book Setup and Grade Book Editor
screens. This menu only shows grade books available for the school year you
are currently working with.

Each class can have multiple grade books, but only one can be active at a time.
Grade books are year specific. To view past years, select “All Classes” button
from Classes tab. You can’t jump to another year without going to the Classes
tab.

Note: The “Jump to” drop-down menu is available on all grade book screens to
allow users to quickly navigate to another course’s grade book. Changes are
not saved when jumping between grade books.

Grade Book Setup

Because grade books are specific to each class, teachers will use their My Home course
list to select a class, and then build a grade book unique to that class. The grade book
will need to be set up for each class before any of the grading tasks can be performed.
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There are six (6) parts to creating a new grade book. The suggested work flow is to
follow this process for each grade book, repeating it as often as necessary until all
grade books have been completed.

l Part 1: users create the grade book name. This is typically “subject + year + grade
(G#) + period (P#).”

l Part 2: users select the Averaging Method for this grade book (points or per-
centage).

l Part 3: users add and configure categories (i.e. exams, homework, take-home pro-
jects, extra credit, etc), and if appropriate, weights. At least one category is
required.

l Part 4: users add attributes (teachers’ notes for receiving credit or no credit, or
attributes with modifiers that adjust assignment grades) to the grade book. Attrib-
utes are optional.

l Part 5: users add scales (different forms of grading scales) to the grade book.
Scales are optional and used more in elementary grades.

l Part 6: users add assignments (individual tests, homework assignments, projects,
etc) to the grade book and link them to appropriate categories and marking peri-
ods.

Note: Certain grade book options, such as subjects, attributes, skill sets, or other
grading features, may or may not be available depending on your district’s
settings.

Initial Grade Book Setup

When a user navigates to a course’s Grades tab (or selects the Grade Book icon from
the Classes tab), they will be directed to that course’s grade book. If no grade books
have been set up for that course, the user will be directed to the Grade Book Setup view
instead, where they may set up a new grade book.

To create a new grade book, click the Add button.

Create a New Grade Book
A new grade book may be created from scratch or imported from a previous year.
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1. To create a grade book from scratch, enter the name for the new grade book
and click the Add button to proceed to the Grade Book Setup for Existing
Grade Books.

Note: Each grade book should have a unique name. A suggested naming
strategy is: subject + year + grade (G#) + period (P#)). For example, “Spanish-
07/08-G7-P3” or “EngComp-07/08-G10-P4-S1.”

2. To use an existing grade book as a template, select the appropriate year from
the first drop-down menu. The second drop-down menu will show a list of all
courses with grade books for the selected year. When a course section is selec-
ted from this list, the import feature will import data from all grade books that
exist for that section.

A. Once a course has been selected, the import options will be available.
Use the radio buttons to select whether to import only that grade
book’s categories, or to import the individual assignments as well.

i. If “Categories Only” is selected, categories, attributes, and
scales will be imported from all grade books in the selected
course section. If the weights of all imported categories do
not add up to 100%, the new grade book will automatically be
set to use unweighted categories.

ii. If “Categories and Assignments” is selected, all assignments
in any grade book that exists for the selected section will be
imported in addition to any categories, attributes, and scales.
All assignment dates and marking periods will be converted
to correspond to the current course’s marking periods.

3. Enter a name for the new grade book and click the Add button to begin the
import.

Note: If importing using the “Categories and Assignments” option, a warning
message will appear to remind the user that it may take some time to import a
large number of assignments. Click OK and do not close the window or
navigate away from this screen until import is complete.
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4. Once the import has completed, the user will be directed to the Grade Book
Setup screen. To proceed, follow the steps for Grade Book Setup for Existing
Grade Books.

Grade Book Setup for Existing Grade Books

Once a grade book has been created, the Grade Book Setup screen will show the
settings for the selected course’s active grade book. The top section of the screen
shows the Averaging Method for that grade book and the default grade book for that
course:

Averaging Method:

The Averaging Method drop-down allows users to set the method used to calculate
averages for each grade book. The two options are Points and Percent. If the Points
value is selected, averages will be based on the total number of points achieved out of
the total number possible. If the Percent value is selected, averages will be based on the
averages divided by the number of assignments.

Points averaging example with 3 assignments:

l Assignment #1 50/100 = 50% for assignment
l Assignment #2 20/40 = 50% for assignment
l Assignment #3 100/100 = 100% for assignment
l Point average = (50+20+100) / (100+40+100) = 170/240 = 70.83%

Percent averaging example with 3 assignments:

l Assignment #1 50/100 = 50% for assignment
l Assignment #2 20/40 = 50% for assignment
l Assignment #3 100/100 = 100% for assignment
l Percentage average = (50+50+100) / 3 = 66.66%
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Note: Whichever method is selected will affect the current total average taken from all
assignments in this grade book. It is not possible to select different averaging methods
per assignment.

Default Grade Book:

This drop-down sets the active grade book for this course. This menu includes all
existing grade books that have been created for this course.

Use the Add button to create a new grade book. To change the name of the default
grade book, click the Edit button.

Edit a Grade Book Name
The name of the default grade book may be changed at any time by clicking the Edit
button on the Grade Book Setup screen.

To change the grade book name, simply enter the new grade book name in the text field
and click Save to apply the changes and return to the Grade Book Setup screen.

Category Tab

Grade Book Categories are topics or headings (like Homework, Tests, Class Work,
Projects, etc.) which individual graded assignments fall under. Categories are how
SchoolTool organizes the various assignments to be graded. You must have at least
one category in order to add assignments, although there is no limit to how many you
add.

The Category tab is selected by default in the Grade Book Setup view.

Note: When a grade book is created using the Import Grade Book method, categories
are also imported. You may modify the categories for the current grade book as needed.
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The Weighted Categories radio buttons allow users to determine how categories are
weighted when calculating averages. This is set to Fixed Weights by default. You can
turn weighting on or off at any time, and your grade book averages will automatically
recalculate according to the selected option. Categories with 0% weight will still be
available in the grade book editor and when adding assignments, but assignments tied
to those categories will not be included in grade book averages in marking periods
where the category has no weight.

Three weighting options exist for categories: Unweighted, Fixed Weights, or Variable
Weights.

l Unweighted: All categories will be active in all marking periods, and will all be given
equal weight in each marking period.

l Fixed Weights: Categories may each be assigned a specific weight, and all cat-
egories will be active in each marking period. Each category will be given the same
weight in each marking period.
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l Variable Weights: Categories may be assigned specific weights for each marking
period. Category weights must total 100% for each marking period, and any weight
may be set to 0% if that category is not used in a specific marking period.

Note: A message stating that “WARNING: Category weights do not add up to 100%” will
appear if you have selected Yes for weighted categories, but either no categories exist,
or existing category weights do not total 100% for each marking period. As soon as
categories total 100%, or weighting is set to No, the message will disappear.

To add a new category, click Add . See the Add or Edit a Category section for detailed
instructions.

To edit an existing category, click Edit . See the Add or Edit a Category section for
detailed instructions.

To delete an existing category, click Delete . If you attempt to delete a category that is
currently in use, you will see a warning prompting you to confirm the action. If you
proceed with the Delete operation, all assignments tied to this category will also be
deleted.

Add or Edit a Category
1. Click the Add Category button on the right side of the Category tab. To edit

an existing category, click the Edit button in the appropriate row.
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2. Enter the Category name (i.e. “Homework,” “Exams,” etc.) and the numeric
Weight (if applicable). If you have selected weighting, you must designate
weight values (if using the Variable Weights option, a value must be entered for
each marking period).

Note: When adding weighted categories, the total weight of all categories must
add up to 100. If you enter a weight that will result in a total over 100, an error
will appear.

Note: Weight values are numeric only – using decimals, percent (%) signs or
words in this field will result in errors.

3. Configure categories to automatically drop the lowest “X” number of assign-
ments for a marking period, if applicable. When a value is set for a category,
the grade book will automatically drop that number of grades per marking
period, per category, per subject (if applicable). All assignment scores remain
in the teacher’s grade book, but any dropped grades will be excluded when cal-
culating a student’s overall average.

Note: There is no indicator in the Grade Book Editor that an assignment is
going to be dropped as this is calculated on the fly: whenever an average is
calculated or when grades are added/deleted/modified, the lowest “X” number
of assignment grades are automatically removed from average calculations
appropriately.

Rules for dropping assignment grades:
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l When calculating student averages, any attributes, including those with
modifiers, are applied before determining the lowest assignment grade(s)
to be dropped.

l Assignments with a No Credit attribute applied are treated as a 0 and can
be dropped

l Assignments with an Exempt attribute are treated as nonexistent grades
and cannot be dropped

l 0-point assignments are treated as nonexistent grades and cannot be
dropped

l Assignments not marked as “Include in Average” cannot be dropped
l This feature will not allow a user to delete all assignments for a student.

If the grade book has fewer than the specified number of assignments to
be dropped for a given marking period, category, and subject, no grades
will be dropped for that student. For example, a category configured to
drop the lowest 2 assignments requires 3 or more assignments for that
marking period and category (and subject, if applicable).

4. Click the Save button on the far left of the Category row to save your cat-
egory. The screen will refresh to show you the category (and weight, if applic-
able) you have added for this grade book.

Note: You can use the Delete button to delete your category, or the Edit
button to make changes to your category name and/or its weight (buttons are
to the left of the category).

5. Repeat these steps for each category in this grade book until all categories and
appropriate weights have been defined.

Note: You can continue to add categories at any time, and can also edit
categories (and their weights) and turn weighting on and off. However, if you
use weighting, all new categories must have a weight, and total weight cannot
exceed 100.

Attribute Tab

Grade book Attributes allow a teacher to designate if a student gets credit for an
assignment or not. For example, you might create an attribute called “exempt” that can
be selected when a child is absent with a legitimate excuse, and therefore failure to turn
in an assignment would not count against them. Or you could create an attribute called
“not handed in” which would result in no credit. Attributes are not required.

Attributes apply to every assignment in this grade book. It is not possible to add
attributes which are only valid for one of a group of assignments.
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To add a new attribute, click Add . See the Add an Attribute section for detailed
instructions.

To edit an existing attribute, click Edit . See the Edit an Attribute section for detailed
instructions.

To delete an existing attribute, click Delete . You may only delete attributes that are not
currently in use.

Add an Attribute
1. Click once on the Add button on the right side of the Attribute tab. The tab

will refresh with entry fields:

l Name (free-text, required, up to 50 characters): name of the attribute (i.e.
“Not Handed In,” Absent when assigned,” “Exempt,” etc.).

l Short name (free-text, required): This is what will display in the Assign-
ment area (i.e. “NH” for Not Handed In or “EX” for Exempt, etc.).

l Type (drop-down): Choose one of the five (5) options:
l No Credit – means that the student will not get credit for this assign-

ment, regardless of whether a grade is entered or not. This will
count against the student and negatively impact the student’s aver-
age. For example, if the assignment is Not Handed In, the student
might get No Credit.

l Exempt – means that the student is exempted from this assign-
ment, regardless of whether a grade is entered or not. The absence
of a grade will NOT count against the student and any grade
entered will NOT impact the student’s average. For example, the stu-
dent may have already completed extra credit and is exempt from a
quiz or homework.

l Flag – has no effect on the average. This just serves as a reminder
to the teacher that this particular attribute was in effect – for
example, maybe the assignment was handed in late. The student
still gets credit, but the teacher wants to remember that for later. Or
maybe the student was absent when the assignment was given.
The student can still make it up, so this will flag the teacher for
later.

l Point Adjustment – applies a point modifier to adjust assignment
scores.

l Percent Adjustment – applies a percentage modifier to adjust
assignment scores.
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l Adjustment (text box, required if Type is Point Adjustment or Percent
Adjustment): indicates the adjustment value (including + or -) for the
attribute.

2. When you have finished defining the attribute, click the Save button on the
far right of the tab to save your attribute (see below). The screen will refresh to
show you the attribute details you have added for this grade book in read-only
mode.

3. Repeat these steps for each attribute you wish to add.

The image below shows how a grade book with multiple attributes might look.

Attributes are applied to assignments in the following order:

1. No Credit (treated as a value of zero)
2. Exempt (not included in grade)
3. Points (numeric modifier)
4. Percentage (percent modifier)

Attribute modifiers will be applied to assignment grades according to the following
formula:

Raw Score + (Sum of all Points Attributes) + (Sum of all Percentage Attributes)

Edit an Attribute
To edit an existing attribute, click the Edit button in the appropriate row.
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The screen will refresh with editable fields. Modify the attribute’s name, short name,
and/or type as needed, and click Save to apply the changes.

Scales Tab

Grade book Scales allow a teacher to designate grading scales for an assignment or
not. For example, you might create a scale called “stars” that would vary in grade
importance such as 5 stars, 4 stars, 3 stars, etc. Scales are used more in the elementary
grades. Scales apply to every assignment in this grade book. It is not possible to add
scales which are only valid for one of a group of assignments. Scales are not required.

To add a new scale, click Add . See the Add or Edit Scales section for detailed
instructions

To edit an existing scale, Select that scale and modify as needed. See the Add or Edit
Scales section for more information.

To delete an existing scale, click Delete . You may only delete scales that are not
currently in use.

Add or Edit Scales
1. Click once on the Add button on the right side of the Scale tab to create a

new scaled (or click Edit to modify an existing scale).
2. The tab will refresh with entry fields:

3. Enter the required, free-text Name of the scale (i.e. “Stars,” “Checks,” , etc.). The
Scales name can be up to 50 characters in length.

4. Enter first new symbol and value and click the green plus sign.
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5. Continue with this process until all of the scale values have been entered.

6. When you have finished defining the scale, click the Save button on the far
right of the tab to save your work.

7. The screen will refresh to show you the scale details you have added for this
grade book in read-only mode.

Deleting a Grade Book

You may delete a grade book (name) after you have deleted all attachments:
assignments, attributes, categories, and scales.

1. To delete the grade book name, you must be in the setup area. Select Grade
book setup from the View drop-down list. The screen will refresh with the setup
screen displaying the name of the current active grade book in the Default
grade book drop-down field.

2. If you do not see the red Delete grade book button to the right of the Default
grade book drop-down list, then this grade book has features attached. If you
do see the Delete grade book button, you may continue without deleting
grade book features.

3. Delete all categories. If assignments exist for this category, a warning message
will appear. Take the appropriate action to remove this category and all
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attached assignments.

4. Delete all attributes. You will be prompted to confirm this action. Click OK to
the prompt and the attribute will be removed. Do the same for Scales if any
were used.

5. When all categories, attributes, scales, and assignments have been deleted, the
red Delete grade book should appear to the right of the grade book name.

6. Click once on the red Delete grade book button at the right of the grade book
drop-down field.

7. When prompted, click OK to continue. The screen will refresh and the Default
grade book list will no longer contain the name of the deleted grade book.

8. You may repeat these steps to delete other grade books or return to the Grade
book setup View to work in another grade book.

Note: Once you have deleted your grade book, there is no way to recover it. You
will have to add it again manually.

Grade Book Editor

The Grade Book Editor is where all assignment information is set up and where all
grades are stored. This is the portion of the Grades tab that teachers will spend the
most time using. From within the Grade Book Editor, teachers may add new
assignments, edit existing assignments, enter grades for assignments, and print reports
per student or per class.
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Depending on permissions and district settings, teachers may be able to import
assignments from Google Classroom using the Google icon.

The number of assignments visible on your screen will vary, based on screen settings.
Simply click the bottom right corner and drag to resize. Additionally, you may click the
Menu button in the grade book toolbar and select “Full screen” to show only the editor
on the screen.

Individual columns can be resized at any time. Click the line in the upper right corner of
the column header and drag it to resize.

Users may click in any cell to edit grades. A green triangle in the top corner of a cell
indicates that the value has changed. The triangle indicator will be removed once
changes have been saved to the grade book.

To navigate between cells in the editor, users may click with a mouse or use a keyboard.
When using the keyboard, either use the arrow keys (left, right, up, down) or use Tab to
move right, Shift+Tab to move left, Enter to move down, and Shift+Enter to move up.
Moving into a cell using this method allows the user to edit the grade for that cell.

To view a student’s category averages for the selected marking period, click on a
student’s average in the far left column. A small window will appear, displaying the
student’s category averages for the marking period that is being viewed (if the user is
viewing all marking periods, the window will use the current marking period’s
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information instead). If the grade book is set up to use weighted categories, the window
will also display each category’s weight for that marking period.

The Grade Book Editor Toolbar

The Grade Book Editor includes a toolbar at the bottom of the screen where users may
click to access menus with additional options.

Menu
Click on the Menu button to view additional view options. These checkboxes control the
information that displays on the screen and are all checked by default.

Current options include:

l Show Inactive Students
l Show Selected Student (to show only a single student, click in the row for that stu-

dent and select this option)
l Show Skill Set Averages (if using skill set grading, this option allows teachers to

specify which skill set averages to display)
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l Show Attributes/Notes Editor (this option is only available if the grade book has
attributes configured and;/or the district has enabled grade book notes)

l Show Student ID
l Use Larger Font
l Column Width (allows users to select a column width between 1 (narrowest) and 5

(widest); all columns will be sized equally based on whichever setting is selected)
l Full screen (shows the grade book editor in full-screen mode)

Reports
Click the Reports button to view available grade book reports, and click on any report to
run it. The report will open in a new window. Available reports include the following:

l Grade Book (prints the Grade Book Report for the entire class)
l Plan Book by Student Name (the report will display student names, and students

will be sorted alphabetically in ascending order by Student Name (Last Name, First
Name)

l Plan Book by Student ID (the report will display Student ID numbers instead of
names, and students will be sorted in ascending order by Student ID)

l Plan Book by Student ID Random (the report will display student ID numbers
instead of names. The students will be displayed in random order, regardless of
name or ID number)

See the section on Grade Book Editor Reportsfor more information on each of these
reports.

Note: Running reports from within the Grade Book Editor produces a quick report that
does not use a pre-screen. To run with additional options, navigate to the Grade Book
Reports view, select the appropriate report and configure options as appropriate.
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Filter
The assignments in the Grade Book Editor can be filtered by Category, Subject, Marking
Period, and/or Skill Set, depending on the options defined by your district. To set a filter,
click the Filters button, click on the desired filter type, and select the appropriate filter
criteria..

Note: To use multiple filters at the same time, you must select one type of filter first,
then click the Filters button and select the other filter.

Note: The “Avg” column and category average mouseover will always display
information based on the assignments currently being displayed in the editor. This
means the average shown will change based on selected assignment filters.

Sort
Grade Book assignments can be sorted by assignment date, by assignment name, or by
category. To apply a sort, click the Sort button and select the appropriate sort option.

Note: Assignments are sorted horizontally in the grade book editor.
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Save/Add/Done Buttons
Changes to the Grade Book can be saved by clicking the Save button at the bottom.
This will also cause all student averages to be refreshed.

The Add button allows teachers to add assignments individually, while the Batch Edit
Assignments button will allow users to add, edit, and/or delete multiple assignments
from a single screen.

To exit the Grade Book Editor and return to the user’s My Home > Classes tab, click the
Done button. If there are unsaved changes, a prompt will appear asking for
confirmation. Click OK to exit without saving or click cancel to return to the grade book
editor.

When a grade book is saved, the following settings are maintained for the user:

l Menu > Show Inactive Students
l Menu > Show Student ID
l Menu > Show Attributes
l Menu > Show Skill Set Averages
l Menu > Use Larger Font
l Menu > Column Width
l Menu > Full Screen
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l Height and width of the Grade Book Editor window
l Filter > Subject, Skill Set, or Category filter selections

After saving changes, these settings will be maintained for each user individually and
will be reflected across all of that user’s grade books. Because these settings are saved
for each user and not for each grade book, users accessing a grade book either by
assuming a faculty identity or as a substitute will continue to see their own settings
reflected, rather than those of the user who last saved the grade book.

Assignments in the Editor View

Hover over an assignment title to see details about that assignment. This will display
the assignment title, the total number of points it is worth, the category short name
(“HW” for example), and the assignment date. If the assignment also has a description,
that will show on another line.

Each assignment has its own menu with assignment specific buttons, available by
clicking on the assignment title.

The following buttons are available for each assignment:

l Edit button – allows you to edit the assignment details and, if available, apply
those changes to multiple grade books.

l Delete button – allows you to delete the assignment from the grade book. This
will delete all related student grades as well.

l Mass Entry button – applies the grade entered in that field to that assignment
for all students.
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l Print buttons – allow you to print the Assignment Report for that assignment,
showing either Student ID or Name.

l Sort button – sorts the students vertically based on their grades for that par-
ticular assignment.

Entering Daily Assignment Grades
1. To enter grades one by one, simply click in a cell and type in a grade (or select

it from the drop-down if not using numeric grades for that assignment). Use
the mouse or the keyboarding shortcuts to navigate to other cells and enter
additional grades.

2. To enter attributes or notes, right click in the desired cell and use the check-
boxes or note entry area, then click the Update button to apply the changes.

3. To enter the same grade, attribute, and/or note for multiple students at once,
click the assignment title to access the Mass Entry button from the assign-
ment drop-down menu. A pop-up will appear with a number of mass entry
options for that assignment.

A. Specify whether to apply the changes to all students' assignments or
only the ungraded assignments in that column. Ungraded assign-
ments are those that have no score, attributes, or notes (if any of
those exist, the assignment will be considered graded for that stu-
dent).

B. Enter the desired grade, attribute(s), and/or note and click the Update
button to apply the changes. The appropriate assignments will be

updated based on the options selected.
4. To recalculate student averages and save grades you’ve entered, click the Save

button from the bottom toolbar. All changes will be applied to the grade
book and student averages will be updated in the Editor.

Note: The “Avg” column will always display the student’s average for the
assignments currently being displayed in the editor. This means the average
shown will change based on selected assignment filters.

Using Attributes and Assignment Notes
Teachers can add attributes and/or notes to any student assignment in the grade book
editor. Attributes must be configured before they will be available in the grade book. The
ability to enter notes is based on district configuration.

To view selected attributes and/or notes, simply mouse over the desired cell.
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Attributes can be shown or hidden using the “Show Attributes/Notes Editor” option in
the grade book editor menu.

Note: If attributes are not configured for the grade book and notes are not enabled, the
menu option will not show.

When the “Show Attributes/Notes Editor” option is checked, brackets will appear in each
cell (“[ ]”). Attribute short codes will be displayed within those brackets where they exist.
When attributes are configured with point or percent adjustments, applying an attribute
will cause the student’s grade book average to be recalculated to account for the
adjustment once the grade book is saved.

To select attributes or to enter a note, right click in the cell (or click between the [ ]
brackets). A pop-up window will appear, where the user may select any appropriate
attributes and/or add student assignment notes as needed. Click the Update button to
save changes.

When a note exists for a given assignment, a blue triangle indicator will appear in the
bottom right corner of the cell.
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Add Assignments
Assignments are the actual tasks students will be graded on. Each assignment must be
named, have a designated point value, have a date and a marking period designation,
and be linked to a category. For information on how to add multiple assignments at one
time, refer to the Batch Add/Edit Assignments section.

1. To add a single assignment, click the Add Assignment button found in the
grade book toolbar at the bottom of the screen.

2. The screen will refresh with entry fields where you can define this assignment.

3. Fill in the fields as appropriate:
l Name (free-text, required, up to 50 characters): Enter an assignment

Name (such as “take home project” or “chapter 3 quiz” etc.). Only the first
15 characters will display on the Grade book editor screen, but the whole
name will appear when you mouse over it. The name should be specific.
More than one assignment may be added with the same name, provided
they are assigned to different dates. Each assignment must have a
unique name and date combination.

l Description (free-text, optional, up to 255 characters): Enter a description
for the assignment, if desired. This will be displayed in the grade book
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editor when mousing over assignment names, and on the My Home >
Assignments tab on student records.

l Points (required): Number of points this assignment is worth. If a single
entry field appears, it assumes you are only entering numeric values. If
you do not see the Points options you require for setting up your assign-
ments, contact your district’s SchoolTool liaison. Depending on your dis-
trict’s preferences, you may see two (2) radio button options for Points:

l Numeric (required, numeric): If selected, a numeric field appears.
The point value must be 1 or greater, unless your district allows
zero-point assignments.

l Other (drop-down): Select from a district-defined group of options,
such as rubric scales, pass/fail, alpha scales, etc.

l Date (required, date field, defaults to current date): You may use this field
for the date assigned or the date due. Use the pop-up calendar to select
the date, or enter the date manually using the mm/dd/yyyy format. This
date is only used to help you organize and track your assignments.

Note: If you add all of your assignments on the same day and do not
change the date field, they will appear in alphabetical order by
assignment name.

l Marking Period (required, drop-down): Select a marking period from the
drop-down. This designation is used to tie an assignment to the selected
marking period. All averages will be calculated based on marking period
designations (rather than dates). This is also used to determine which
assignment scores are included when submitting marking period and/or
progress report grades, to determine the average shown on the My Home
> Grades tab, and the assignments that are shown on a student’s My
Home > Assignments tab.

l Category (required, drop-down): You should see a list of all the categories
you added to this grade book. This value will default to the first value in
the list.

4. If you have Forms available, you may use the drop-down to select a form and
click Add to associate it with this assignment.
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A. After associating a form, you will see a message that the form has not
yet been distributed to students.

B. To distribute the form to the students in that section, click the Dis-
tribute button in the upper right corner of the screen.

C. Apply these changes or add this assignment to other grade books if
desired by clicking once in the check box(es) in the Duplicate tab (see
the Add Assignments to Multiple Grade Books or Edit Assignments in
Multiple Grade Books sections for more information).

D. Click the Update assignment and return to the grade book button in
the upper right corner of the Grades tab. The screen will refresh dis-
playing the modified assignment.

E. When you have finished editing assignments, click once on the Save
grade book changes button to save your work.
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5. Decide whether to include this assignment in student averages. The “Include in
average” check box is checked by default; simply uncheck it by clicking once,
and this assignment will not be included in averages. An example might be an
assignment that measures participation which has no actual score; you might
give each student who attended a 1 out of 1, but choose not have this impact
the overall class average.

6. Decide whether to allow parent access through the parent portal to this assign-
ment. The Allow parent access is not checked by default; simply check the box
by clicking once and this assignment will be viewable to a parent when access-
ing SchoolTool.

Note: Keep in mind that if your district uses Push Notifications for the
SchoolTool Mobile App, users may get notifications when assignment grades
are saved for assignments designated as Allow Public Access.

1. Choose whether or not to include assignment notes for individual stu-
dents in the parent portal. This option is unchecked by default and
does not appear if student assignment notes are not configured for
use. When this option is enabled for an assignment, students’ notes
for that assignment will appear on the My Home > Assignments tab.

Note: The Allow Public Access check box and the Include Notes
option only appear if your district allows parent access to SchoolTool.

7. When you have finished building this assignment, save your work using either
method A or B below:

A. If you wish to add another assignment after this one, click once on the
Save Assignment and add another button. The first assignment
will be saved, and the tab will refresh allowing you to add another
assignment.

B. If you wish to add only this assignment, and return to the grade book,
click once on the Save assignment and return to grade book but-
ton. Use this button when you have finished adding assignments. In
this example we will save and return to the grade book.

8. Repeat these steps for each assignment in this grade book.
9. When you have finished adding assignments, return to the Grade book editor

View area (finish adding your assignment and click the Save and return to
grade book button, OR click the Return to grade book without saving button
in the upper right corner of the assignment area).

10. Save your entire grade book. Click once on any of the Save grade book
changes buttons found in the upper portion of the Grade book editor View in
the Grades tab to save the assignment(s) to the grade book.
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Add Assignments to Multiple Grade Books
Often it will be necessary to add assignments during the marking period after your grade
books have been set up. SchoolTool allows users to add a new assignment at any time,
and to add a single assignment to multiple grade books (if multiple grade books exist)
at the same time.

Note: You must have at least one grade book to use this procedure.

1. To create an assignment, navigate to the Grades tab and click once on the Add
assignments button in the grade book toolbar. The tab will refresh with entry
fields for the new assignment, as well as the Duplicate tab, along the bottom of
the assignment area.

Note: If you do not see the Duplicate tab, it means you do not have any other
grade books to copy this assignment to.

2. Enter the assignment details: Name, Description, Points, Date, Marking Period,
Category, whether this will be included in averages or not and whether to allow
parent access. Note that if you are using Forms, these cannot currently be
duplicated in other grade books.

3. Use the Duplicate tab to add this assignment to one (or more) of your existing
grade books for other sections/courses. Click once in the check box to the left
of the name of each grade book that should also have this assignment added
to it.
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Note: Use the radio button to toggle the list of available grade books between
only those defined as a “default” grade books or all grade books for all courses
in the current year.

4. Use the Categories drop-down list at the right of each grade book row to put
the assignment in the correct category. (Remember, grade books can each
have their own categories, so you will need to choose the appropriate category
per grade book.)

Note: You can also add an attachment to the assignment by clicking on the
Attachment tab and using the browse button to locate and upload the
attachment.

5. Click the Save button (upper right corner of the Grades tab) to save the new
assignment to this grade book and to each grade book checked on the Duplic-
ate tab.

Note: To verify that the new assignment has been added to the other selected
grade books, you can review each grade book.

Attachments Tab
Any number of files, and any file type, may be added to an assignment.
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1. To add attachments to an assignment, click on the Attachments tab.

2. Click the Browse button and locate the file to attach.

3. Click Upload to attach the file to the assignment. You must upload the file for
the attachment to be added.

4. The uploaded file will appear in the list of attached files when the upload is
completed.

5. Once an attachment has been added to an assignment, you may click the
Select button to open the file or the Delete button to remove it.

6. Remember to Save the assignment after adding or removing an attachment.

Subjects Tab
The Subjects tab helps teachers organize assignments and grade students according to
performance in one or more subject areas at a time. Any number of subjects may be
selected. To associate an assignment with one or more subjects, simply check or
uncheck the appropriate subject boxes and Save the assignment.
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Descriptors Tab
The Descriptors tab allows teachers to tie specific descriptors to individual
assignments. This allows SchoolTool to calculate averages per descriptor when
teachers use the “Grade Book Copy Grades” feature when submitting Marking Period
grades. This is typically used only by elementary teachers, and only applies for
descriptor-based graded courses.

Skills Tab
The Skills tab allows teachers to tie assignments to specific skills within pre-defined
skill sets. This option is only available for districts that have set up skill sets and
associated those skill sets with courses. Assignments can be tied to any number of
individual skills. The Grade Book Editor will allow filtering based on skills or skill sets,
and other grading screens may include skill and skill set averages, depending on district
grading settings.

Edit Assignments
1. Navigate to the Grades tab for the appropriate class to view the grade book

editor.
2. Click once on the assignment title you wish to modify and click the Edit Assign-

ment button.
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Note: For information on editing multiple assignments at once, refer to the
Batch Add/Edit Assignments section.

3. The assignment details will appear in editable fields.

4. Make changes to the Name, Points, Date, Marking Period, and/or Category,
and/or any of the check box options for this assignment if desired.

5. If you have Forms available, you may use the drop-down to select a form and
click Add to associate it with this assignment.
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A. After associating a form, you will see a message that the form has not
yet been distributed to students.

B. To distribute the form to the students in that section, click the Dis-
tribute button in the upper right corner of the screen.

6. Apply these changes or add this assignment to other grade books if desired by
clicking once in the check box(es) in the Duplicate tab (see the Add Assign-
ments to Multiple Grade Books or Edit Assignments in Multiple Grade Books sec-
tions for more information).

7. Click the Update assignment and return to the grade book button in the
upper right corner of the Grades tab. The screen will refresh displaying the mod-
ified assignment.

8. When you have finished editing assignments, click once on the Save grade
book changes button to save your work.

Edit Assignments in Multiple Grade Books
1. To modify an assignment, click on the assignment title and click on the Edit

Assignment button. The screen will refresh with detail fields for that assign-
ment, as well as the Duplicate tab, along the bottom of the assignment area.
The Duplicate tab shows all available grade books.

Note: If you do not see the Duplicate tab, it means you do not have any grade
books to copy these changes to.
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2. Enter the assignment details as needed: Name, Points, Date, Marking Period,
Category, whether or not this will be included in averages, and whether to allow
parent access. Pink fields are required.

1. Use the Duplicate tab to apply these changes to one (or more) of your existing
grade books for other sections/courses. Click once in the check box to the left
of the name of each grade book that should also have this assignment
changed. Note that if you are using Forms, these cannot currently be duplic-
ated in other grade books.

A. Use the Categories drop-down list at the right of each grade book row
to put the assignment in the correct category. (Remember, grade
books can each have their own categories, so you will need to choose
the appropriate category for each grade book.)
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3. Select the Update assignment and return to grade book button (upper right
corner of the screen) to save the changes to this assignment.

4. If you have selected additional grade books using the Duplicate tab,
SchoolTool will attempt to copy those changes to the selected grade books
one at a time. If a matching assignment exists in any selected grade book, the
assignment changes will be applied to those grade books.

5. If no errors are encountered and the update completes successfully, the
changes will be applied and the user will be returned to the grade book editor.

6. If an error occurs, the user will see a warning message on the screen, indic-
ating which grade book was not updated. Other selected grade books will be
updated appropriately unless indicated otherwise. You will receive a separate
message for each grade book affected.

7. An error may be due to any of the following possible situations:
l Grading Scale not found: This will occur if you change the grading scale

for an assignment and attempt to copy that change to a grade book
where that grading scale does not exist.

l Another assignment exists with the same name: If an assignment exists
in another grade book with the same name but different details, you will
be unable to copy the assignment changes. This applies to situations
where identical assignments were added to the grade books but then
were manually edited individually, because those edits will change the
details of that individual assignment and it will no longer be recognized
as the “same” assignment as in other grade books.

l No assignments with that name: If the assignment to be modified does
not exist in another grade book, it cannot be modified. To correct this,
add a matching assignment to the desired grade book.

8. To verify that the new assignment has been modified in the other selected
grade books, you can review each grade book.

Batch Add/Edit Assignments
To make batch assignment changes, click the Batch Edit Assignments button,
located at the bottom of the screen in the Grade Book Editor Toolbar.
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The screen will refresh to display a list, presented in edit mode, that contains all
assignments that currently exist in that grade book. The list can be sorted by any
column, and may be filtered by marking period using the Marking Period Filter drop-
down in the upper left corner. By default, the list includes assignments from all marking
periods.

Note: Once a user saves changes from this screen, all modifications are applied to the
grade book editor as a single operation, including changing existing assignments,
deleting existing assignments, and adding new assignments. If multiple grade books are
selected, these changes will be applied across all selected grade books at once.

To modify existing assignments, simply locate the assignment(s) to be changed, edit all
appropriate fields, and click the Save button to apply changes.

Note: All required fields must contain valid information. An error message will appear
for any invalid field entries to indicate the specific assignment(s) that contain invalid
data.

A pop-up will appear with a list of the default (active) grade books for each course
section.
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To apply the new assignments and/or modifications to other grade books, simply select
the desired grade books and click Save.

Note: When adding assignments to multiple grade books, keep in mind that the
destination grade book must have matching categories in order to copy the assignment.
In addition, when modifying or deleting existing assignments, the assignment names
and dates must be the same in both grade books in order for changes to be applied.

To delete one or more assignments, check the box to the left of each assignment to be
removed (or use the check box in the header to select all assignments) and click the
Save button to permanently delete all selected assignments.

In the pop-up that appears, select the appropriate grade books from which you wish to
delete this assignment, and click Save.

A warning message will appear asking the user to confirm this operation; click OK to
proceed or click Cancel to return to the Batch Edit Assignments screen without deleting.

To add one or more new assignments to the grade book in batch mode, select the
appropriate number from the drop-down in the upper right button and click the Add
button. The new assignments will be added as blank rows at the top of the assignment
list. Enter all information as needed and click Save to add the assignments. Select any
grade books to add the assignments to and click Save to return to the grade book editor.
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Delete Assignments
1. Navigate to the Grades tab for the appropriate class to view the grade book

editor.
2. Click once on the assignment title and click the Delete Assignment button.

3. A prompt will display asking if you are sure you want to delete this assignment.

4. Click OK to complete the delete action. The assignment will be removed from
the editor view.

Warning: There is no way to recover an assignment and any grades associated
with it after you have confirmed the delete transaction.

5. Repeat the steps for any other assignments to be deleted.
6. When you have finished deleting assignments, click once on the Save grade

book changes button to save your work.

Transferring Assignment Grades for Students
who Switch Sections
When a student is switched between two sections of the same course, both with the
same teacher, the teacher will be presented with a new icon next to the student's name
that will allow transfer of assignment grades from the student's previous grade book.

To transfer these assignment grades:
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1. Navigate to the Grade Book Editor of a course section that a student was
recently switched into

2. Locate and click on the "Move grades…" button

Note: Once assignments have been copied over for a specific student, the
"Move grades…" button will no longer appear for that student. If there are no
grades to copy over for a specific student, the "Move grades…" button will not
appear.

3. Read the warning message, and click OK to continue. All assignment grades
will be copied from the student's previous grade book into the current one.

Note: Assignment grades will not be copied over if the assignment name, date,
or attributes are different in the two grade books. If there are existing grades in
the current grade book, they will not be overwritten by imported grades. These
existing grades will be skipped, and blank assignment grades will be imported.
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Importing Assignments from Google
Classroom

l To import assignments from Google Classroom, begin by clicking on the Google
icon in the upper left corner of the Grade Book Editor screen.

In the popup that opens, select the Google Classroom from which you want to
import assignments (if this section has already been linked, the linked Classroom
will be selected for you and the search will run automatically). The start and end
dates will default to the current marking period dates; change these values as
needed to bring in additional assignments within the current school year.

After you click Search, you'll see a list of assignments that are available in Google
Classroom (use the checkboxes to choose which assignments you want to
import). If assignments have been scored, that information will also be imported;
use the "Overwrite scores" option if you want to update existing assignment
scores in the grade book. Edit the Max Score and Date information as needed,
then click the Import button.

Note: The first time you import a given assignment, the "SchoolTool Assignment"
column will show the word "New" at the end of the assignment name (this will not
actually be included in the assignment name after it's imported). The import will
add these new assignments to the current marking period and the first
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assignment category in the list; feel free to change those now if you wish. Keep in
mind that you may need to scroll horizontally to see those fields.

Wait while SchoolTool processes the import. You'll see a popup that displays a
confirmation message once the import has completed successfully. If the import
encountered issues, the popup will show error message(s) for any failures.

Things to know:

l After the initial import of an assignment, the assignment name, max score,
date, marking period, and/or category will not automatically be updated in
SchoolTool on subsequent imports. If you change this information in Google
Classroom, you'll need to manually update the corresponding assignments in
SchoolTool as well.

l Deleting an assignment in Google Classroom does not automatically remove
it from SchoolTool. You'll need to manually remove it from the SchoolTool
grade book in that case.

l Assignment scores will only be imported if the assignment has been graded
and marked as "Returned."

l This feature will only import assignments that are "Assignment" or "Quiz
Assignment" item types. "Question" types are not supported at this time.

Grade Book Editor Reports

There are four (4) reports available to you while you are working in the grade book
editor:
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l Grade Book Report (per student)
l Grade Book Report (per class)
l Plan Book Report
l Assignment Report

Grade Book Report (per Class or per Student)
The Grade book report is a view of an individualized student’s performance in this
course. When printed from within the Grade Book Editor View, it includes an overall
class average, the number of days tardy, the student’s average per category, any
attributes, weighting and all assignment scores. When running this report per class, it
will generate a report that includes all students in the course. When running for an
individual student, the same information displays but is limited to the selected student.

Note: The Grade book report is also available under the Grade Book Reports View. By
printing this report under the Grade Book Reports View, you have additional options
available from a pre-screen to control the information displayed on the report.

To print the Grade Book Report for a specific student, click the Print icon in that
student’s row in the editor grid. The Grade Book Report for that student will
automatically generate in a new window.

To print the Grade Book Report for the whole class, click the Print menu button on the
grade book toolbar. Select “Grade Book” from the menu to print the Grade Book Report
for the entire class. The report will generate automatically in a new window.
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Assignment information is displayed on the Grade Book Report is based on the
following logic:

l If an Exempt attribute is checked for an assignment, the report will show “Exempt”
for that assignment (rather than showing a 0 / 0, as was previously displayed).

l If a No Credit attribute is checked for an assignment, the report will show 0 / 100
with a grade of 0 (this reflects current functionality; no change was made here).

l If a Flag attribute is checked for an assignment, the course will show the score /
100, with the appropriate grade indicated (this reflects current functionality; no
change was made here).

l If an assignment has no score recorded, the report will show nothing (rather than
showing a 0 / 0, as was previously displayed).

l If an assignment’s recorded score is 0, the report will show 0 / 100, with a grade of
0 (this reflects current functionality; no change was made here).

l Only those items with numeric grades will be used to calculate the student’s aver-
ages.

Plan Book Report
The Plan Book report is a grid-like report allowing you to see all students compared to
each other, their overall course averages, their averages per category and per
assignment.
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To print the Plan Book Report for the whole class, click the Print menu button on the
grade book toolbar. Select the appropriate “Planbook…” option to print the Plan Book
Report for the entire class. The following print options are available for this report:

l Planbook By Student Name (the report will display student names, and students
will be sorted alphabetically in ascending order by Student Name (Last Name, First
Name)

l Planbook by Student ID (the report will display Student ID numbers instead of
names, and students will be sorted in ascending order by Student ID)

l Planbook By Student ID Random (the report will display student ID numbers
instead of names. The students will be displayed in random order, regardless of
name or ID number)

The report will generate automatically in a new window.
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Assignment Reports
This report is a way for teachers to print and post scores for a simple assignment for all
students without names. It displays a list of Earned Points (the number of points a
student received) and Scores (the actual grade a student received) for each assignment.

To print an Assignment Report, click on the assignment title and click the appropriate
Print button from the Assignment menu (Print by Student ID displays student ID
numbers without names, while Print by Name includes both student ID and student
name).

The report will generate automatically in a new window.

Grade Book Reports
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In addition to the reports available while working in the Grade Book Editor, there are five
(5) reports available from the “Grade Book Reports” view.

l Assignment Report – Assignments with descriptors
l Grade Book Report – Students, assignments, categories, and grades
l Plan Book Report – Students, assignments, categories, and grades
l Grade Distribution Report – Grade distribution per assignment
l Missing Assignment Report – Students and the assignments they do not have

grades for
l Grade Calculation Report – Students and the grades for each descriptor

Reports in the “Grade Book Reports” View

The Grade Book Reports view opens a menu of additional report options. Select the
report you wish to view from the drop-down. The screen will refresh to provide the
corresponding pre-screen for that report. Pre-screen options will include date (or date
range) and marking period but may also include additional options as appropriate for
the selected report.

Assignment Report
This report is a list of all assignments in this grade book, the date associated with each
and the max points or grading scale.

To run the report, select a Marking Period or Date Range to determine which
assignments should be included. If the course uses descriptor based grading, a
checkbox option will be available to allow users to choose whether or not to show
descriptors for each assignment on the report.
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Grade Book Report
The Grade Book Report includes several options that control the information displayed
on the report, and can be run for an entire section or for a sub-set of students. Select the
appropriate options and choose the students to include in the report, then click Run
Report to generate it.

Available options include the following:

l Marking Period: To run the report for a single marking period, select that value
from the drop-down list. The report will list only those assignments tied to the
selected marking period, and the student’s overall average on the report will reflect
only the selected marking period assignments. By default this option is set to All.

l Assignment date range (“Show assignments between…”): Users can select a date
range to filter assignments. These date fields are required, and will be pre-pop-
ulated by default to include all assignments in that grade book.
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l Student grade range (“Show students with averages between…”): Users can select
a grade range to filter students by current average. These numeric fields are not
required and are not pre-populated.

l Show Attributes: If checked, any assignment Attribute codes are displayed on the
report. This option is checked by default.

l Show Assignment Details: If checked, the report will display details about each
assignment. When unchecked, only a summary of each category is displayed. This
option is checked by default.

l Hide Student Names: When checked, student names will not be displayed on the
report (only student IDs will be shown). This option is unchecked by default.

l Use Larger Fonts (single column): When checked, the report will be generated in a
single-column format with larger fonts, rather than the smaller, two-column
format. This option is unchecked by default.

l Show Quarterly Summary: When checked, this will display a summary section at
bottom of each student’s information, showing the student’s quarterly average, the
student’s overall course average, and the average of the class as a whole. This
option is unchecked by default.

l Hide Class Average (checkbox): Users can choose whether or not to show
the class average in the Quarterly Summary section. This checkbox is
unchecked by default, and is only available if the “Show Quarterly Summary”
option is checked.

l Show Missing Assignments: When checked, this will display a message at the bot-
tom of each student’s information, indicating the number of missing assignments
(missing assignments are any assignments that is blank (no score received, and
no attributes checked). This option is unchecked by default.

l Show Signature Lines: When checked, this will include a line at the bottom of each
student’s information for parent and student signatures. This option is unchecked
by default.

In addition, users may choose the order in which categories are displayed on the report.
This may be accomplished by changing the numeric order values for each category (a
category ranked “1” will display first, a category ranked “2” will display second, and so
on). If a category has no number entered, that category will not show on the report. By
default, categories are displayed alphabetically and are automatically ordered
accordingly.
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Plan Book Report
The Plan Book Report includes several options that control the information displayed on
the report, and can be run for an entire section or for a sub-set of students. Select the
appropriate options and choose the students to include in the report, then click Run
Report to generate it.

Options available on the Plan Book Report pre-screen include the following:

l Marking Period: To run the report for a single marking period, select that value
from the drop-down list. The report will list only those assignments tied to the
selected marking period, and the student’s overall average on the report will reflect
only the selected marking period assignments. By default this option is set to All.

l Assignment date range (“Show assignments between…”): Users can select a date
range to filter assignments. These date fields are required, and will be pre-pop-
ulated by default to include all assignments in that grade book
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l Student grade range (“Show students with averages between…”): Users can select
a grade range to filter students by current average. These numeric fields are not
required and are not pre-populated.

l Use Larger Fonts: when checked, the report will be generated with larger fonts,
rather than the smaller format. This option is unchecked by default.

l Show Inactive Students: when checked, the report will include all inactive students.
This option is unchecked by default.

l Show Assignment Details: when checked, the report will display details for all
assignments included in the report. This option is checked by default.

l Show Class Average: when checked, the left-most column for overall class aver-
age will be hidden. This option is unchecked by default.

l Show Missing Assignments Section: when checked, this will display a message at
the bottom of each student’s information, indicating the number of missing assign-
ments (missing assignments are any assignments that is blank (no score
received, and no attributes checked). This option is unchecked by default.

l Student Order: this drop-down determines how students are sorted and displayed
on the report. Options include:

l “By Student Name ASC: The report will display student names, and will sort
based on Student Name (Last Name, First Name) in ascending order.

l By Student ID ASC: The report will display student ID numbers instead of
names. The report will be sorted based on student ID in ascending order.

l By Student ID Random: The report will display student ID numbers instead of
names. The students will be displayed in random order, regardless of name
or ID number.

l Users may use the Categories list to select which categories are displayed on the
report. By default, all categories are checked and will therefore show on the report.

l

Notes:
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l For each assignment, the assignment name is displayed on the first line, while the
number of possible points and the Class Average for that individual assignment
are displayed on the next line(s) for each individual assignment.

l When calculating averages, assignments with no score entered (blank or marked
as Exempt) are not included in the average. A score of zero (0) will be included in
the average.

l If an assignment is marked as Exempt, this will be indicated on the Plan Book
Report as “Ex.”

Grade Distribution Report
This report breaks down the student grades and the percentages of students who got
each grade, per assignment along with the assignment average, max number of points,
and student names. It is a multiple page report and helps teachers see the ranges of
points and how many students fall into each range.
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Missing Assignment Report
This report lists all students who are missing one or more assignment grades, along
with the specific name and date of what is missing. Assignments that were marked with
an attribute with a type of “exempt” or “no credit” will not display on this report.

Grade Calculation Report
This report displays a breakdown by category and subject on an individual student
basis. Grades are displayed for each assignment, as is a category average. This report is
typically used only by elementary teachers.
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Submit Marking Period Grades

Marking Period grades are the grades that appear on student report cards at the end of
each marking period (quarter, trimester, etc). This process is the same for each marking
period, including the final marking period.

Note: This procedure is typically performed by secondary teachers only.

If the grade book has been used, grades can be entered manually or can be copied from
the grade book into a marking period grade. If the grade book has not been used, grades
can only be entered manually.

Grades can only be entered during open grading periods. These dates are controlled by
district personnel. During the unlocked period, you may make changes to grades and/or
comments and resubmit them as often as you like. Simply make the desired changes,
and then click the Submit button. This will overwrite previously submitted marking
period grades information. Once the marking period’s grading period is locked, changes
can only be made by a guidance counselor.

In between saves, you can also click the Clear button to clear out any unsaved changes
(grades and/or comments) that you have entered but have not yet submitted. You'll be
prompted to confirm this operation.

Note: Use the Grade Verification Report to check your work before report cards are
printed. The Grade Verification Report is found in the My Home > Reports tab.
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1. From the My Home view, select a course from your course list and access the
Grades tab. Assuming your grade book has been set up, it will display, along
with a list of students and any assignments in the Grade book editor View.

2. From the View drop-down list, select Submit marking period grades.

Note: If the marking period is unlocked/open, the view will refresh with a list of
students and entry fields for their marking period grades. If the marking period
is locked (not open yet or was open and is now closed) the view will refresh
with a list of students in read-only mode. If grades had been entered for the
marking period before it was locked, they will appear in read-only mode as well.
If the marking period is locked, you will not see entry fields.

3. Select the marking period for which you are entering grade information from
the "Show" dropdown list. The default will be the current marking period.

A. Use the "Compare to" dropdown to view grades and comments from
other marking periods (the most recently ended marking period is
selected by default).

B. Use the “Show Inactive Students” checkbox to submit grades for stu-
dents who are no longer in that course but were at some point during
the selected marking period (this includes students who dropped, with-
drew, or switched from the course during that marking period).

4. Assuming the marking period selected is unlocked, enter grades for each stu-
dent. Use the Clear All Grades button at the top of the column if you need to
clear all grade and grade notes without saving.
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A. If you have been using the grade book, you can copy your grade book
average into the marking period grades for each student. In the Grade
Book Average column, click once on the Copy grade book grades
button to copy the current grade book averages into the grade field.
This marking period grade is still editable if you choose to change it.

B. If you have not been using the grade book, you must manually enter
the current alpha or numeric grades for each student.

Note: The grading scale associated with this course is set up and
maintained in the Course Catalog. If you use alpha grades, you will
select from a drop-down list of options. If you use numeric grades,
you will have a free-text entry field where you can type in the grade
value.

C. If the student has not completed the class and does not get a grade,
use the grade note drop-down list to the right of the grade field to
enter a non-completion comment. This list includes values such as
medical, audit and incomplete, among other district-specific values.
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Note: You cannot save the grades if any student has both a grade and
a grade note. It has to be one or the other!

5. If the course uses skills-based grading, the skill set average, as well as the aver-
age for each individual skill, will appear below the overall grade book average.

A. For skill sets that drive grading, each individual skill average will be
copied when using the Copy Grade Book Grades feature.

Note: If the skill set is not configured to allow overrides of marking
period grades, the top Marking Period Grade field will be grayed out.

B. To change skill grades, enter the appropriate value(s) in the Grade
column and click the Recalculate button to update the marking
period average (if appropriate).

i. If the “Allow Override of MP Grade” option is enabled for a
given skill set, users can modify the overall average manually
without recalculating using the individual skill grades.

ii. If the “Allow Override of MP Grade” option is not enabled for
a given skill set, users will be unable to manually override the
overall average. If individual skill grades are modified, the
average will automatically be recalculated to reflect the
newly entered skill grades when the user clicks Save.
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6. Add comments for each student, if desired, using one or more of the methods
described below.

Note: Several buttons are available for individual comment actions but are also
available in the Comments column header to allow these actions to be
performed as batch operations. Clicking the Add Comment button for an
individual comment will add that comment only, while clicking the Apply All
Comments button in the header will apply all comments that have been
entered (but not yet added) for all students, allowing users to enter comments
for multiple students without having to click Add for each individual comment
as they go. Similarly, the Clear Comment button for an individual comment
will clear that comment only; clicking the Clear All button in the header will
remove all comments for all students. Spell-check can also be performed
for a single comment or for all comments.

Methods for adding comments may include the following:

Add comments for one student at a time

l Add comments from the Comment bank:
1. Click on the Comment Bank link for each student indi-

vidually. This will bring up the entire comment bank so
you can select multiple comments for that student. Use
the check boxes to select one or more comments.
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2. Once you have selected the appropriate comments,
click the Add Comments button to save. Continue on
for the rest of your class roster.

l Add Comment Bank comments using numeric Translation Codes
in the free-text field:

1. Enter the numeric values associated with comments
from the Comment Bank into the free-text field.

2. If you wish to add multiple values at one time separate
them with spaces or commas.

3. Click the Add Comment button to apply the com-
ment to that student and continue. The Comment Bank
comments associated with those values will appear in
the Grade column for that student.

Note: Numeric comment values, also known as
Translation Codes, are a district preference. If you are
unable to enter numbers or the corresponding
comments are not displaying, contact your SchoolTool
liaison.

l Add a free-text comment (note that free-text comments are avail-
able based on district settings and may not be available for all
users):

1. Type your comment in the free-text field, then click the
Add personal comment button to the right of the
text box to add the comment to the student’s record.

Note: To spell check your free-text comment, click once
on the Check Spelling button to the right of the free-
text field.

Note: Comments entered here may not appear exactly
as they will appear on the report
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Enter identical free-text comments for all students

l Click on the Mass Enter Free Text Comments button in the
Comments column header

l Enter the desired comment text. Remember to click the Add
button before saving or the comment will not be added!

l Repeat these steps as appropriate and click the Add Comments
button to apply these comments to all students.

Add the same comments to all students using the Comment Bank

1. Click on the Mass Comment Bank button in the Comments
column header

2. The Comment Bank will open in a pop-up. Use the
checkboxes to select the comment(s) you wish to add.
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3. Click the Add Comments button to apply these comments to
all students.

7. When you have finished adding grades and/or comments for each student,
click the Submit button in the upper right section of the Grades tab screen in
order to save your work. Once grades have been submitted/saved, a con-
firmation message “Marking Period grades have been submitted” will appear.

Submit Progress Report Grades

Progress Reports are typically performed mid-way through the marking period (i.e. at
week 5 of a 10 week marking period cycle). They contain comments and/or grades
which update parents on student performance and progress. In some cases, comments-
based progress reports may contain comments that include grade range information.

Note: This procedure generally applies to secondary teachers only.

Progress Report grades and comments can only be entered during open grading
periods. These are controlled by district personnel. Once grading periods have been
locked, only a guidance counselor can change progress report information.

Note: Not all districts generate and distribute progress reports. Only use this procedure
if your district follows this grading model.
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1. From the View drop-down list, select Submit progress report grades.

2. If the marking period is open (unlocked), the screen will refresh with the default
marking and progress report periods and a list of students with grades and/or
comment entry fields. Use the “Show Inactive Students” checkbox to submit
grades for students who are no longer in that course but were at some point
during the selected marking period (students who dropped, withdrew, or
switched from the course during that marking period).

Note: If the marking period is locked, you will not see entry fields.

Note: If the progress report interval is locked (i.e., not yet open, or locked after
entries were due), the progress report area will appear in read-only mode. If
comments were entered, they will appear. If comments have not been entered
yet, the Progress Report column will be blank. Contact your SchoolTool liaison
to unlock the progress report period, or contact a guidance counselor if
changes are required after the period has been locked.

3. Assuming that the marking period is open, select the marking period and pro-
gress report interval for which you are entering comments from the drop-down
lists at the top of the student list. The default will be the current marking peri-
od/progress report interval.

A. If you have not been using the grade book, you must manually enter
the current alpha or numeric grades for each student.

B. If you have been using the grade book, you can copy your grade book
average into the progress report grades for each student. In the Grade
Book Average column, click once on the Copy grade book grades
button to copy the current grade book averages into the grade field.
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This grade is still editable if you choose to change it.

4. Enter progress report comments for each student using one or more of the fol-
lowing methods:

l

Add comments to students one at a time

1. Add performance-related comments from the Comment
bank:

l Selecting the Comment Bank link will bring up the
entire comment bank so you can select multiple
comments for that student.

l Use the check boxes to select one or more com-
ments.

l Once you have selected the appropriate com-
ments, click the Add Comments button to save.
Continue on for the rest of your class roster.

2. Add a free-text comment about the student or their per-
formance in the free-text field (this is optional; max num-
ber of characters is 50).:

l Type your comment in the free-text field, then
click the Add personal comment button to the
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right of the text box to add the comment to the stu-
dent’s record.

Note: To spell check your free-text comment, click
once on the Check Spelling button to the right
of the free-text field. You can only check your
work BEFORE you have added the comment.

Note: Comments entered here may not appear
exactly as they will appear on the report

3. Add Comment Bank comments using translation codes
in the free-text field:

Users may enter the numeric values associated with
comments from the Comment Bank into the free-text
field. If you wish to add multiple values at one time
separate them with spaces or commas.

Note: Numeric comment values, also known as
Translation Codes, are a district preference. If you are
unable to enter numbers or the corresponding
comments are not displaying, contact your SchoolTool
liaison.

l Once you have listed all the numeric values, click
once on the Add personal comment button.
The Comment Bank comments associated with
those values will appear in the Grade column for
that student.

Note: Use the Delete buttons to remove one or
more comments.
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l

 Enter comments for multiple students and save all comments in a
single operation

l Type the numeric value(s) associated with a Comment
Bank comment (if this feature is enabled) OR a free-text per-
sonal comment into the free-text field for a student.

l Repeat until all students have comments in their free-text
fields.

l Scroll back to the top of the Grades tab. Click once on the
Batch Add Comments button at the top of the grid. The
comments will all be added to the respective students at
the same time.

Note: If your district limits the number of comments
(Comment Bank or other) which can be recorded and
printed on progress reports, an error message will display
once you have exceeded (or attempted to exceed) this
number.

l

Add free-text comments to everyone in the class using the Mass Enter
Free Text Comments button

l Click on the Mass Enter Free Text Comments button at
the top of the grid.

l In the popup that appears, enter the desired comment text.
Remember to click the Add button before saving or the
comment will not be added!
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l Repeat the previous step as needed to enter multiple com-
ments, then click the Add Comments button to apply the
comment(s) to all students in the class.

l

Select comments from the Comment Bank and add them to every
student in the class

l Click on the Mass Comment Bank button at the top of
the grid.

l In the popup that appears, use the checkboxes to select
one or more comments from the Comment Bank.

l Click the Add Comments button to apply those comments
to all students in the class.

5. When you have finished adding comments for each student, click the Submit
button on the upper right section of the Grades tab screen in order to save your
work. Once grades have been submitted/saved, a confirmation message
“Progress report grades have been submitted” will appear.
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At any point, you can clear out your unsaved changes by clicking the Clear button in the
upper right portion of the screen. This will not remove any data that has already been
saved/submitted, but allows the user to quickly remove any grades and/or comments
they may have entered but had not yet submitted.

Note: During the unlocked period, you may make changes to comments and resubmit
them as often as you like. Simply make the desired changes, and then click the Submit
button. This will overwrite previously submitted progress report comments. Once the
progress report period is locked, changes can only be made by a guidance counselor.

Note: Use the Teacher Progress Report to check your work before progress reports are
printed. This report is found in the My Home > Reports tab.

Submit Descriptor Report Card Grades

Note: This procedure is typically performed by elementary teachers only.

Descriptor report card grades are the grades that appear on student report cards at the
end of each marking period (quarter, trimester, etc). This process is the same for each
marking period, including the final marking period.

If the grade book has been used, grades can be copied from all assignment grades to a
final marking period grade. If the grade book has not been used, grades can be entered
manually.
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Grades can only be entered during open grading periods. These are controlled by district
personnel. Once grading periods have been locked, only a guidance counselor can
change marking period grades.

1. Access the grade book for the appropriate class.
2. From the View drop-down list, select Submit descriptor report card grades.

3. The screen will refresh with the default Marking Period and a list of students.
To grade by student, select a student and continue to the next screen to grade
that student across all descriptors. To grade by descriptor, select that option
and then choose a descriptor. Continue to the next screen to grade that
descriptor for all students.

Submitting Grades By Student

1. To the right of the student names is a column for Completed grades. This rep-
resents the number of descriptors which have been graded for each student. A
value of “0/68” indicates that no descriptors have been graded out of 68 total
descriptors to be graded.

Note: You may only submit report card grades/comments during the open or
unlocked period. Once this period expires, grades are locked, and the
information becomes read-only for those marking periods which have passed.
Future marking periods remain unavailable until the grading period arrives.

2. Select the first student to be graded. Click once on the Select button to the
left of the student name. You may start at any point in the list. The screen will
refresh with a descriptor area for the selected student. You may need to use
scroll bar at right to see additional options.
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Note: Some grading options may or may not be visible depending on district
settings.

3. Enter the grade information for each student in the subject drop-down area.

Note: If there are gradable subjects on your report card, the Copy Grade Book
Grades link can be used to convert existing averages from the grade book to
district-mapped values in the descriptor grading area. This feature is
dependent on the set up of your report card and is not equally applicable to all
grade levels.

4. Select an appropriate, subject-specific grading option from the drop-down list
at right. Leave the defaulted value, or open the list to select an alternate value.

5. Repeat the above steps for all descriptors in the subject list.

Note: The default grading option in each drop-down field is determined by your
district and grade level. It may be NONE, or it may be a value teachers select
most often (i.e. S – Satisfactory). This will vary from grade level to grade level
(i.e. K to 3) and from building to building.

6. Enter the comments for each subject area, if desired, using any of the following
methods below.

Note: Comments entered here may not appear exactly as they will appear on
the report

A. If your school building/grade level uses subject-based comments, an
entry area for comments will appear at the end of each subject grad-
ing area. The character counter at the bottom of the comment entry
field will indicate the number of characters remaining. If your school
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building/grade level does not use subject-based comments, then only
a single comment area will appear at the bottom of the grading area.

B. Add performance-related comments from the Comment bank.
l Selecting the Add comments from comment bank button

(next to the words Comment Bank) will bring up the entire com-
ment bank.

l Select one or more comments for that student by clicking once
in the check box next to each comment you want.

l Once you have selected the appropriate comments, click the
Save comments button to save them to this subject’s grade
area. The comments will appear on the student’s Comments
sub tab as seen below.

Note: Use the Delete buttons (to the left of each comment) to
remove one or more of the comments you have selected (see
previous image).

Note: Only use the Delete All Comments button (to the right
of the comment entry field) to delete ALL Comment Bank AND
free-text comments at once, including any text in the free-text
entry field.

C. Add a free-text, personal narrative comment about the student or their
performance in the free-text field (this is optional).
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l Type your comment in the free-text field.
l Click once on the Check Spelling button, if desired.

Note: You may check the spelling of your free-text comment
while it is still in the entry field. If errors are found, a pop-up
window with options will appear. If no errors are found, the spell-
check box will appear briefly and will then close. Once you have
added your comment, it can no longer be spell checked.)

l Click once on the Add personal comments button to the right
of the text box to add the comment to the student’s record.

l Once you have added personal comments, the subject comment
area will look like this:

To delete a single comment, use the Delete button to the left
of the comment. To edit your comment, click the Edit for the
appropriate comment and update the content.

D. Add Comment Bank comments using the free-text field.
l If this feature has been enabled, you may enter the numeric

value(s) (translation codes) associated with one or more com-
ments from the Comment Bank into the free-text field. If you add
multiple values at one time separate them with spaces or com-
mas.
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l Once you have listed all the numeric values, click once on the
Add personal comment button. The Comment Bank com-
ments associated with those values will appear in the subject
grading area for that student.

7. Use the Delete buttons (to the left of each comment) to remove one or more
of the comments you have selected (see previous image).

Note: Only use the Delete All Comments button (to the right of the comment
entry field) to delete ALL Comment Bank AND free-text comments at once,
including any text in the free-text entry field.

8. When you have finished grading and adding comments to this subject area,
continue on to the next one. It may be necessary to scroll down to see addi-
tional subject areas to be graded. Repeat steps 6 and 7 until all subject areas
are completed.

9. When you have finished grading and adding comments to all subject areas for
this student, you must save your work. Use any of the following task buttons to
save:

l Use the Submit grades button to save your work and return to your list
of students. This button is located in the upper right corner or lower right
corner of the Grades tab, OR

l Use the Submit grades and go to next student button to save your
work and go on to grade the next student in the list (this button will not
appear if you are at the end of the list.), OR

l Use the Submit grades and go to previous student button to save your
work and go on to the next student (this button will not appear if you are
at the beginning of the list) .
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10. Once grades have been submitted/saved, a green confirmation message “Mark-
ing period grades have been submitted” will appear. This message either
appears under the View menu in the Submit descriptor report card grades view
(see above), or above the name of the previous/next student in the list (see
below).

Note: During the unlocked period, you may make changes to grades and/or
comments and resubmit them as often as you like. Simply make the desired
changes, and then click the appropriate task button to save your work. This will
overwrite previously submitted report card grades information. Once the report
card grading period is locked, changes cannot be made.

11. To verify your comments and grade values will display properly, use the Ele-
mentary Grade Report:

12. Click once on Home to return to your My Home area.
13. Click once on the Reports sub tab to the far right of your Class List. The tab will

open with a list of elementary-specific reports.
14. Select the Elementary Report Card. The report card will appear in a separate

window, where you can verify the grade values and comments added.

Note: Depending on district settings, descriptor topics and any submitted
grades may be visible on the Marking Period Grades view of a student’s My
Home > Grades tab.

Submit Descriptor Grades by Descriptor

Note: This procedure is typically performed by elementary teachers only.

1. To submit report card grades by descriptor, choose the appropriate marking
period and Select the descriptor you wish to grade.

2. The screen will refresh to display a list of students and the grades they have
received for the selected descriptor.

3. Select the scores for each student and click Save to submit the grades or click
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Cancel to return to the list of descriptors without saving.

Submit Descriptor Progress Report Grades

Note: This procedure generally applies to elementary teachers only.

Descriptor progress reports are typically performed mid-way through the marking period
(i.e. at week 5 of a 10 week marking period cycle). They contain comments which
update parents on student performance and progress.

Descriptor progress report comments can only be entered during open grading periods.
These are controlled by district personnel. Once grading periods have been locked, only
a guidance counselor can change progress report comments.

Note: Not all districts generate and distribute descriptor progress reports. Only use this
procedure if your district follows this grading model.

1. From the My Home view, select a course from your course list and access the
Grades tab. Assuming your grade book has been set up, it will display, along
with a list of students and any assignments in the Grade book editor View.

2. From the View drop-down list, select Submit midterm exam grades.

3. The screen will refresh with a list of students and a complete column des-
ignating how many descriptor values have been completed per student. For
example, “0/4” means that none are complete, while “4/4” means all are com-
plete.
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4. Select the marking period and progress report interval for which you are enter-
ing comments from the drop-down lists at the top of the student list. The
default selections will be the current marking period/progress report interval.

5. Select the first student from the list by clicking once on the Select button to
the left of the student row. The screen will refresh with grade entry details for
the selected student.

6. Enter the progress report comments for each student. Depending on your dis-
trict preferences and settings for elementary descriptor progress report grad-
ing, you may see free-text entry fields, comment fields, or drop-down lists with
pre-defined options.

Note: To use the Comment Bank, click once on the Add comments from
comment bank button located in the Comments sub tab area.

Note: To enter free-text, narrative-style comments, type into the free text
comment area, and click once on the Add personal comment button to the
right of the entry field. Use the Check Spelling button to check your work first.

Note: Comments entered here may not appear exactly as they will appear on
the report

7. When you have finished adding descriptor progress report values for each sub-
ject, and/or comments for each student, you have two options for saving your
work:

A. Click once on the Submit grades and go to next student button in
the upper right corner of the progress report grading area to continue
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grading the next student. The next student’s progress report grading
area will appear, OR

B. Click once on the Submit grades button in the upper right corner of
the progress report grading area to save grades for this single stu-
dent, and then quit.

8. Once grades have been submitted/saved, a confirmation message will appear.

Submit Midterm Exam Grades

Midterm exam grades are the assessment grades typically given at the half-way point of
a year-long course. However, midterms can also be used to assess progress at the half-
way point of a half-year course.

1. From the My Home view, select a course from your course list and access the
Grades tab. Assuming your grade book has been set up, it will display, along
with a list of students and any assignments in the Grade book editor View.

2. From the View drop-down list, select Submit midterm exam grades.

3. The view will refresh with a list of students and entry fields for their midterm
exam grades.

Note: If the Submit midterm exam grades option does not appear in the drop-
down list, then this course has not been set up with a midterm exam in the
Course Catalog.

4. Enter the grade information for each student. In the grade value field, enter the
appropriate grade according to the pre-defined grading scale, such as a
numeric grade in a free-text field, or an alpha grade selected from a drop-down
field.
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Note: The grading scale associated with a midterm exam is set up and
maintained in the Assessments sub-module of the Counseling module.

A. If assessment notes are enabled for the current school year, teachers
will also see a drop-down list where they may select an assessment
note for each student as appropriate.

5. When you have finished grading each student, click the Submit button in the
upper right corner to save your work. Once grades have been submitted/saved,
a confirmation message “Midterm grades have been submitted” will appear.

To discard any unsaved changes and revert to the last saved state, click the
Clear button.

Note: The midterm exam can be set up to equal a certain percentage of the
final course average. Please contact your SchoolTool liaison for more
information on midterm exams.

Note: To verify midterm exam grades, review the Grades Verification report
found in the My Home > Reports tab.



Teacher User Guide Page 209 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

Submit Final Exam Grades

Final exam grades are the assessment grades that appear on student report cards when
the course has finished. This may be at the end of a semester for a half-year course, or
at the end of the year. Final exam grades are not final averages, nor do they replace final
averages.

1. Navigate to the Grades tab for the appropriate class.
2. From the View drop-down list, select Submit final exam grades.

3. The view will refresh with a list of students and entry fields for their final exam
grades.

Note: If the Submit final exam grades option does not appear in the drop-down
list, then this course has not been set up with a final exam in the Course
Catalog.

4. Select the assessment you are entering grades for from the Assessment drop-
down list. This list contains all assessments tied to this course. If only one
assessment is linked, it will display in the field. If there are multiple finals for
this course, select the appropriate assessment from the drop-down field before
grading students.

Note: If a Regents exam has been tied to this course, a corresponding
Administered On drop-down field will appear. Make sure to select the
appropriate date/time from this field before saving grade entries.

5. Enter the grade information for each student:
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6. In the grade value field, enter the appropriate grade according to the pre-
defined grading scale, such as a numeric grade in a free-text field, or an alpha
grade selected from a drop-down field.

Note: The grading scale associated with a final exam is set up and maintained
in the Assessments sub-module of the Counseling module.

A. If assessment notes are enabled for the current school year, teachers
will also see a drop-down list where they may select an assessment
note for each student as appropriate.

7. If you cannot enter a grade for this student, check the appropriate box to des-
ignate why. Otherwise, leave these check boxes unchecked.

A. Absent – the student was absent on the day the exam was admin-
istered.

B. Unscorable – the student’s exam could not be graded.
C. Exempt – the student was exempt from taking the exam (in accord-

ance with state definitions).

D. With Modifications – if the student took the exam with modifications
(such as a translator or device meant to assist with a disability), check
the With Modifications check box. Otherwise, leave this box
unchecked.

i. If this field is checked, the screen will refresh, displaying a
list of options. Check any appropriate modifications.
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8. Select the Language the student took the exam in. English is the default.

9. Repeat these steps for each student in the course.
10. When you have finished grading each student, click the Submit button to save

your work.

Once grades have been submitted/saved, a confirmation message “Final exam
grades have been submitted” will appear.

To discard any unsaved changes and revert to the last saved state, click the
Clear button.

Note: The final exam can be set up to equal a certain percentage of the final course
average.

Note: To verify final exam grades, review the Grades Verification report found in the My
Home > Reports tab.

Override Calculated Final Averages

Occasionally, teachers may need to override the final average calculated by SchoolTool.
Final grade calculations are based on formulas set up by the district at the beginning of
the school year. If a teacher feels that the calculated grade (which is often based on all
marking period grades and any final exam grade(s)) should be changed for a student or
students, using this feature allows them to overwrite it. Likewise, if a student has a
grade note for a marking period, which means that the final grade should be incomplete,
teachers can use the Average Override feature to remove the pre-calculated grade. The
report card would then show a blank in the final average area, denoting that this class
was incomplete.
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Note: This process assumes that final marking period (typically quarter 4 or semester
2) grades have been entered and saved, and that final exam grades have been
submitted.

Note: This process should only be used at the end of the final grading period for a
course (i.e. end of the first semester for a half-year course, or end of the year for a full-
year course). The average override feature should never be used to log or override a
marking period grade.

1. Navigate to the Grades tab for the appropriate class.
2. From the View drop-down list, select Override calculated final averages. The

view will refresh with a list of students and their current final averages based
on SchoolTool calculations.

3. Locate the student for whom you will override a grade. The Average Override
column will show all final averages that exist for students on this screen,
whether those averages were calculated automatically or have already been
overridden. You can identify overridden averages by the presence of a Clear
Override  button in any row that has an existing override. When an override is
entered, the Clear Override  button will appear in that row immediately.

4. Enter the new grade information for the student:
A. In the grade value field, enter the appropriate grade according to the

pre-defined grading scale, such as a numeric grade in a free-text field,
or an alpha grade selected from a drop-down field.

Note: If you wish to remove a grade so that the final average appears
blank on the report card, as in the case where the final grade is
incomplete, simply remove the numeric grade (do not type a zero) or
choose NONE as the alpha grade and save. In this scenario, the Clear
Override  button will appear next to an empty grade field, and
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clearing the override would cause the final average to be recalculated
once again.

5. Repeat for each student whose final grade must be overridden. When you have
finished, click the Submit button to save your work. If there are any validation
errors on the page, the Submit button will be disabled until you have resolved
the issues.

Once grades have been submitted/saved, a confirmation message “Final
average overrides have been submitted” will appear.

To discard any unsaved changes and revert to the last saved state, click the
Clear button.

Note: Any grade entered in this area will appear on the report card as the student’s final
grade. To verify final average overrides, run the Grades Verification Report found in your
My Home > Reports tab for the final marking period.

Submit SLO Scores

Teachers can submit SLO scores from within the Grade Book for any course section that
has an active SLO.

Depending on user permissions, the screen may display in read-only mode, or may
include Edit buttons for each score column to allow users to enter or modify SLO
scores.

To enter and submit SLO scores, click the Edit button in the appropriate column.
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Enter scores and click Save to submit the grades or click Cancel to return without
saving.

Import Assignments and Grades

The Import Assignments and Grades screen allows teachers to quickly add
assignments and associated grades to a grade book after the data has been sent from
another system (such as an LMS). Assignment data will be sent to SchoolTool behind
the scenes and will automatically appear on this screen when available. Teachers can
then review the information and add it to their grade books. After importing to the grade
book, these assignments will behave like any other assignment in the grade book editor.
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To add assignments and pending grades to the grade book editor, use the checkboxes
to select the assignment(s) you wish to import. Modify fields as needed, being sure to
select values for all required fields. Click the Save icon to import the selected
assignments and any pending student grades, or use the Discard button to remove
selected assignments without importing.

Hover over the Grades button to see the number of pending grades in a mouse over,
or click on it to see a list of pending student grades.

If the grade book already contains a matching assignment (an assignment with the
same name and date), or if students already have scores for that assignment, you will
receive an error indicating that duplicate data already exists. You may discard the
pending changes or, if you wish to import, you may use the “Allow Overwrite” option to
import assignments and/or grades anyway (this will overwrite existing data).

The Batch Adjust Category button allows you to quickly set all assignments to the
same category.
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Select the appropriate category from the drop-down and click Update to set this
category for all assignments on the screen.

Keep in mind that batch adjusting the category will change all assignments on the
screen, not just those that are checked.

Submit CDOS

To submit data for CDOS:

1. Select Submit CDOS from the View menu.
2. Select the year (9th Grade, 10th Grade., etc.) and CDOS document.
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3. Select students and click Next .

4. Select course topics and click Next .

5. Enter evaluation data for each descriptor.

6. Click Save and Next to submit and move to the next student, or Save and Exit
to save and return to the beginning. A confirmation message will appear

when data has been saved for the previous student.
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Submit Employability Profile Scores

To submit scores for Employability Profiles:

1. Select Submit Employability Profile Evaluation from the View menu.
2. Select the appropriate marking period and Employability Profile for which you

wish to submit scores.

3. Select students from the list and click Next .

4. Select course topics and click Next .
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5. Enter scores and/or comments for each descriptor for the first student.

Note: The screen will display the most recently submitted marking period’s
grade and/or comments relative to the grading interval currently being graded.
Only marking periods that fall before the interval being graded will be shown.

6. Click Save and Next to submit and move to the next student, or Save and Exit
to save and return to the beginning. A confirmation message will appear

when data has been saved for the previous student.

Submit User Defined Assessments

The Submit User Defined Assessments area allows teachers to submit User Defined
Assessment data for students on their rosters. Teachers can access this area by
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navigating to their grade book for a course and selecting the Submit User Defined
Assessments option in the View menu.

To begin, select the User Defined Assessment and school year for which you wish to
submit data. The page will refresh with a list of students and columns for each UDA
field. Check the “Show Inactive Students” option if desired.

If students already have data for that UDA, the information will be presented as a
separate row for those students, with a second (blank) row to allow entry of a new UDA
record. Use the “Show Only Blank Rows” option to hide existing UDA data.
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To submit UDA data, simply enter the appropriate data and click the Save button.
Required UDA fields are indicated with a red asterisk * in column headings.

End of Year Grading FAQs

Question: What final grading tasks do teachers need to complete at the end of the year?

Answer: At the end of the year, teachers have three (3) specific tasks to complete all
grading.

1. Enter and save final marking period (i.e. Quarter 4 or Trimester 3) grades. Fol-
low the steps in the Submit Marking Period Grades section or complete the pro-
cedure as you’ve done for all previous marking periods.

2. Enter and save final exam grades. These could be local finals which are used in
final average calculations, or Regents exams. Follow the steps in the Submit
Final Exam Grades section.

3. Verify final grade entries and final average calculations. Final averages are
automatically calculated by SchoolTool using formulas set by the district. For
example, final grades may be calculated based on 4 marking periods and a
final exam worth 20% of the final average. To verify final grades and final aver-
ages, use the Grade Verification report found in the My Home > Reports tab.

Note: If a teacher wishes to change a final grade which was calculated by SchoolTool,
they may use the Average Override feature. Follow the steps in the Override Calculated
Final Averages procedure for more information.
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Note: To remove the calculated final average, use the Average Override to remove the
final grade. The report card will display a blank in the average column.

Question: How do I enter final exam grades?
Answer: From your My Home class list, select a course. When the course
Attendance tab appears, select the Grades tab. When the Grades tab appears,
open the View menu. Select Submit final exam grades. The screen will refresh with
your list of students and entry fields where final exam grades can be entered.
Enter and save your grades. Refer to the Submit Final Exam Grades procedures for
more information.

Question: How do I mark a student as exempt from a final exam?
Answer: A state final exam can be marked as Absent, Unscorable, or Exempt.

Question: How do I enter final averages?
Answer: You don’t. SchoolTool does this for you. After you have submitted and
saved grades for the final marking period, and any final exam grades, SchoolTool
automatically calculates the final average.

Question: How do I designate that a final grade should be a grade note, such as
“incomplete” or “medical”?

Answer: There is no way to select a grade note as the final grade. Instead, use the
Average Override feature to remove the pre-calculated alpha or numeric grade
value for the student. Once the Average Override is saved (either as NONE (for
alpha grading) or blank (for numeric grading)), the student’s report card will show
a blank for that grade, indicating the final grade is incomplete.

Question: How does SchoolToolcalculate final averages for a course?
Answer: In most cases, the final average is based on the marking period grades
and a final exam grade. Final exams can be designated as a percent of the final
grade; if this is set up in the Course Catalog, the formula will consider the
percentage and figure the appropriate average. If there is no final exam, the final
grade will be based on the marking period grades.

Question: Where can teachers go to see final averages calculated by SchoolTool?
Answer: There are two places. Teachers can use the Grade Verification Report
found in their My Home > Reports tab which show the calculated averages for
each student, or in the Grades tab of a course, teachers can change the view to
see the Average Override screen. This screen displays the SchoolTool– calculated
final average, which takes into consideration final exam grades and all marking
period grades. Refer to the article on Calculating Horizontal Averages for more
scenarios.

Question: Is there a report teachers can use to review final averages?
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Answer: Yes. In a Teacher’s My Home area, there is a Reports tab. The Reports tab
contains a report called “Grade Verification.” View this report for the final marking
period (semester 2, trimester 3, quarter 4) to see all previous marking period
grades, final exam grades, and final calculated grade.

Question: How does SchoolTooldisplay the final average if one of the marking period
grades is a grade note, such as “medical,” “incomplete,” “audit,” etc?

Answer: The system will not calculate a final grade because one of the marking
period grades is missing. Refer to the Knowledge Base for more information.

Question: If my final grades are numeric, what happens if I erase a final grade in the
Average Override area?

Answer: If you replace a final grade with a blank field, then the student’s final
grade on the report card will appear blank.

Question: If my final grades are letters instead of numbers, what happens if I replace a
final grade with NONE in the Average Override area?

Answer: If you replace a final grade with an alpha value of NONE, then the
student’s final grade on the report card will appear blank. If you convert your
letters to numeric grades, then the final grade will appear as a numeric value on
the report card.

Question: Can I use Average Override to change marking period grades?
Answer: No. The Average Override feature only affects the final grade, which
appears on a report card or transcript at the end of the course.

Missing Students Tab
The Missing Students tab only displays for teachers. This tab will show a teacher a list
of unresolved course absences for the specified date range. The list will display all
students who are assigned to one of that teacher’s classes. This list may be sorted by
any column simply by clicking on that column’s heading.
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Note:  This list only shows unresolved course absences for the current year. In addition,
the Missing Students tab is only visible for teachers who have classes for that school
year.

Teachers also have the option to print the list of missing students list. After clicking the
Missing Students Report button, the report will generate in a new window. The report
will respect the on-screen sort order and the specified date range.

Reports Tab
The Reports tab is only available for faculty members, and does not appear if the current
year’s Master Schedule is unlocked. You will only see a list of reports here if you have
classes listed and the appropriate user permissions.

If you have reports listed in this tab, you may click on the appropriate Select  button to
choose the report you want to run. Some reports will automatically generate and will
open in a new window. Other reports require user input before they can be run (dates or
date ranges, for example).

Note: Access to specific reports is based on user permissions, and not all teachers will
have access to all reports.

Teacher Reports

Teachers are given access to several reports to help them analyze and verify their grade
entries, their homeroom and period attendance, and their class information.
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All reports are found under the Reports tab at the top of a teacher’s My Home screen.
The following is a list of reports generally found here. These typically vary between
elementary and secondary teachers.

l Course List Report
l Detailed Homeroom List Report
l Elementary Report Cart Report (elementary teachers only)
l Grade Verification Report (secondary teachers only)
l Period Attendance Report (secondary teachers only)
l Progress Report
l Daily Roster Report

To access the Teacher Reports:

1. From Home > My Home, click on the Reports tab. The screen will refresh with a
list of reports.

2. Click once on the Select button to the right of the row for the desired report.
Some reports will automatically generate, while others have a prescreen that
requires user input before the report can be run.

Course List Report

SchoolTool contains a Course List Report which allows teachers to verify the students
that are in each class they teach. This report is found in the Reports tab of every
teacher’s My Home.

Select the Course List Report. The report screen will automatically generate.
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Note: This report is portrait showing all courses in a double pane. This report is for a
quick glance to see students in your class. It is not meant for attendance taking.

Grade Verification Reports

The Grade Verification Report allows teachers to verify their marking period grades,
midterm exams, final exam grades, and calculated final averages and comments. This
report is found in the Reports tab of every teacher’s My Home.

Use this report at the end of each marking period to ensure all students have been
graded. At the end of the year, use this report to verify that all final exam grades have
been entered and those final averages, as calculated by SchoolTool, are correct.

1. Select the Grade Verification Report. The report pre-screen will appear.
2. Select the appropriate marking period from the Marking Period drop-down list.

Note: In this example, if you select Quarter 1, only grades (and comments) for
Quarter 1 will appear. If you select Quarter 2, grades for Quarter 1 and Quarter 2
will display. If you select Quarter 3, grades for Quarters 1, 2 & 3 will display, and
so on. Averages and transcript credits earned display in parentheses while in
progress.
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Note: After final marking period grades and final exam grades have been
submitted, generate this report for the final marking period to see the final
horizontal averages as calculated by SchoolTool.

3. Click once on Run Report. The Report Viewer will launch and the report will
appear.

Note: The Grade Verification Report contains verification pages for every class
in the teacher’s My Home. It may be necessary to scroll through the pages to
find a particular class if you are verifying one section or looking to verify a
specific student.

Note: Refer to the following procedures for more information on making
corrections to grade information: Final Exam Grading, Marking Period Grading,
and Secondary Average Override.

Note:Students who appear highlighted in red on the report have grades or
grade notes but the report cannot calculate an in-progress average for that
student.

Period Attendance Report

SchoolTool contains a Period Attendance Report which allows teachers to verify a list of
students that have been absent from class. This report is found in the Reports tab of
every teacher’s My Home.

1. Select the Period Attendance Report. The report pre-screen will appear.

Note: This report generates for every student. There is no way to limit it to one
class or a particular student at this time.
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2. Select the appropriate marking period from the Marking Period or Date Range
using the radio buttons and drop downs available.

A. By default, this report only includes active students (students are con-
sidered active if they had an active enrollment in the selected building
on the last date of the specified date range). To run the report with
inactive students included, check the Include Inactive Students check-
box.

3. Click Run Report to generate the report, which will open in a new window.

Note: If you select the Marking Period, a date range will appear at the top of the report
displaying the actual dates of that marking period.

Note: The Period Attendance Report lists every student taught by this teacher, in
alphabetical order. The class the student was absent from displays under the student
name, along with the period of that class. Because of this it may be necessary to scroll
through the pages to find a particular class if you are verifying one section or looking to
verify a specific student.

Progress Report

SchoolTool contains a Progress Report which allows teachers to verify their grades
and/or comments per student per class for selected progress report interval. This report
is found in the Reports tab of every teacher’s My Home.

1. Select the Progress Report. The report pre-screen will appear.
2. Select the appropriate marking period from the Marking Period and Progress

Report Interval from the drop-down list and run the report.
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Note: The Progress Report contains verification pages for every class in the
teacher’s My Home. It may be necessary to scroll through the pages to find a
particular class if you are verifying one section or looking to verify a specific
student.

Detailed Homeroom List Report

SchoolTool contains a Detailed Homeroom List Report which allows teachers to see
details on each student for each class such as birthdays, contact information, home
phone number, etc. This report is found in the Reports tab of a teacher’s My Home.

Select the Detailed Homeroom List Report. The report screen will automatically
generate.
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Elementary Report Card

SchoolTool contains an Elementary Report Card which allows teachers to verify their
descriptor report card grades and comments. This report is found in the Reports sub tab
of every teacher’s My Home.

Use this report at the end of each grading period to ensure all students have been
graded successfully. At the end of the year, use this report to verify that all grading
period grades have been entered.

To access the Elementary Report Card:

1. Select the Detailed Homeroom List Report. The report screen will auto-
matically generate.

2. Select the appropriate marking period from the Marking Period and report card
format from the drop-down lists.

Note: In this example, if you select marking period 1, only grades (and
comments) for marking period 1 will appear. If you select marking period 2,
grades for marking periods 1 & 2 will display. If you select marking period 3,
grades for marking periods 1, 2 & 3 will display. If you select marking period 4,
grades for all marking periods will display.

3. Click once on Run Report.

Note: The Elementary Report Card contains verification pages for every student
in the teacher’s My Home. It may be necessary to scroll through the pages to
find a particular student, or use the preview pane at the left to select a student.

Note: Refer to the Descriptor Report Cards procedures for more information on
making corrections to grade information.
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Daily Roster Report

SchoolTool contains a Daily Roster Report which allows teachers to print a list of
students per class. This report is found in the Reports tab of every teacher’s My Home.

1. Select the Daily Roster Report. The report pre-screen will appear.

2. Select the date that you wish to run the report from and click Run Report.

Note: The Daily Roster Report contains several pages for every class in the
teacher’s My Home. It may be necessary to scroll through the pages to find a
particular class if you are verifying one section or looking to verify a specific
student.

Note: This report is often used by substitute teachers for attendance.

Minutes Verification and Override

The Minutes Verification and Override allows teachers to review course minutes per
relationship and, if they have the appropriate permissions, manage overrides for
relationship minutes, and responsibility weight for data warehouse exports. The screen
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shows only that teacher’s students. Depending on the user’s permissions, the screen
may include options to View Minutes, Edit Override Values for Export, or both.

Note: Due to the large number of calculations, this screen may load slowly; using filters
to narrow the results will help.

1. To begin, use the dropdown to select a School Year.
2. Select whether to View Minutes or Edit Override Values for Export (these

options are available based on permissions; View will present the results in
read-only mode, while Edit will allow users to add, edit, or clear overrides).

A. If the View option was selected, users can specify a Date Range. The
results list will show records where a relationship existed during the
selected dates; all minutes calculations will be performed based on
these dates, allowing users to see the minutes accumulated for a
relationship for that date range.

Note: When the Edit option is selected, records will reflect the
selected school year; users will not be able to specify a date range
due to the nature of minutes calculations.

3. Select Students (all students or specific students using the batch selector).

A. When a user clicks the Select Students option, the screen will refresh
to show the teacher’s class list or the batch selector. Select the
appropriate students and click Continue (or click Cancel  to return to
the main screen)
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B. Once students are selected, the radio button will show “Selected
Students” (including the number of students selected). Click New
Search to clear the search and find a new group of students or click
Modify Search to return to the previous search criteria.

4. Click the Search button to generate the results list (results will only include
rows for courses that are mapped to a state course).

The results list will display any relationships that meet the selected filter
criteria (if in View mode, the list will be presented in read-only mode). The list
will include relationship start and end dates, the student ID and name, the
course department, ID (including section number and period), course name,
state course code, and teacher. It will also include calculated values for Total
Planned, Potential, and Actual Minutes, Responsibility Weight, and any existing
overrides for Potential Minutes, Actual Minutes, and Weight values.

Records in red text indicate that a Minutes override was added but that row is
no longer valid due to underlying data issues (for example, if a schedule
effective date is modified after the student has been given a minutes override).
These rows will show “0” for the calculated minute columns.

Definitions:

l Total Planned: This field is the number of minutes that the course has met (or
planned to meet) for the school year. This is based on the number of ‘sessions’ a
course/section has met and the minutes – derived from one of the three options
described below. The sessions will use all weekdays that are associated with a
semester and are not set to ‘Students Off’ in the Maintenance > School Year > Cal-
endar area.

l Potential: This field is based on the Total Planned Class time with the following
exceptions:

l The minutes calculation will start with the Relationship Start Date and pro-
ceed to the Relationship End Date. When a date range is selected, cal-
culations will only include minutes within that date range.

l When a date range is selected, this calculation will only include minutes
within that date range.
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l Actual: This field is based on the Potential Student Instructional Time but will NOT
include any sessions that occur on a date for which the student has a daily
absence or a period absence for the given course/section.

l Weight: This is a number between 0 and 1 representing the percent allocation of
responsibility for instruction assigned to this teacher and student.

When in Override Mode, Edit and Delete buttons may appear beside rows in this list.
To add or modify an override, click the Edit button and modify the fields at the far right
of the list as desired. Be sure to Save when done to apply changes.

The Delete button clears all override values that the user has rights to override for a
given row. It will only be available when an override exists. When clearing overrides for
an invalid row (shown in red), that entire row will be removed from the list.

Print the report if desired. The report will respect any on-screen sort order.

Employability Profile/CDOS Report

1. Use the pre-screen to define the options for the report and click the Run Report
button to generate the report.
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A. Select the type of report you wish to run (Employability Profile or
CDOS).

B. Select a profile from the drop-down (this list will include all available
profiles of the Type selected in the previous step; for teachers, the list
will be limited to profiles that are tied to that teacher’s courses).

C. Select the appropriate timeframe for the report:
i. For Employability Profile reports, select a Marking Period

using the drop-downs provided.
ii. For CDOS reports, select a Year.

D. Select the desired report format.
E. Select the students for whom you wish to generate the report (all stu-

dents, a single student, or a group of students selected by using the
Class List or the batch selector):

i. To select a group of students, click the Select Students
option. The screen will refresh to show the teacher’s class
list and/or the batch selector. Select the appropriate stu-
dents and click Continue (or click Cancel to return to the
main screen).

ii. Once students are selected, the radio option will show “Selec-
ted Students” (including the number of students selected).
Click New Search to clear the search and find a new group of
students or click Modify Search to return to the previous
search criteria.

F. Choose the order in which you wish to generate the reports (either by
student name or by home district) and click the Run Report button.

Sample Report Employability Profile - Portrait Layout:
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Sample Report Employability Profile - Landscape Layout:
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Sample CDOS Report:
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Current Marking Period Average Report

The Current Marking Period Average Report allows teachers to generate reports based
on students' grade book averages (based on assignment grades) for the current
marking period. The report is broken down by course and shows all students in that
course or, if a grade range is specified, only those students whose current average is
within the specified range. The report also includes a column that indicates students'
overall averages based on assignment grades.

Teachers might use this report to get a snapshot of students' performance for the
current marking period. For example, to see which students who are close to failing, they
may run the report for only those students with a current average between 60 and 70.
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Note: Students who have not received any assignment scores will not be included in the
report.

1. To begin, locate the student(s) for whom you wish to run the report.
A. First, select the appropriate classes and click Search.

B. The screen will display a list of students from the selected classes.
Use the checkboxes to select one or more students and click
Continue.

2. On the report pre-screen, specify the range for averages you wish to return. For
example, you might wish to limit the results to students whose current marking
period averages are between 90-100, or only those whose current marking
period averages are below a 67. To view all students, simply leave both range
fields blank. Click the Run Report button to generate the report.

3. A new window will open with the report, which is broken down by course and
shows only the selected students who meet the grade range criteria for the
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currently active marking period.

Search Tab

This is the default My Home tab used for users who are not Parents, Students, or
Teachers with current classes. This tab allows you to search for a student. There are
two methods for searching: Basic Search and Advanced Search (Batch Selector).
Search rights are based on user permissions and may not be visible for all users. For
detailed instructions on using Advanced Search, see the Batch Selector User Guide.

Quick Search
From the top of any SchoolTool screen, a search control exists that can be used to
search for student records without navigating back to the main search screen of the
current module. This search feature is controlled by user permissions, so not all users
will see this.

To use the Quick Search feature, simply enter text in the search box at the top of the
screen, and click on the Search button.

All searches will be performed from within the main search window of the current
module.  For instance, using the new Quick Search feature from within the Attendance
module will re-navigate the user to Attendance > Student Search and display the
appropriate results. If a Quick Search is performed within a module that a user does not



Teacher User Guide Page 241 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

have rights to search in, or that does not have a search function (such as the
Maintenance module), the search will be performed from within Home > My Home >
Search.

Note:  All current operations should be completed (saved) before using the Quick
Search function.  Using Quick Search will navigate the user away from the current
screen in order to display the search results.

Basic Search
Use this procedure anytime you see a single search field with a search button, as in the
image below, which illustrates a basic search from a user’s My Home module. This
same function is available as a “Quick Search” feature that is accessible from anywhere
within the application. Keep in mind that not all users will see the link to Advanced
Search that is shown in the image below.

1. Enter search criteria into the search field.

2. Typically, the text entered here is any combination of a student's first name,
last name, parent's last name, or student ID. For example:

l Shelly Smith
l Sh Smith
l Smith
l Shelly
l 34712

3. Click on the Search button to obtain the results.

Tips for Search Criteria

1. Depending on the makeup of your school and district, different search
strategies may apply.

l In a very large district, for instance, it may be worthwhile to be
very specific when searching to prevent to help minimize the
number of results. In a smaller district, being general when
specifying criteria may be advantageous.

2. Be general: Enter only the part of the name you need.
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l Typing Dan will locate all students with a name of "Dan,” "Daniel,”
and "Danielle,” and McDanoskovich.”  It will also save you from
having to guess how to spell "Danovski"

3. Be specifc: If you know you are looking for Tanya Smith, just entering
"smith" may result in too many "hits.” Instead, try typing "Tan Smith,” to
narrow the list down further

4. Don't guess: If you have no idea how to spell a name, just enter the
letters you do know. 

l Typing "ist" might return a lot of students, but it will suffice for
locating a student named "Khristeena.” Again, if you know any of
the student's last name, use that too. E.g., "ist jones"

5. Use Wildcards: Wherever you are unsure of a name, you may use a
wildcard, a character that replaces the questionable part of the name.

l For instance "ste*en" will locate all students with a name if either
Steven or Stephen.

More on Using Wildcards

A wildcard is a single character, either an asterisk (*) or percent sign
(%) that can be used to substitute for any number of unknown
characters in the name being searched for and can be used anywhere
in a string of text.

l "ste*n" will locate all students with a name of Steven, Stephen, or
Stephanie.

l "m*Donald" will locate all students with a name of "MacDonald"
or "McDonald.”

Example:

A phone call comes into the attendance office stating simply that
"Steven" is home sick today. Since we don't know how to spell Steven
(Stevan? Stephen?) We can use wildcards to help:

l Enter a search criteria of "ste*n" and click on the Search button.
l Note the results returned all students that have a first name, last

name, or a contact's last name of either Steven or Stephen, as
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well as names containing those letters, such as Stephanie.

Search Results
There are four (4) possible results from a search:

1. No search results: When no students can be found based on the entered cri-
teria, a message stating this will be displayed.

2. Too many search results: When too many results are found that match the
entered criteria, a message stating this will be displayed. The maximum num-
ber of search results is determined by the district and can be set in the Main-
tenance area by a system administrator.

3. A single match found: When only a single match exists for the entered criteria,
the student's record that matches the criteria will be displayed immediately.

4. Multiple Matches: When a group of students match the same entered criteria,
they will all be displayed in a list format. Typically, a Select button will allow
you to choose the specific desired student.

Remember that all search result pages can be paged through with the page navigation
buttons, and sorted with column headers.
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Once a record has been selected, that student record will display on the screen. From
within the displayed student record, you will see a new set of controls that allow you to
access other records from the search results.

These controls allow you to:

l View the list of students with the View Search button,
l Cancel the search altogether with the cancel Search button, or
l / Page through the list of students using the Previous and Next buttons.

Student Tab
The Student tab is only available to students (both current and former students. This tab
provides students with access to that person’s Student Record. Depending on district
settings, students may also have access to Teacher Pages for some of their courses
from this screen.
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To access the student record, click on the View Student Record button or click on the
student photo or name.

Students who have currently active classes may also have access to Teacher Pages for
some of their classes. To access the Teacher Page for a course, simply click on the
Teacher Page button for the appropriate course section (links will only show for
sections where the teacher has added notes to the Teacher Page).

Important Note: This is not the same as the “Students Tab” available to Parents. A user
will only see both the Student and the Students tabs if the parent was once a student at
the school and now has Parent Portal access for a student.

Students Tab
The Students tab is the default view for parents and district portal users. This tab is
available to users who have the Parent Portal Access flag and have an enrolled student.
It is also available for other portal users who have an active Limited Search enabled.

The Students tab will display a list of any student contacts for whom the user has
Parent Portal Access, followed by a list of Limited Search results. To access the student
record for an individual, click the View Student Record button, or click on the student's
photo or name.

Student schedules are hidden by default; click the "Show Courses" link to expand a
student's schedule. Note that the options to view courses for Current Semester or All
semesters will only be visible when at least one student's schedule has been expanded.
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Users with access to the Parent Portal icon can click on the icon to view a login
history for that student.

If a student's current schedule is available, it will display below the student's contact
information. Depending on district settings, parents may also have access to Teacher
Pages for some of their students' courses from this screen. To access the Teacher
Page for a course, simply click on the Teacher Pages button for the appropriate course
section (links will only show for sections where the teacher has added notes to the
Teacher Page).
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Students Tab: District Portal

The Students tab is the default view for parents and district portal users. This tab is
available to users who have the Parent Portal Access flag and have an enrolled student.
It is also available for other portal users who have an active Limited Search enabled.

The District Portal area provides a list of students to whom you have been given access
through a Limited Search. This list provides basic information about the students you
can access. To access a student record from within the Limited Search results, click the
Select  button for that student.

Note: This list is generally managed by your district but, depending on district settings,
you may have the ability to manage your own Limited Search results.

Depending on permissions, you may also have an option to view Student Locator
information for these students. If this is enabled, you will see a "Show Student Locator"
checkbox option at the top of the list. This option is unchecked by default; check this
option to see a column that displays each student's current location.

Filtering Limited Search Results (District Portal)

To filter the list of students in the Limited Search list, click on the Filter  icon for the
desired column(s).
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Enter the desired text in the field that appears (the rows will automatically filter as you
type). Close the filter field by pressing Enter or by clicking outside the filter field.

The Filter button will change to the Active Filter  icon to indicate when a filter is active.
To remove a filter, simply click on the Active Filter  icon and delete the text in that
field. Press Enter or click outside the filter field to update the results.

Note:  Filters will be remembered for each user and will be re-applied the next time you
access this screen.

My Home > Student Record
When you Select  a student from a list, you will see that student's Personal Information
Record, also known simply as the Student Record.

Most SchoolTool users deal with student records most often, but every individual in
SchoolTool has his/her own Person Record where all information related to that person
is stored. This document will focus on working with a Student Information Record, as
these typically contain the most detail.

The Student Record contains all information about a student. There are 2 main parts to
the Student Record: the Personal Information section and the Student Information
section. When using certain modules, additional sections may appear at the bottom of
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the record with module-specific information. This information is available based on user
permissions and the module you are using; therefore not all users will have access to
every tab in the Student Information section(s).

Use the Show/Hide buttons to collapse sections of the student's record that you do
not wish to see. This will result in less scrolling needed to view the student's record.

If you are viewing the results of a student search, you can use the following options:

1. Click the Next and Previous buttons to move forward and backward
between students in your search results.

2. Click the Cancel Search button to cancel the current search and remain on
the current student.

3. Click the Back button to return to the previous screen.

Personal Information Section
The Personal Information section at the top of the student record contains a summary
of the student’s information. This information includes the student’s name, gender, age,
primary language, and contact information. It also shows the student’s grade,
homeroom, homeroom teacher (with an email link), locker number (with an icon that
shows the locker combination in a mouse-over), counselor (with an email link),
enrollment type, building/school level, and home district (if applicable). The student
locator text in the bottom left corner of this section shows the current location of that
student, based on the student’s schedule and attendance data. If the student has any
alerts, those icons will display for users with the appropriate permissions.
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Note: The specific information available here is based on Maintenance settings; not all
users will see all fields/data.

Depending on district settings, users may be able to submit contact change requests via
the Personal Information Section. To submit a request, click on the Change Request
button at the top right of the screen.

This will open the Change Request form, where you can submit a request to change
phone numbers, email addresses, and contact rights associated with your name.
Depending on permissions, you can also edit the call order for the student.

To edit the call order, drag and drop the available phone numbers into the call order list
as desired.

Below that, you can change your own contact information. Depending on district
settings, you might also be able to submit changes for other contacts.
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Once those changes have been made, click Submit. If successfully submitted, the
screen will show a list of desired changes. You will also receive an email stating the
requesting changes have been submitted for processing.

There are several types of alerts that may be visible on a teacher's class roster and also
on individual students' Personal Information Records. In addition, the alert icons may
provide more information on the specific alert, which displays in a text box that appears
when the user holds the mouse over an alert icon.

Available alerts include the following icons and corresponding mouse-over text:

AIS Program
Service

Icon:

IEP Viewer

Icon:

Medical
Alerts

Icon:

Custom Alerts

Icon:

Send
Notification

Icon:

Mouse-over
text:

Mouse-over
Text:

Mouse-over
text:

Note: Custom
Alerts are
indicated by a
flag or other
image and
may be any
color defined
by the district.
The mouse-
over text will
display the
name of the
custom alert
as defined in

Clicking this
icon opens a
pop-up
where users
can enter a
message to
send to this
student via
direct noti-
fication in
the
SchoolTool
mobile app
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Maintenance.

Student RTI
Information

Icon:

View
Shared
District
Data

Icon:

Student
Dashboard
Viewer

Icon:

WebEdge
Student
Portfolio
Viewer

Icon:

Hovering the
mouse over
this icon will
display a list
of that
student's
active RTI
records.

Clicking
this icon
opens a
window to
display
student
data shared
by another
district.

This icon
appears
only when
districts
have
configured
data
sharing.

Clicking this
icon opens
a window to
display the
Student
View
dashboard
for that
student.

Clicking this
icon opens a
window to
display the
WebEdge
Student
Portfolio for
that student.

The visibility of these alerts is controlled by district permission settings. Users may be
able to see the alert icon only, the mouse-over text description only, both, or none of
these, depending on their user permissions. Separate permissions also control whether
users may see these icons on a teacher's Roster.

The Send Notification button appears for students who have opted to receive direct
notifications in the SchoolTool mobile app (this also requires that the district has
configured that building school level to allow direct notifications). Click the Send
Notification button and enter a title and message to send to the student, then click
Send. The message will be delivered as a notification on the student’s mobile device.
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Users with permission to view students' SchoolTool Premier dashboards may see a
SchoolTool Dashboard Viewer icon for students who have a Student ID and have ever
had an in-district enrollment. If this icon appears, users can click on the Viewer icon to
view that student's dashboard in a new window.

If shared data is available from another SchoolTool district, a View District Data icon
may appear on in the alerts area. This will allow the user to view data from another
district that has been configured for district-to-district data sharing (most likely between
a BOCES and home district). To view shared data (or shared report cards and/or
transcripts), hover over the District Data icon and Select the desired option (View
District Data, View District Report Card, or View District Transcript) from the dropdown.
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If the user has View or Edit rights, corresponding buttons will be available for each
record (either an Edit icon, for users with Edit permissions, or a Select icon, for
users with View permissions).

or

Viewing RTI Records

Users with View rights only will see Select icons for each record in the list.

Select a record to view details in read-only mode. Click the Back button to return to the
student record. Click the RTI Detail Report icon to print the RTI record and its
associated intervention details.
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Editing RTI Records

Users with Edit rights can click the Edit button for any of the RTI records listed.

Click the Edit icon for any record to open it in edit mode. Make changes as needed
and click Save to return to the student record. Please note that any number of
interventions may be edited or added, but the top section of the RTI record cannot be
changed from this screen. Click the RTI Detail Report icon to print the RTI record and
its associated intervention details.

Accounts Tab
The Accounts tab shows any existing local user accounts assigned to that individual,
the last login date and all groups to which the account has been assigned. From this tab,
users with the appropriate permission(s) may edit, delete, or unlock existing local
accounts. Users may also create new local accounts and assign those accounts to a
local user group.

Depending on permissions, users may also be able to assume the account of that
individual by clicking on the Assume Account button. When a user assumes a
person's account, all permissions and building rights will reflect those of the person
whose account is being assumed. To return to the original user account, simply log out
of SchoolTool.
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When an email address is modified for any individual, an Add button will appear to
allow the user to create a new local user account for that person. If the person already
has a local account created using a different email address, the user will need to add a
new account in order to use the updated email address for local logins.

Click on the Edit button to access the account maintenance area for that user. From
this screen, users can reset passwords, delete accounts, and/or modify group
assignments.

Users will only be able to modify group assignments that have the “Show in Home,”
“Show in Census” or “Show in Faculty” option enabled in Maintenance > User/Group >
Local Account Maintenance > Manage Groups. The group checkboxes will be disabled
for any groups that do not have this option checked.

The “Disable Current Logins” button on the Accounts tab may be used to prevent a user
from logging into SchoolTool without having to make changes to network securities.
Clicking the “Disable Current Logins” button will immediately remove all account
associations that have been made for this person. A confirmation message will appear
asking you to confirm the operation; click OK to continue. The person can be re-
associated with an account at any time from within the Maintenance module.
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If no associations exist for a person, this button will not display when editing the
Personal Information section. Any time an association is disabled, an audit entry is
created in SchoolTool.

Contacts Tab
The Contacts tab gives users immediate access to this student's parents/guardians.
Each contact associated with this student will appear on this tab.

To view the Contact Call Order for a student, click the View Call Order button at the
top of the Contacts tab.

Additional buttons appear to the right of each contact, giving you more information
about this contact and their rights/responsibilities. To see more information about the
contact, hold the mouse over each button and tool tips will appear giving more details:

l The Primary icon lets you know this contact is the primary guardian.
l The Receives Mail icon lets you know this contact will receive report cards, dis-

cipline letters, and other mailings about this student.
l The Pickup icon lets you know this contact is legally allowed to pick the stu-

dent up at school.
l The email icon lets you know this guardian may be contacted by email. Users

may be able to click the icon to send an email to that person.
l The Custody Alert icon lets you know that there is a custodial situation regard-

ing the student.
l The Parent Portal icon lets you know that this contact is allowed to see that stu-

dent in their Home > My Home > Students tab (Parent Portal). Users with the appro-
priate permissions may be able to view that contact's login history (the maximum
number of logins shown here is based on district settings).

l The Restricted View icon indicates that the person has restricted access to con-
tact information for that student. The adult is unable to see contact information
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for anyone who does not live in his/her household.

The information on this tab is view-only. If changes need to be made, this information
should be shared with anyone who maintains student and contact information.

If there is a custody alert associated with that student, the Contacts tab will show a red
circle.

Schedule Tab
The Schedule tab shows the student’s schedule for each marking period or semester in
read-only mode. This tab is typically empty for elementary students, because general
education classes and “specials” (art, music) are typically set up as supplemental
courses (courses not tied to specific periods).

Note: Depending on user permissions and settings in Maintenance, student schedules
may not be available until after a specified date. When this is the case, a message will
appear in place of the schedule to indicate that schedules are not currently available.
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Click the Print icon to print the student’s schedule. If multiple report formats are
available, you will be provided with a drop-down menu where you may select the
appropriate report format to be generated.

When viewing the Schedule tab, users typically have two (2) view options: Standard View
and Grid View. These are presented as radio buttons; select the appropriate option to
toggle the view between Standard and Grid views.

Standard View

Standard View displays the student's schedule as a read-only list of courses, ordered by
period number, along with section number, course name, days the class meets, the
room number, and the teacher are listed for each course. Supplemental courses are
listed at the top of each list.

When viewing the schedule in Standard View, any unscheduled periods are omitted.
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Grid View

Grid View displays the student's schedule in a read-only grid format. This provides a
visual representation of the student's schedule for each period across each cycle day.
Supplemental courses are shown at the bottom of each grid.

When viewing the schedule in Grid View, any unscheduled periods are omitted.

Attendance Tab
The Attendance tab shows a summary of the student's total absences for the current
year (if any). Users may change between Daily or Course attendance views by selecting
the appropriate radio button. Use the year drop-down to review historical data for a
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previous year. If the student has courses in more than one building school level,
additional drop-downs may be available to filter based on location.

The Daily Attendance option shows users all daily absences. This may also include early
dismissals, late arrivals, and in/out records.

The Course Attendance options (All, Missed Courses, and Attendance Letter) allow
users to see a summary of course attendance for that year.

l All: shows users all course absences, including those that are tied to daily
absences. Users with the appropriate permissions can choose to show or hide
period tardies using the Show Tardy checkbox.

l Missed Classes: shows users all period misses where the student was marked
absent by a teacher (this view only includes period misses for times when the stu-
dent was expected to be in class, and does not include period absences that are
tied to daily absences).
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l Attendance Letter: shows users a list of period attendance that may contribute to
attendance policy letters (the specific types of attendance entries shown is
dependent on how course attendance policy is configured).

Each view is controlled by its own permission; if you do not have permission to view a
specific option, the radio button for that option will not appear. In addition, depending on
your school's settings, newly submitted absences may not be visible immediately.

To view tallies, click on the Show Attendance Tallies button in the upper right corner
of the Course Attendance view.

A list of attendance tallies will display in a pop-up. Use the drop-down to tally by reason,
type, course, period, teacher, or date. Click the Print icon to send a printer-friendly
version of the tallies to your printer.
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Discipline Tab
The Discipline tab shows a history of discipline incidents you have entered (if any), and,
if the district uses points for discipline incidents, the student's accumulated points for
that year. Use the year drop-down to review historical data for a previous year.

Depending on user permissions and district settings, users may be able to see all
incidents for that student or only those for which a “Date Seen” has been entered.

Faculty members can also see any incident they have submitted. In addition, some
users may also be able to add, edit, or delete student incidents from the My Home >
Discipline tab.
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l Click the Add button in the upper right corner of the tab to add a new incident.
l Click the Details button to view an incident you have submitted in read-only

mode.
l Click the Edit button to edit an incident you have submitted.
l Click the Delete button to remove an incident you have submitted.

Grades Tab
The My Home > Grades tab shows grades in each class based on the selected view. The
Grade column displays the word “None” until grades have been published. To view
grades, select the appropriate view from the drop-down menu.

Available views include the following:

l Marking Period Grades
l Progress Report Grades
l Marking Period Average
l Assessment Grades
l Final Grades

Each view in the drop-down is driven by its own permission.
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Marking Period / Progress Report Grades

The Marking Period Grades and Progress Report Grades views allow users to see
marking period grades and/or progress report grades for each grading interval. For both
views, the screen will show grades for the current grading interval by default. Whenever
grades are not available, the Grade column will display “None.”

Descriptor-based course grades may be visible on the Marking Period Grades view.
Descriptor topics for each course will be listed, with any available grades, grouped
alphabetically by course name.

If the district uses skill sets for grading, each submitted skill grade will also be displayed
on the Marking Period Grades view. Where multiple skill sets are used for a course, each
skill set will be labeled and the individual skill grades will appear below the
corresponding label.

Users with the appropriate permissions also have the option to print report cards and/or
progress reports from these views. If more than one report format is available for
printing, a drop-down menu will appear and the user must select a report format to print.
Any configurable options will default to the values set in Counseling. To print, navigate
to the appropriate Marking Period or Progress Report Grades view and click the Print
icon.

The report format must be defined for each Building School Level and Grade before
users may print these reports. If these reports have not been defined, the Print icon will
not appear, regardless of the user's permissions. For more information on defining
report formats for the Grades tab, refer to the Maintenance Module documentation.

Marking Period Average

To view the current marking period averages for each course, select Marking Period
Average from the View drop-down. This view will display the current grade book average
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for each course for the selected marking period. By default, this view will display the
marking period that was selected on the Marking Period Grades view.

Assessment Grades

To view assessment grades, select the appropriate school year and select the
“Assessment Grades” option from the View drop-down. The screen will refresh to show
all assessments assigned to that student for the selected school year. Any available
grades will display in the “Score” column; for exams where scores have not yet been
entered, the word “None” will display instead.

If a student has received an assessment note for any assessment, the short code of the
note may display instead of the score, depending on yearly configuration options.

Final Grades

To view final course grades, select the appropriate school year and select the “Final
Grades” option from the View drop-down. This view will display the final grade for all
courses for which grades have been submitted. This view is year-specific and is not
limited to a specific marking period or progress interval.



Teacher User Guide Page 267 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

If grades are not available for any course, the Grade column will display “None” for that
course.

Assessments Tab
The Assessments tab displays a student's 3-8 Assessment scores and any User Defined
Assessment records for users with the appropriate permissions. To change the view,
select the appropriate radio button (if radio buttons do not appear, this means the user
has permission to see only one type of record on this tab).

The 3-8 Testing view shows a student’s 3-8 Assessment scores. This view is typically
available only for elementary students. You may print the student’s 3-8 Assessments
from within this tab by using the Print button in the top right of the tab.

Use the radio buttons to view either 3-8 Testing data (the default view) or User Defined
Assessment records.
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To view user defined assessment records, select the appropriate radio button and use
the drop-down to specify the type of user defined assessments to view. All records for
the selected user defined assessment will be shown on the screen.

To add a new user defined assessment record, click the Add button and complete the
fields as appropriate. Use the Edit or Delete buttons to modify or remove records as
necessary.

Note: When adding a user defined assessment, the school year is a required field.

Assignments Tab
The Assignments tab displays all assignments tied to the selected marking period in
any grade book that exists for the selected school year and course. By default, the
Assignments tab shows a list of all courses.

Click on the Show Average button to see a list of all course averages for that marking
period.
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Any assignment descriptions entered by the teacher will display on the second line in
the list of assignments.

For any assignment with an attribute associated with it, the Student Score column will
display the score, if any, as well as the short code for any attributes applied to that
assignment and the adjusted score (if appropriate). Multiple attributes are separated by
a comma.

Scores, attributes, and adjustments are displayed as follows:

Score (Adjusted Score) [Attribute Short Code]

For example, a student originally received an 82 on an assignment, but the teacher
applied an “EC” attribute to that assignment to designate Extra Credit of 10%. The
student's score now shows 82 (90.2) [EC] to indicate the adjustment.
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Users can move their mouse over any attribute in the Student Score column. The
mouse-over text will show the user the full name of the attribute and any adjustment
defined for that attribute. For example, holding the mouse over the “2L” attribute may
display “2+ days late: -15%” to indicate that the score has been adjusted by -15% based
on the application of that attribute.

If the teacher has shared any assignment notes, a Notes column will display for users
who have permission to view assignment notes.

Attachments are indicated by an icon in the Assignment Name column. To view an
attachment, click the Attachment icon and download the file.

When viewing assignments for a specific course, the marking period average will be
displayed next to the course drop down.

Click the Show Category Average button to view the category break down for the
course for the selected marking period.
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Letters Tab
On the Letters tab of a Student Record, users will see the student's Attendance Letter
history. The list is read-only unless the user has permission to delete letters or mark
them as ignored, and may be sorted by any column. Users may view other years'
Attendance Letters by using the drop-down menu.

Users with the appropriate permission may delete any letter from the Letters tab. If this
permission is enabled, a Delete button will appear next to each letter in the list.

The Attendance Letters history shows the following information:

l Type: Displays the policy type that was used for that letter (this is determined
based on the Attendance Policy settings in Maintenance). The values shown here
may be Daily, Course, or Tardy, depending on the type of policy.

l Threshold Name: The name of the Attendance Policy stage that was used to gen-
erate this letter.

l Threshold: Shows the number of misses used for that particular Attendance Policy
threshold.

l As Of: Reflects the date entered by the user when running the Attendance Letters
search

l Created On: Displays the date on which the user actually generated that letter
l Detail: Provides details about the course for which the letter was run. The details,

which are separated by commas, are Course ID, Course Name, and Section Num-
ber (SN), respectively.

l Ignore: When checked, a letter will be marked as “ignored” and SchoolTool will
behave as though the letter was never sent. When a letter is ignored, the comment
entered by the user as the reason for ignoring the letter will be displayed in a
second row.
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Details will only display when the policy Type is Course; if the Type is Daily or Tardy, the
Details field will be blank.

Users with the appropriate permissions may mark a student's attendance letter as
“ignored.” When a letter is marked as “ignored,” SchoolTool will keep the historical
record to indicate that the letter was sent. However, when determining which students
need attendance letters, SchoolTool will behave as though that particular letter was
never sent.

To ignore an attendance letter, click the Ignore checkbox on the right side of the screen
for the letter you wish to ignore.

In the pop-up window that appears, enter a brief comment to indicate a reason for
ignoring the letter and click OK to continue.

When a letter is marked as “ignored,” the letter will display on the student's Letters tab in
gray text. To remove the “ignore” status, simply uncheck the Ignore checkbox (this will
also remove the comment).
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User Defined Tab
The User Defined tab is available on the Person Record for students, residents, or
faculty. This tab displays any active user defined screens created in Maintenance.
These screens are created and configured by the district and may contain any number
of custom fields and field types. Select a user defined screen from the drop-down menu
to view a list of all active records for that screen.

If the individual has data entered for any user defined screen, this information will
appear in read-only mode on this tab. Click Show History to show all records for that
screen, including inactive records. Users can also click the Print button to generate a
report of that person's user defined screens.

Users with Edit permission may add, modify, or remove records. To modify an existing
record, click the Edit button and modify as needed. Click the Delete button to
permanently remove a record.

To add a new record, select the screen from the drop-down menu and click the Add
button. A new record will open in edit mode. All required fields are highlighted in pink.
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Enter information in each field as appropriate and Save the record when finished.
Field types are indicated for all fields except drop-downs, and may include any of the
following field types:

l Drop-down List
l Text
l Real (real numbers; can include decimal points)
l Integer (whole numbers only)
l Date
l Checkbox (Yes/No)

Active fields, field types, drop-down content, and maximum field lengths are specified in
Maintenance for each user defined screen. Refer to the Maintenance Module
documentation for detailed information on configuring a user defined screen.

All records must have a Start Date, which is used to indicate the date the record became
active. If an End Date is entered, that indicates the date that record expires. Once the
End Date has passed, the record will become inactive and will be visible when a user
clicks “Show History.”

Hours Tab
The Hours tab allows users to track hours for various student activities. This includes
Work-Based Learning hours and CTE Hours.
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This tab also allows users to manage the master list of categories and/or locations that
are available to any student in SchoolTool.

Adding Hours
To add hours for a student, begin by clicking the Add Category/Location button above
the appropriate Hours grid.

In the pop-up that appears, begin by entering text to search for an existing category. A
list of possible matches will appear as you type.

If a matching category is found, click the Use button to select it.

If no match is found, you can create a new one by clicking on the Add New Category
button. Note that creating a new category from this area will add a category to the
master Categories list that will be available for any student.
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After selecting a category, you can specify a location or simply click Continue if you
don't wish to assign a location.

To search for an existing location, simply begin typing in the Location field. As with
Categories, click the Use button to select a location or click Add New Location to add a
new one (again, adding a location from here will make that location available for any
student).

After selecting a category (and a location, if desired), click the Continue button.
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You will be directed to the Hours Entry screen. If you selected a category/location
combination that is already in use for this student, you will see the existing information
associated with that category/location.

In the Hours Entry pop-up, you may enter notes for that category which may be
displayed on certain reports (Employability Profile reports, CDOS reports, and some
transcripts). Category notes are specific to that student for the selected
category/location combination, and will not be shared with other students using that
category, nor will they be shared with other categories or locations on that student's
record. You may also change the category or location by clicking the Edit
Category/Location button near the top of the screen.
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Note: If you select a category/location combination that already exists for that student,
you will be taken to that category/location hours screen instead. Any existing hours for
the original category/location will remain on the student’s Hours tab and will not be
modified.

Click the Add Hours button to begin entering hours for this category. Fill in the fields
in the row that appears. The Notes field for each row of hours is for informational
purposes only and will not be displayed on reports.

After entering all appropriate information, click the Save button to return to the
student's Hours tab.

Once a category has been added to the student's Hours tab, you may use the Show/Hide
buttons to expand rows, click the Edit button to add/edit category/location details

and hours, or Delete the row (you will not see a Delete button if the row has hours
associated with it; you must first delete all hour entries if you wish to remove a
category/location).

Managing Categories
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Click on the Edit Categories button to view a list of all existing categories.

A pop-up will appear, displaying all categories.

Click Add to create a new category. You will be prompted to select an hours
Type (current options are Work-Based Learning or Community Service) and
enter a Category Name.

Click the Delete button to delete a category. Note that categories can only be
deleted if they are not tied to any students.

To modify a category, click the Edit button and make the necessary changes.
Keep in mind that changes to a category will impact any other students who are
already associated with that location.

Managing Locations

Click on the Edit Locations button to view a list of all existing locations.
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A pop-up will appear, displaying all locations. Click Add to create a new
location.

If a location is in use, you may click on the Show Students button to view a
list of all students associated with this location. Locations can only be deleted
if they are not tied to any student.

To modify details for a location, click the Edit button and make the necessary
changes. Keep in mind that changes to a location in this area will impact any
other students who are already associated with that location.
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CTE Hours
To enter CTE Hours, begin by clicking the Add Course button to select a CTE course.

A pop-up will appear with a drop-down list of all courses on that student's schedule that
are designated as CTE courses. Select the appropriate course and click the Add button.

The course will be added to the student's Hours tab. You may use the Show/Hide
buttons to expand rows, click the Edit button to add/edit hours, or Delete a course if
it does not have hours associated with it (you may not delete a row that has hours
associated with it; you must first delete all hour entries if you wish to remove a course).
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To add CTE course notes and view or edit hours, click the Edit button for the
appropriate row.

In the Hours Entry pop-up, you may enter notes for that course which may be displayed
on certain reports (Employability Profile reports, CDOS reports, and some transcripts).
These notes are specific to that student for the selected course, and will not be shared
with other students in that course, nor will they be shared with other courses on that
student's record.

Click the Add Hours button to begin entering hours for this course. Fill in the fields in
the row that appears. The Notes field for each row of hours is for informational
purposes only and will not be displayed on reports.
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After entering all appropriate information, click the Save button to return to the
student's Hours tab.

Managing Categories and Locations

Users with appropriate permissions will see Edit Categories and Edit Locations buttons
on the Hours tab. Clicking on these buttons allows a user to manage the categories
and/or locations that are available to any student in SchoolTool. Note that categories
and locations that are currently associated with students' hours cannot be deleted.

Editing Categories
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Click on the Edit Categories button to view a list of all existing categories.

A pop-up will appear, displaying all categories.

Click Add to create a new category. You will be prompted to select an hours
Type (current options are Work-Based Learning or Community Service) and
enter a Category Name.

Click the Delete button to delete a category. Note that categories can only be
deleted if they are not tied to any students.

To modify a category, click the Edit button and make the necessary changes.
Keep in mind that changes to a category will impact any other students who are
already associated with that location.

Editing Locations

Click on the Edit Locations button to view a list of all existing locations.
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A pop-up will appear, displaying all locations. Click Add to create a new
location.

If a location is in use, you may click on the Show Students button to view a
list of all students associated with this location. Locations can only be deleted
if they are not tied to any student.

To modify details for a location, click the Edit button and make the necessary
changes. Keep in mind that changes to a location in this area will impact any
other students who are already associated with that location.
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Notes Tab
Each person record contains a Notes tab where you can add other information about
this person. For a student, you might add notes about club participation or record
meetings with parents. This is also where Orders of Protection are added. Be careful
about the confidentiality of the information you add, as some notes can be seen by all
users.

Printing Student Notes

Users may print a report of all Student Notes listed on the Notes tab by clicking the Print
icon in the upper left corner of the Notes area. The report will include all notes that are

visible to that user, and will display the note type, the dates the note was created and/or
modified, the note text, and will indicate whether or not the note has any attachments.

If the user has permission to view Orders of Protection, the report will also include these
notes. The report will include all Effective dates and Expiration dates indicated on the
Order of Protection note.

General Notes

1. Click once on the green Add Note button.
2. Select a Note type. There are four (4) types of General Notes:

A. Global – which, when saved, are available to all SchoolTool users.
B. Building Only, Not Passed with Promotion – which become a part of

the student's record only until he/she advances to the next building,
and then they are visible only to users whose building rights include
the building where the note was originally added.
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C. Building Only, Passed with Promotion – which, when saved, become a
part of the student's record and remain as he/she advances to the
next building.

D. Personal – which are only available to the user that entered the note.
3. Enter the note content in the free-text area. This field will accept up to 1,000

characters.

4. Add any supporting documents by clicking once on the Browse button and loc-
ating a file on the hard drive. Files may be any format (Word documents,
spreadsheets, HTML, emails, etc), and there is no limit to the number of attach-
ments which may be included. Once a file is located, it must be uploaded to
SchoolTool in order for it to be saved with this note.

5. Once the Note is saved, the tab will refresh showing the notes in read-only
mode.

6. The Notes tab title will display a green circle to indicate that “new” notes exist
on that student's record. Notes are considered new for a specified number of
days after they have been created or modified, as defined by the district.

The Notes tab title will display a red circle when an active Order of Protection
note exists, regardless of whether or not new notes exist.

7. Use the Delete and Edit buttons to remove or make changes to existing
notes.

Orders of Protection

1. Select Order of Protection from the drop-down list at the right of the tab.
2. Click once on the green Add Note button. An Order of Protection record will

appear.
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3. Complete the Order of Protection:
A. Type a free-text description (required) of the order in the box under

the word Type.
B. Enter an Effective Date (required). Type the date manually in the

mm/dd/yyyy format, or use the pop-up calendar.
C. Enter an Expiration Date (if any). Type the date manually in the mm/d-

d/yyyy format, or use the pop-up calendar.
D. Attach any digital supporting documents by using the Browse and

Upload Attachment buttons.
4. Click once on the green Save button to the left of the description comments

box.

Once the Order of Protection has been saved, the Notes tab will display a red circle,
alerting users that there is an Order of Protection for this student.

Orders of Protection can be Edited and Deleted as necessary.

The Created By and Modified By audit tracking will update as users add and update this
information.

Printing Student Notes

Users may print a report of all Student Notes listed on the Notes tab by clicking the Print
icon in the upper left corner of the Notes area. The report will include all notes that are

visible to that user, and will display the note type, the dates the note was created and/or
modified, the note text, and will indicate whether or not the note has any attachments.
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If the user has permission to view Orders of Protection, the report will also include these
notes. The report will include all Effective dates and Expiration dates indicated on the
Order of Protection note.

Using Dashboards
SchoolTool dashboards provide users with an alternate way to view data and analyze
trends. Each dashboard includes a unique selection of data and corresponding
presentation tools such as graphs, charts, and tables that can be manipulated in a
variety of ways. Once familiar with the following key elements and features, users
should be able to quickly navigate through any dashboard and easily obtain the desired
information.

Using Filters

Each dashboard contains a filter section at the top of the screen. Default filters are
dependent on the data presented by each individual dashboard, but function identically
across all dashboards.

To apply filters, select the appropriate criteria and click the Update Page Data button to
refresh the page.

To filter on additional fields, click the Manage Custom Filters button. Refer to the
Customizing Filters section below for details.

To revert to the default filter fields and values for the current filter configuration, click
the Reset Filters button. If you are using a saved filter configuration, this button will
reset the fields and values for that configuration.

To save changes to your filter configuration, click the Save Filter Configuration button.
If you are using a saved filter configuration, this will update that configuration using the
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selected fields and values. If no saved filter configurations have been defined, you will
be prompted to enter a name for the new configuration prior to saving.

Customizing Filters

In addition to the basic filters that are pre-defined for each dashboard, users can select
additional filter criteria from an extensive list of fields.

To add fields, click the Manage Custom Filters button in the lower right portion of the
Filters section. The Add Filter Field dialog box will open, which contains a list of all fields
available for that dashboard.

Select one or more fields to add by clicking the field name and click the Update Filters
button to add those fields. A message will appear while the filter is loaded.

Once the “Loading” indicator disappears, repeat the above steps to add other fields or
click the Done button to return to the dashboard. Any user-defined filter fields will be
available and will have blue-shaded title bars. To remove a user-defined field, simply
click the Remove  button for that field.
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Saving Filters

Filter configurations can be saved on a per-user basis and can be loaded on any
dashboard. To save filters, simply select the desired filter fields and criteria and click the
Save Filter Configuration button.

Note:  If you are using a saved filter configuration, this will update that configuration
using the selected fields. If no saved filter configurations have been defined, you will be
prompted to enter a name for the new configuration prior to saving.

Click OK in the message box that appears to confirm this action and save the filter
configuration. Once this has been saved, that dashboard will retain the filter
configuration any time the user loads that dashboard.

Using the Filters Menu

Users can save any number of filter configurations for later use. These filters are
available on a per-user basis and can be loaded on any dashboard to which that user
has access. To save a filter configuration, click the Filters menu and select an operation:

l Reset: Clicking this option will reset the filter fields and values to the selected con-
figuration (or the system default, if no saved configuration is currently selected).

l Save: Clicking this option will update the currently selected filter configuration. If
no saved filter configurations have been defined, you will be prompted to enter a
name for the new configuration prior to saving.

l Save As…: Clicking this option will allow you to save a new filter configuration
based on the fields currently selected. You will be prompted to enter a con-
figuration name prior to saving.

l Load Existing:  Clicking this option will allow you to load any saved filter con-
figuration for that dashboard, including the system default. A small blue circle will
indicate the currently active configuration. To delete a filter configuration, use the
“Load existing” option and click the Delete icon next to the configuration to be
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removed.

Hiding/Expanding Sections

Each section of a dashboard can be hidden or expanded as needed to accommodate
real estate on the screen.

l Click the Hide  button to minimize a visible section.
l Click the Expand  button to expand a hidden section.

If a section has no data available for the selected filters, the section will be minimized by
default.

Working With Charts

Dashboards contain a number of interactive charts, including bar graphs, line graphs, pie
charts, or tables. Each of these charts functions differently depending on the
information presented. In general, most charts allow users to adjust the chart type and
color palette, adjust the chart breakdown, export, and view additional information about
specific data points. All interactive charts contain two (2) tabs:  a Data tab (shown by
default) and a Configuration tab.
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Data Tab

The Data tab is the main chart presentation area, and by default includes data matching
the selected filter criteria. Hovering the mouse over any data point will display additional
information about that point.

Mouseovers will display the series to which the data belongs, as well as the X and Y axis
information (in the example above, on the left, the series is 2009-2010, the X value or
“Month” is Jan, and the Y value or “Count” is 2479).

To view additional details about a data point or range of data, click on the point or
section of the graph. Details about the selection will display below the graph.
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When working with pie charts, the selected piece will separate from the rest of the pie to
indicate the selection.

Users can use the Drill Down button to view additional details about the data. Refer to
the section on Using the Drill Down Feature for details on this feature.

Note: The ability to drill down in a dashboard is controlled by a security option; when
this option is disabled, the Drill Down button will not be available.

Some charts also include options that allow the user to select different criteria or
change the way in which data is broken down in the chart. These breakdown or range
options are usually provided as one or more drop-down menus above the chart. These
menus may contain additional breakdown fields, depending on the filter fields that the
user has added to the dashboard.
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On the Attendance and Discipline dashboards, users with permissions to drill down will
see an additional break down field that allows them to view data per student across a
given school year. When breaking down by Student Name on the Attendance dashboard,
viewing data in a yearly format (either by selecting a single year or by grouping by
school year) will provide a “Top __ absence counts” field to allow users to limit data to a
sub-set of students with the most absence counts (a corresponding break down option
exists for late arrivals and early dismissals as well).

For example, entering 5 in this field will return students with the 5 highest absence
counts (counts may include multiple students, so the number of students returned may
be higher than the value entered in this field).

This functionality is paralleled when breaking down on Offender on the Discipline
dashboard.



Teacher User Guide Page 296 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

Certain charts (on the Assessments and Course Scores dashboards, for example) may
display information about scores such as the average score for all data and for the
selected series.  Hover the mouse over the line indicating the Average Score to view the
numeric value (on the Comparative dashboard, you must first check the box to Enable
mouse-over information.

To view or hide additional statistics information (including median and standard
deviation range), click the Show additional statistics checkbox at the top of the chart.
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Configuration Tab

Users also have the ability to change the way any chart is presented by using the
Configuration tab. Currently users are able to change the color palette of any chart or
the chart type (available chart types depend on the type of data presented by the chart).
Simply use the drop-downs to select the change(s) and click the Update button to
refresh the chart with the selected preferences.

Exporting Charts

Dashboards also allow users to export an image of the chart data into a variety of
formats. To export, right click in the graph or chart to be exported and select the desired
format from the drop-down menu. Select whether or not to show the Filter Label and
click the Export button.

Export options include the following file formats:

l Adobe (.pdf)
l Excel (.xls)
l Image (.jpg, .bmp, .png, .gif, or .tif)
l Text (.txt)
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l Rich Text (.rtf)
l Web Archive (.mht)

Comparative Dashboard
The Comparative dashboard allows users to compare two sets of data by choosing the
sets of information they wish to see on the X and Y axes.

To begin, use the filters in the upper section of the screen to specify any appropriate
criteria to filter the students you wish to include.

Next, select the appropriate options for the X and Y axes to specify which data you want
to compare. Choices include 3-8 Assessments, Assessments, Course Scores, and User
Defined Assessments. Depending on which option you select, additional drop-downs
may appear to allow you to specify further. Once you have made all necessary
selections, the chart below will update to reflect your choices.

The chart will update, allowing you to compare data between the selected elements. A
variety of breakdown options will be available for both axes.

Use the X and Y range fields to view details on data points within a specific range based
on the X or Y axis. This allows users to narrow down the range they are viewing to a
sample set of students and compare specific data points within that set of values.  Drill-
down functionality will respect the selected range and will only include students whose
data is visible on the chart.

To view additional information about the data, use the checkboxes above the chart to
Enable mouse-over information for data points or Enable statistical trendline to view
the trendline based on the actual data shown by the chart.
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Because of the nature of the comparison chart presentation, users have access to an
additional Trend Mode drill-down option. Trend mode allows users to view a list of
students whose data points fall outside a specified proximity to the trendline. This
allows users to obtain a list of “outliers” that are not within a given distance above or
below the trendline.

Specify the selection set (points above the trendline, below the trendline, or both above
and below), then specify either a threshold (number of points or a percent) to indicate
the distance from the trendline that you wish to examine. For example, choosing a
threshold of 10 points will show students whose data points are 11 or more points away
from the trendline.

Course Attendance Dashboard
The Course Attendance dashboard provides users with a way to analyze period
attendance for a group of students. By default, this dashboard displays a single
"Absence by Period" chart showing course absences for the current school year.

For example, you might:

l Show High School data in both charts, but break down by grade in the first chart
and break down by course department in the second.
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l Set up the first chart to show data broken down by Course Department and use the
second chart to show data for only a single department, broken down by course
name.

l Use the first chart to show High School data and the second chart to show Middle
School data.

Depending on your permissions, you might also have the ability to add an additional
chart to the Course Attendance dashboard. See the section on Available Charts, below,
for more information about the charts that can be added.

Dashboard Basics

Customizing your Chart

Charts on the Course Attendance dashboard are customizable, providing you
with flexibility in terms of the data you wish to analyze and the presentation of
that data. To change the data used by the chart, as well as the way it is broken
down, you can update filters and/or breakdowns. To change the way the data is
presented on that chart, you can change the chart type and the color palette.
These customizations can be saved for both charts in a single operation. To
update the filters and configuration, click the Edit button.

Updating Filters and Breakdowns

The Edit panel will appear in a popup, displaying the current filter
selections and chart configuration. Modify these as needed, keeping in
mind that the School Year, Building School Level, Grade, Gender,
Ethnicity, Course Department, and Course Name filters utilize the
"smart filter" functionality and will limit the choices in subsequent
filters based on the data that is available for the selected filter options.
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Depending on permissions, some users may also have access to a
Period Modality filter when using the Absence by Period and Absence
by Course charts on the Course Attendance Dashboard. Options for
this filter include In Person and Remote and will reflect students’ period
modalities based on the Remote checkbox values selected when
submitting course attendance.

Chart data can be broken down by any field except Period. Simply drag
and drop the desired field heading into the Breakdown By box to
change the breakdown selection. The selection changes will show
when Preview or Apply are selected.

Changing Chart Configuration

The Configuration tab, also available by clicking the Edit button on a
chart, displays your chart's color palette and chart type options. These
control the style of the charts and can be modified to best suit the
presentation of your data.
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Previewing Chart Changes

At any time, you may click the Preview button to see a preview of the
chart using the new selections prior to applying them.

If your filter and breakdown choices result in a chart that has more
data than can be displayed, a warning will appear. To resolve the issue,
adjust your filter selections to reduce the amount of data and/or
change the Breakdown By field to use a different field.

Applying Chart Changes

After selecting the appropriate filters and configurations, you may click
Apply in the upper right corner of the screen to apply the changes
and immediately return to the chart. Click the Cancel button to
return to the chart without applying your changes. If you wish to reset
your filters to the default, click the Reset button in the upper left
corner.
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After applying filters and configurations, you will be returned to the
main screen.

Saving Configuration

Users can save the selected filter selections, break down options, and chart
type/colors after applying changes by clicking on the Save button on the
Course Attendance dashboard banner. The next time the user logs in, the
Course Attendance dashboard will load the saved configuration choices by
default.

Note: Changes to both charts will be saved at the same time.

Adding a Second Chart

By default, the Course Attendance dashboard shows a single chart (in the
screenshot below, the first chart has been customized for illustrative purposes).
Users with the appropriate permission can add a second chart in order to
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perform side-by-side comparisons or present multiple sets of data within a
single dashboard.

Click the Add button in the upper right corner of the screen to add a second
chart.

From the menu that appears, select the type of chart you wish to add. Current
chart options include:

l Course Attendance – Absence by Course: This chart allows you to ana-
lyze course attendance based on the course name for a group of stu-
dents.

l Course Attendance – Absence by Period: This chart allows you to analyze
period attendance for a group of students.

l Early Warning – Absenteeism: This chart allows you to analyze daily
attendance for a group of students using the NYS definition of Absent-
eeism (Not at Risk, At Risk, or Chronically Absent).

Refer to the section on Available Charts for additional information about these
charts.
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After selecting one of the chart options, the new chart will be added to the
dashboard using that chart’s default settings.

As with existing charts, users can click the Edit button to modify filter and
breakdown choices as well as chart type and color palettes for that chart.

Once applied, these changes will be visible for the duration of the user’s session
and can be saved for future use by clicking on the Save button on the
Course Attendance dashboard banner.
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To remove the second chart, simply click the Delete Chart button in the upper
right corner of the chart.

Working with Charts

By default, charts will display details about the selected filters below the chart title.

To hide this information, click the up arrow to collapse the filter details.

To view absence counts for a specific data point on the Absence by Period or Absence
by Course charts, hover over the bar for that period/course.
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Users with appropriate permissions will be able to drill down on the chart data. To drill
down on all data in the chart, right click on the chart and select Drill Down All. A single
bar on the graph can be drilled down by hovering over the bar and clicking Drill Down
Selected Point (or Drill Down Selected Series, when clicking on a specific series in a
chart legend that includes multiple series).

A Drill Down tab will open up, showing the selected data. To sort in ascending or
descending order, click on the category name at the top of the chart. Users can also see
the filters applied to the drill down by clicking on the arrow to the right of the chart title.

To export chart data to a .csv file, click Export.

Additional Information

Multiple drill downs can be open at a time and will appear as tabs at the top of
the chart. Please note only 10 drill down charts can be open at a time.

If you go back to apply different filters to the chart, the drill downs are still
available for the previous filters. A message will appear above the drill downs,
alerting that the drill down no longer matches the shown chart.

Please note that charts with records between 100,000 and 500,000 may take
extra time to export. Charts with more than 500,000 records will not be able to
export.

Available Charts

Course Attendance - Absence by Period Chart
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The Absence by Period chart shows the number of absences that occurred in
each period.

Notes:

l The Absence by Period chart does not include Supplementals (courses
not assigned to a period).

l This chart also excludes period misses that are due to suspensions (ISS
or OSS).

l Period misses that are due to daily absences are included here, and the
Absence Reason filter includes all appropriate Daily and Period absence
reasons.

Course Attendance - Absence by Course Chart

This chart is similar to the Absence by Period chart but it allows users to
analyze course attendance based on the course name, rather than the period.
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Keep in mind that courses are labeled with the Course Name followed by
Course ID, but only the first 20 characters will be displayed (the full Course
Name and ID will be visible when a user hovers over a data point). Also note
that, by default, the chart shows all courses for the current school year.

Users can slide the chart area left to right to scroll horizontally; as with other
charts, users can also use a mouse-wheel or “pinch to zoom” functionality to
zoom in or out. To reduce the number of courses shown, simply click the Edit
button and use the filter panel to choose the desired criteria.

Notes:

l As with the Absence by Period chart, the Absence by Course chart does
not include Supplementals (courses not assigned to a period).

l Multiple instances of the same course: If a student is scheduled for mul-
tiple sections of the same course, each section has its own absences and
will be counted independently. For example, a student enrolled in Phys Ed
Section 1 and Section 2 can be absent in either section or both. If the stu-
dent is absent from both sections, two separate absences will be recor-
ded for that course.

l Courses that meet in multiple periods: When a course section meets mul-
tiple times during the same day, SchoolTool only saves the last recorded
attendance submission; therefore, a maximum of one absence will be
counted for that course for a given day. For example, a student might
have a schedule where Chemistry meets during 1st period and again dur-
ing 4th period.

l If the student is marked present in 1st period but later marked
absent in 4th period, the present will be overwritten when the
absence is recorded later in the day, and thus would be counted as a
single absence.
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l If the student is marked absent in 1st period but present in 4th
period, the absence will be overwritten by the present and will there-
fore not be included at all.

l If the student is marked absent in both periods, this will count as a
single absence.

l Sections with multiple teachers: When breaking down by the Course
Teacher field, course absences may be counted multiple times for course
sections taught by multiple teachers. The chart will display a separate
data point for each individual teacher, and course absences will be dis-
played for each teacher. The drill down results will continue to display
each course absence only once, and the Course Teacher column will dis-
play all teachers for a given section, separated by a “/” character.

For example, let’s say Section 1 of English 11R is co-taught by Mr. Knox
and Mrs. Copeland. When breaking down by Course Teacher, you’ll see a
bar for Mr. Knox and another for Mrs. Copeland, and the totals for each
teacher will include student absences from their co-taught sections as
well as any sections that are taught individually.

When viewing the drill down results, users will see the both teachers
(“Copeland/Knox”) for that course section when hovering over the Course
Teacher column.
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Early Warning - Absenteeism Chart

This chart allows users to identify students within a selected student
population (based on primary enrollments only) using the NYS definition of
Absenteeism:

l Chronically Absent (10% or More)
l At Risk (5 – 9 %)
l Not at Risk (Less than 5%)

These ranges are calculated as a percentage of days the student was absent
out of the total number of days the student was enrolled for that school year.
Note that these values are based on number of enrollment days for a student
per school year, regardless of the actual enrollment location. For example, a
student who changes grades mid-year or a student who moves from one
program to another within the same district will be calculated using the total
enrollment days across all enrollments.

Once each student’s percentage has been calculated, those numbers are
rounded to the nearest tenth and placed in one of three pre-defined absence
ranges based on whole numbers (Not at Risk: Less than 5%, At Risk: 5 – 9 %,
Chronically Absent: 10% or More).

For example:

l A student percentage of 9.85 rounds to 9.9 and will be placed in the “5 to
9%” range

l A student percentage of 9.95 rounds to 10.0 and will be placed in the
“10% or More” range
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A student’s absence is counted toward these totals if both of the following are
true:

l The student is enrolled for 10 or more instructional days and attended at
least 1 day during that period (instructional days do not include calendar
days where “Students Off” is checked)

l The absentee reason is configured with the “Count as Absence/In/Out”
flag checked.

Note: Students are not included in these calculations if the number of Absent
Days is equal to Enrollment Days

Examples

Scenario #1: Analyzing Period Attendance by Grade, then Department

Let’s say we want to analyze period attendance in the High School by grade
and, once we’ve identified the grade level with the highest number of absences,
we want to see which departments have the most absences.

We’ll begin by clicking on the Edit button in the first chart in order to customize
it.
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We'll edit the filters to show 2018-2019 period attendance for the High School
and change the breakdown to grade. We'll also use the Config tab to change the
colors and choose a line chart. After clicking Apply, we'll return to the updated
version of our chart.

As you can see, our 12th graders (represented by the blue line in the image
below) have a higher overall level of absences.

Next we might want to focus on just the 12th graders and analyze the data for
them based on course department. To do that, we’ll begin by adding a second
chart.
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We’ll click the Edit button on the second chart to update the filters and
breakdown. In this example, we’re setting filters to include 2018-2019, High
School, Grade 12. We’re also changing the breakdown to Course Department
(by dragging the filter heading over to the Breakdown By area) and using the
Config tab to change the chart type to a line chart. Once we have the filter and
breakdown settings configured, we click the Apply button to return to the
charts.

Our second chart now shows a line for each department. Based on this chart,
we can see that our 12th graders are missing Study Hall most often, but in
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period 1 we also have a large number of absences in Social Studies as
compared to other departments.

Scenario #2: Comparing Absences by Course, then by Teacher

Let’s say we want to use the Absence by Course chart to identify the course(s)
with the largest number of absences, and then compare the absence counts for
those specific courses by teacher.

To begin, we’ll add the Absence by Course chart and edit the filters to show all
of our English courses in the High school. In our example, we see that English
10R has the highest number of absences.
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Next we might want to change our filters to look at only the English 10R course,
but this time we’ll change the Breakdown option to the Course Teacher field to
get an idea of how each teacher’s totals compare to the others. Here we see
that Mr. Morse and Mr. Hardy have the two highest absent counts across this
course.

From here we could further narrow down data, or we could use the Drill Down
feature to obtain a results list that we could export and use to perform
additional analysis.
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Early Warning Dashboard
The Early Warning dashboard provides users with a means of analyzing attendance
trends for a group of students. By default, this dashboard displays a single
"Absenteeism" chart which shows students in three different groups based on the NYS
definition of Absenteeism:

l Chronically Absent (10% or More)
l At Risk (5 – 9 %)
l Not at Risk (Less than 5%)

Refer to the section on Absenteeism Chart, below, for additional details on this chart.

Depending on your permissions, you might also have the ability to add an additional
chart to the Early Warning dashboard. See the section on Available Charts, below, for
more information about the charts that can be added.

Dashboard Basics

Customizing your Chart
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Charts on the Early Warning dashboard are customizable, providing you with
flexibility in terms of the data you wish to analyze and the presentation of that
data. To change the data used by the chart you can update filters; to change the
way the data is presented on that chart, you can change the chart type and the
color palette. To update filters and configuration, click the Edit button at the
top of the chart.

Updating Filters and Breakdowns

The Edit panel will appear in a popup, displaying the current filter
selections and chart configuration. Modify these as needed, keeping in
mind that the School Year, Building School Level, Grade, Gender, and
Ethnicity filters utilize the "smart filter" functionality and will limit the
choices in subsequent filters based on the data that is available for the
selected filter options.

Depending on permissions, some users may also have access to a
Currently Enrolled filter when using the Absenteeism chart on the Early
Warning Dashboard. Options for this filter include “Enrolled” and “Not
Enrolled,” and will reflect students’ current enrollment status. Students
are considered “currently enrolled” when they have a current enrollment
or an end date that is after the date of the most recent SchoolTool
Dashboards import.



Teacher User Guide Page 319 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

Chart data can be broken down by any filter field. Simply drag and drop
the desired field heading into the Breakdown By box to change the
breakdown selection. The selection changes will show when Preview
or Apply are selected.

Changing Chart Configuration

The Configuration tab, also available by clicking the Edit button on a
chart, displays your chart's color palette and chart type options. These
control the style of the charts and can be modified to best suit the
presentation of your data.

Previewing Chart Changes
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At any time, you may click the Preview button to see a preview of the
chart using the new selections prior to applying them.

If your filter and breakdown choices result in a chart that has more
data than can be displayed, a warning will appear. To resolve the issue,
adjust your filter selections to reduce the amount of data and/or
change the Breakdown By field to use a different field.

Applying Chart Changes
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After selecting the appropriate filters and configurations, you may click
Apply in the upper right corner of the screen to apply the changes
and immediately return to the chart. Click the Cancel button to
return to the chart without applying your changes. If you wish to reset
your filters to the default, click the Reset button in the upper left
corner.

After applying filters and configurations, you will be returned to the
main screen.

Saving Configuration

Users can save the selected filter selections, break down options, and chart
type/colors after applying changes by clicking on the Save button on the
Early Warning dashboard banner. The next time the user logs in, the Early
Warning dashboard will load the saved configuration choices by default.

Note: Changes to both charts will be saved at the same time.
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Adding a Second Chart

By default, the Early Warning dashboard shows a single chart (in the screenshot
below, the first chart has been customized for illustrative purposes). Users with
the appropriate permission can add a second chart to this dashboard in order
to perform side-by-side comparisons or present multiple sets of data within a
single dashboard.

Click the Add button in the upper right corner of the screen to add a second
chart.

From the menu that appears, select the type of chart you wish to add. Current
chart options include:

l Course Attendance – Absence by Course: This chart allows you to ana-
lyze course attendance based on the course name for a group of stu-
dents.

l Course Attendance – Absence by Period: This chart allows you to analyze
course attendance based on period for a group of students.
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l Early Warning – Absenteeism: This chart allows you to analyze daily
attendance for a group of students using the NYS definition of Absent-
eeism (Not at Risk, At Risk, or Chronically Absent).

Refer to the section on Available Charts for additional information about these
charts.

After selecting one of the chart options, the new chart will be added to the
dashboard using that chart’s default settings.

As with existing charts, users can click the Edit button to modify filter and
breakdown choices as well as chart type and color palettes for that chart. Once
applied, these changes will be visible for the duration of the user’s session and
can be saved for future use by clicking on the Save button on the Course
Attendance dashboard banner.
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To remove the second chart, simply click the Delete Chart button in the upper
right corner of the chart.

Working with Charts

By default, charts will display details about the selected filters below the chart title.

To hide this information, click the up arrow to collapse the filter details.

To view details for a specific data point, hover over it. The hover content for the
Absenteeism chart includes school year, absenteeism range (Less than 5%, 5-9%, 10%
or More), the percentage of students in the selected population that fall into that range,
and the number of students in that range out of the total number of students in the
selected population.
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Users with appropriate permissions will be able to drill down on the chart data. To drill
down on all data in the chart, right click anywhere on the chart and select Drill Down All.
A single data point on the graph can be drilled down by hovering over the bar and right
clicking to select Drill Down Selected Point (or Drill Down Selected Series, when clicking
on a specific series in a chart legend that includes multiple series).

A Drill Down tab will open up, showing the selected data. To sort in ascending or
descending order, click on the category name at the top of the chart. Users can also see
the filters applied to the drill down by clicking on the arrow to the right of the chart title.

To export chart data to a .csv file, click Export.
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Additional Information

Multiple drill downs can be open at a time and will appear as tabs at the top of
the chart. Please note only 10 drill down charts can be open at a time.

If you go back to apply different filters to the chart, the drill downs are still
available for the previous filters. A message will appear above the drill downs,
alerting that the drill down no longer matches the shown chart.

Please note that charts with records between 100,000 and 500,000 may take
extra time to export. Charts with more than 500,000 records will not be able to
export.

Available Charts

Early Warning - Absenteeism Chart

This chart allows users to identify students within a selected student
population (based on primary enrollments only) using the NYS definition of
Absenteeism:

l Chronically Absent (10% or More)
l At Risk (5 – 9 %)
l Not at Risk (Less than 5%)

These ranges are calculated as a percentage of days the student was absent
out of the total number of days the student was enrolled for that school year.
Note that these values are based on number of enrollment days for a student
per school year, regardless of the actual enrollment location. For example, a
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student who changes grades mid-year or a student who moves from one
program to another within the same district will be calculated using the total
enrollment days across all enrollments.

Once each student’s percentage has been calculated, those numbers are
rounded to the nearest tenth and placed in one of three pre-defined absence
ranges based on whole numbers (Not at Risk: Less than 5%, At Risk: 5 – 9 %,
Chronically Absent: 10% or More).

For example:

l A student percentage of 9.85 rounds to 9.9 and will be placed in the “5 to
9%” range

l A student percentage of 9.95 rounds to 10.0 and will be placed in the
“10% or More” range

A student’s absence is counted toward these totals if both of the following are
true:

l The student is enrolled for 10 or more instructional days and attended at
least 1 day during that period (instructional days do not include calendar
days where “Students Off” is checked)

l The absentee reason is configured with the “Count as Absence/In/Out”
flag checked.

Note: Students are not included in these calculations if the number of Absent
Days is equal to Enrollment Days

Course Attendance - Absence by Period Chart

The Absence by Period chart shows the number of absences that occurred in
each period.
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Notes:

l The Absence by Period chart does not include Supplementals (courses
not assigned to a period).

l This chart also excludes period misses that are due to suspensions (ISS
or OSS).

l Period misses that are due to daily absences are included here, and the
Absence Reason filter includes all appropriate Daily and Period absence
reasons.

Course Attendance - Absence by Course Chart

This chart is similar to the Absence by Period chart but it allows users to
analyze course attendance based on the course name, rather than the period.

Keep in mind that courses are labeled with the Course Name followed by
Course ID, but only the first 20 characters will be displayed (the full Course
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Name and ID will be visible when a user hovers over a data point). Also note
that, by default, the chart shows all courses for the current school year.

Users can slide the chart area left to right to scroll horizontally; as with other
charts, users can also use a mouse-wheel or “pinch to zoom” functionality to
zoom in or out. To reduce the number of courses shown, simply click the Edit
button and use the filter panel to choose the desired criteria.

Notes:

l As with the Absence by Period chart, the Absence by Course chart does
not include Supplementals (courses not assigned to a period).

l Multiple instances of the same course: If a student is scheduled for mul-
tiple sections of the same course, each section has its own absences and
will be counted independently. For example, a student enrolled in Phys Ed
Section 1 and Section 2 can be absent in either section or both. If the stu-
dent is absent from both sections, two separate absences will be recor-
ded for that course.

l Courses that meet in multiple periods: When a course section meets mul-
tiple times during the same day, SchoolTool only saves the last recorded
attendance submission; therefore, a maximum of one absence will be
counted for that course for a given day. For example, a student might
have a schedule where Chemistry meets during 1st period and again dur-
ing 4th period.

l If the student is marked present in 1st period but later marked
absent in 4th period, the present will be overwritten when the
absence is recorded later in the day, and thus would be counted as a
single absence.

l If the student is marked absent in 1st period but present in 4th
period, the absence will be overwritten by the present and will there-
fore not be included at all.
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l If the student is marked absent in both periods, this will count as a
single absence.

l Sections with multiple teachers: When breaking down by the Course
Teacher field, course absences may be counted multiple times for course
sections taught by multiple teachers. The chart will display a separate
data point for each individual teacher, and course absences will be dis-
played for each teacher. The drill down results will continue to display
each course absence only once, and the Course Teacher column will dis-
play all teachers for a given section, separated by a “/” character.

For example, let’s say Section 1 of English 11R is co-taught by Mr. Knox
and Mrs. Copeland. When breaking down by Course Teacher, you’ll see a
bar for Mr. Knox and another for Mrs. Copeland, and the totals for each
teacher will include student absences from their co-taught sections as
well as any sections that are taught individually.

When viewing the drill down results, users will see the both teachers
(“Copeland/Knox”) for that course section when hovering over the Course
Teacher column.
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Examples

Example 1: Identify Students at Risk of Becoming Chronically Absent

Let's say we want to identify students in our district who are already classified
as chronically absent and those that are currently at risk.

We can use the default filter settings because we'll be looking at the current
school year and all buildings. If you need to change your current filters,
however, you can do so by clicking on the Edit button in the Absenteeism
chart.

When viewing the chart, we can hover over the bars for the 5-9% and 10% or
More groups to see the number of students in each group. In this example, we
see that there are 5 students in the At Risk (5 to 9%) group and 3 students
already designated as Chronically Absent (10% or More).

Drilling down on each of those points will give us a list that includes the
students' names and enrollment information so that we can review their data
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further and determine next steps to assist them. We can also see each
student's percentage, which allows us to quickly identify which students are
closest to a 9% rate, and are therefore closest to becoming chronically absent.

Example 2: Compare Data Across Multiple Years for a Single Building

We can also use the Absenteeism chart to compare trends from year to year.
For example, we might want to see how our high school did over the last 3
years to determine whether any of the modifications we've made are having an
impact.

To begin, we'll click on the Edit button in the Absenteeism chart in order to
customize our filters.

We'll set our filters to include 2019-2020, 2018-2019, and 2017-2018 school
years, and select only the high school. After clicking Apply, we'll return to the
updated version of our chart.
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Our updated chart shows that we have a slight decrease from year to year in the
At Risk (5-9%) group and an overall drop in the Chronically Absent (10% or
More) group, but it also shows a slight increase in the Chronically Absent from
last year to this year.

Example 3: Analyzing How Enrollments Impact Absenteeism Trends

Let’s say we want to get an idea of how our district’s absenteeism totals for the
current year might be impacted by students who are no longer enrolled. To see
this, we’ll navigate to the Absenteeism chart on the Early Warning dashboard
and click Edit to open the Filter panel. We’ll leave our filters set to the default
(current school year for all students) but we’ll drag the Currently Enrolled filter
to the Breakdown By area.
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After we apply the change, we’ll see bars for “Enrolled” and “Not Enrolled” for
each Absence Range. In this case, the Chronically Absent range (10% or more)
is primarily made up of students who are not enrolled.

Now that we’ve seen how our unenrolled students are impacting our trends,
let’s say we want to review absenteeism trends from the last several years, but
we want to limit our results to only students who are currently enrolled. To do
this, we’ll click Edit on the Absenteeism chart to access the filter configuration
window again. We’ll change our breakdown back to School Year, and select the
appropriate values for the School Year filter (in this example, we’ll select the
past three years, starting with 2020-2021). For the Currently Enrolled filter, we’ll
select only “Enrolled” in order to see only current students.
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After we apply the changes, the chart will show only students who are currently
enrolled (in this case, our import jobs ran last night so the results show all
students who were actively enrolled yesterday). Note that students who were
enrolled during the selected years but have graduated will not be included in
this data, because those students are no longer enrolled.

Faculty View Dashboard
The Faculty View dashboard allows users to review multiple types of data for an
individual faculty member on one screen. Because of the way data is presented here,
this dashboard functions slightly differently from the other dashboards. This dashboard
can be accessed through Home > Dashboards or on a faculty record by clicking on the
Dashboards icon.

To begin using the Faculty View dashboard, users must first locate the teacher whose
data they wish to view. This may be accomplished by using the filters at the top of the
screen to narrow the list of faculty. In addition, users may search for a specific teacher
by name. To search, type the first and/or last name (or part of the name) in the Faculty
Name Search box and click Update Page Data or press the Enter key. All filters will
respect users’ building security rights.

After clicking the Update Page Data button (or pressing the Enter key), a list of teachers
meeting the selected criteria will appear below. Results are sorted alphabetically and
grouped by faculty last name.
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Note:  The search field works in conjunction with filter selections. Therefore, if a user
selects only “High School” from the School Name filter and types “Smith” in the faculty
name search field, the results will include only teachers in the High School whose name
contains “smith”.

Click on the appropriate teacher name; the Faculty View will then open in a new window.

The Faculty View dashboard provides the following charts:

l Final Course Scores
l Assessments
l SLO Target Met
l SLO Average Growth

If no data is available for a given chart, the chart will not be displayed on the dashboard.

To select a sub-set of school years for which to show data, click the Select Year(s)
button at the top of the screen.
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Select the desired years, then click Update Page Data.

Some charts include a “Show Average” checkbox option. When this option is checked,
the chart will display the data as an average of all course scores for each year, rather
than showing each year’s data as separate lines.

SLO Dashboard
The SLO (Student Learning Objectives) dashboard provides users with the ability to
review existing SLO data trends for percentages of students meeting SLO target scores
and average student growth. It also allows users to manipulate charts to see other
possible scenarios. For example, an administrator can adjust the target scores by a
specific percentage or number of points to see how the same data might look if a
different target score had been used.
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Note: The SLO dashboard shows only course sections that have active SLOs and will
only return data for students who have a Pre-Score and a Post-Score.

The SLO Target Met chart displays the percentage of students who met the SLO Target
and can be broken down by a number of options. To adjust the target and see how the
data might look if the target were different, enter a number (positive or negative) and
select either percent or points to indicate how the target should be adjusted.

When drilling down from the SLO Target Met chart, users will be presented with a new
chart that indicates how each student performed. If the target has been adjusted, the
drill-down chart will reflect the adjusted target as well. The SLO Data Points column
shows a visual representation of each student’s pre score, target score, and post score. 
Student growth is shown as either green, to indicate the student met the target score, or
red, to indicate the student did not meet the target. Users can drill down a second time
to obtain the student results list, which includes columns for adjusted target information
as well as the actual data.

The Average Student Growth chart shows the average difference between post score
and pre score for each student for each breakdown group. Use the minimum/maximum
fields to adjust the Y-axis (growth points) if needed.
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Home > Discussions
The Home > Discussions sub-module allows users to send and receive messages
directly within SchoolTool.

Note: Currently, all users with the Enter permissions for the Discussions sub-module will
be able to view received messages, but only teachers with the appropriate permissions
have the ability to initiate discussions.

This screen will display a list of all messages you have sent or received. To view a
message, simply click on the discussion's title on the left side of the screen.

When a discussion has new messages, an indicator will be displayed in the left-hand
pane.
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Sending Messages

Teachers can send a message by navigating to the Home > Discussions area and
clicking the Create New Discussion button in the upper right corner of the screen.

The New Message screen will appear with options to locate the recipients you wish to
sent a message to. Depending on district settings, you may be able to initiate a
discussion with any students in buildings/school levels you have access to, or only to
students in your current classes. You may also have the ability to send to students'
primary contacts and/or other faculty.

Use the radio buttons to choose whether to locate recipients (to send to primary
contacts, select Student). Depending on which option you have selected, additional
drop-downs will appear, allowing you to locate the desired recipients. Using the options,
select the recipients and add them to the recipients list at the bottom of the screen. As
you add recipients, a grid will display showing a list of all individuals who will receive
this message.
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Sending to Students/Primary Contacts:

Note: To send to a student, be sure that the "Include" drop-down is set to "Student Only;"
to send to primary contacts, set the "Include" drop-down to "Primary Contact Only."
When sending to primary contacts, you will then locate the student(s) whose primary
contact you wish to include. If you wish to send a message to a student and that
student's primary contact, set it to "Both."

l To send to students in your classes, use the Course and Student drop-downs to
locate the student and click Add to add them to the list of recipients below. The
Course drop-down is used to filter the Student list based on a specific class roster.
The Student drop-down contains a list of all active students in any of that teacher’s
classes (or in the selected class).

l To send to students in a building you have access to, enter a student's name or ID
in the Student field. You may also filter the results based on building and/or school
level. Select the appropriate students from the results list by clicking on the stu-
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dent's name.

Sending to Faculty

l To send to faculty members, use the drop-downs to filter the list of faculty. Select
the desired faculty members from the list (note that only active faculty will be lis-
ted here) and click Add to add them to the list of recipients below.

After selecting students and/or faculty and entering the desired message, review the list
of recipients and click the Send button (or click Cancel to return to the main Discussions
screen).
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A confirmation message will appear, indicating that the message was successfully sent.

To view a list of participants in a discussion, hover your mouse over the Participants
icon.
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To add additional participants, click the Add button within the Participants
mouseover.

Use the Edit Discussion screen to add participants using the process described above
for creating discussions.
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After recipients have been added, you will see a message to that effect in the main
Discussion window.

Receiving Messages

After a message has been sent to a student, the student can navigate to the Home >
Discussions sub-module to retrieve it. When accessing the Discussions screen,
students will see a list of all received messages displayed, with the most recent
message at the top. Each message will show the sender’s name and the body of the
message.

To reply, simply enter the desired message in the text entry box at the top of the
discussion pane and click Reply to send it.
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Home > Forms
The Home > Forms sub-module displays a list of any forms you have created, and/or
any forms awaiting responses from you.

My Forms

If you have permissions to create forms, the top section of this screen will display a list
of any forms you have created. Mouse over a form's name to view its description, if one
is available.

To add a new form, click the Add button (this is available based on permissions).

Options:

l Distribute Form - allows you to deliver the form to users for responses.
l View Responses - allows you to view results
l Edit Form - allows you to edit the form
l Delete Form - allows you to delete the form (this option is only available if the

form has not been distributed)
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You may sort the grid by clicking on the heading for any column. To filter either grid
based on the values in one or more column, simply click on the Filter icon for the
desired column(s). Filters are specific to each grid (for example, filtering to view only
Active forms). Filters will be remembered for each user and will be re-applied the next
time you access this screen.

Enter the desired text in the field that appears (the rows will automatically filter as you
type). Close the filter field by pressing Enter or by clicking outside the filter field.

The Filter button will change to the Active Filter icon to indicate when a filter is active.
To remove a filter, simply click on the Active Filter icon and delete the text in that
field. Press Enter or click outside the filter field to update the results.

Distribute a Form:

Teachers can distribute forms to other SchoolTool users by clicking the Distribute Form
button.

The Select Recipients screen will appear with options to locate the recipients you wish
to deliver this form to. Depending on district settings, you may be able to deliver forms
to any students in buildings/school levels you have access to, or only to students in your
current classes. You may also have the ability to deliver it to students' primary contacts
and/or other faculty.

Use the radio buttons to choose whether to locate recipients (to deliver to primary
contacts, select Student). Depending on which option you have selected, additional
drop-downs will appear, allowing you to locate the desired recipient.

Distributing to Students/Primary Contacts:
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Note: To distribute forms to a student, be sure that the "Include" drop-down is set to
"Student Only;" to send to primary contacts, set the "Include" drop-down to "Primary
Contact Only." When delivering to primary contacts, you will then locate the student
whose primary contact you wish to include.

l To send to students in your courses, use the Course and Student drop-downs to
locate the desired students. The Course drop-down is used to filter the Student list
based on a specific class roster. The Student drop-down contains a list of all act-
ive students in any of that teacher’s classes (or in the selected class). Click the
Add button to add the selected student(s) to the recipients list.

l To send to a student in a building you have access to, enter a student's name or ID
in the Student field. You may also filter the results based on building and/or school
level. Select the appropriate student from the results list to add the student as a
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recipient.

Distributing to Faculty

l To deliver forms to a faculty member, use the drop-downs to filter the list of fac-
ulty. Select the desired faculty member from the list (note that only active faculty
will be listed here). Click the Add button to add the selected faculty member(s) to
the recipients list.

After selecting recipients, click the Distribute Form button to deliver the form and return
to the main Forms screen.
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Edit a Form:

To edit a form, click the Edit Form button. Modify the form as needed and click Save
to apply your changes.

View Responses:

Click the View Responses button to review all responses to a form. Students who
have received the form but have not submitted a response will be listed here without any
answers.
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My Responses

If you have received forms from another user, you will see a My Responses section
listing all forms awaiting response.

To respond, click the Respond button. The form will open in a pop-up window.
Complete all fields as appropriate and click the Submit button.
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Note: When assuming another user's account or identity, you will be unable to submit
responses on behalf of that user.

Create a Form
To create a form, begin by clicking the Add button (or click Edit to modify an existing
form).

Enter the name of your form (required) and a description (optional). Specify whether or
not the form is Active (inactive forms cannot be distributed). Use the "Allow Resubmit"
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option to specify whether or not recipients can submit multiple responses to the same
form.

Add or edit your questions as needed and click Save when you are finished.

Adding and Modifying Questions on a Form:

You may add as many questions as you wish. To add a question, select the desired
question type and click the Add button. Use the drag-and-drop arrows to reorder
questions on a form. Click Delete to remove a question (this option is only available if
the form has not yet been distributed).

Currently available question types include Short Answer, Long Answer, and Multiple
Choice; additional question types will be added in the future.

l Short Answer: This question type allows recipients to enter up to 255 characters of
plain text as an answer.

l Long Answer: This question type allows recipients to enter up to 1000 characters
of plain text as an answer.

l Multiple Choice: This question type allows recipients to choose between a number
of answers using radio buttons or checkboxes. To add possible answers, simply
click in the Answer field, type the answer text, and click Add. Use the Delete but-
ton to remove an answer or use the drag-and-drop arrows to reorder answers
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(the Delete option is only available if the form has not yet been distributed).

Home > Virtual Classroom
The Discussions screen shows a list of all discussions to which you have access, the
status and the number of new messages in each discussion, and links to relevant
attachments posted by the teacher.

Open discussions allow all participants to post messages, Read-Only discussions can
be viewed by all participants but only faculty can post messages, and Archived
discussions are only visible to faculty. Use the checkbox to show archived discussions.

Teachers can create new discussions and manage existing discussions. To create a
new discussion, click the Add  button.

A pop-up window will appear. Enter a name for the discussion, set its status (Open,
Read-Only, or Archived), specify whether the discussion should be moderated or not
(moderated discussions require teacher approval on all student comments), select a
section to determine which students can participate, and upload any attachments as
needed.
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To enter a discussion, Select it from the list. The discussion window will open as a
pop-up and can be resized as desired.

Additionally, users with permission to see the Discussions  icon will see a count of
all unread messages in their discussions in the upper right corner of the screen.

Hover the mouse over the icon to see a list of all available discussions and click on a
discussion name to access it.

The Discussion Window
The discussion window allows users to interact with other participants in real-time. If
you have rights to post in this discussion, you will be presented with a text entry area at
the bottom of the screen. The text entry area includes some basic formatting tools. To
enter a comment, simply type the desired text, format it if desired, and press the Enter
key.

Posts by faculty will be shaded blue, while students will appear in white.
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To view attachments from within the discussion window, click on the Menu link in the
upper right and select the appropriate attachment to download from the drop-down.

All users have the ability to delete their own comments using the Delete  button next to
the comment to be removed. Teachers have the ability to delete all users’ comments.
Users will no longer be able to see the original comment text, and instead will see an
indicator that the comment has been deleted.
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Moderated Discussions

Teachers have the ability to designate any discussion as moderated. In a moderated
discussion, all comments by students must be approved before they become visible to
the other participants.

When a student posts a comment in a moderated discussion, only the teacher and the
student who entered the comment will be able to see the comment until it has been
approved. Comments awaiting approval will show as Pending in the discussion window
for the student who entered it.

Teachers will see an Approve button next to all pending comments.
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To approve a single post, simply click the Approve button, or hover over the button to
select “Approve this comment” from the menu. Click “Approve all from this user” to
approve all of that student’s pending comments in a single operation.

Note: Once a comment is approved, it will be visible to all users in the discussion. If you
do not want to approve a comment, you may leave it in “Pending” state, or you can click
the Delete  button to delete it.

After a comment has been approved, an “Approved” indicator will appear in place of the
Approve button.

Teachers also have the ability to approve all pending comments for the entire
discussion. To do this, click on the Menu icon and select “Approve all comments”
from the menu.
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Attendance Module
Teachers are generally given limited access to the Attendance module to see daily
absences, whether students might be in or out during class, and/or to generate daily
rosters. When you select the Attendance module link at the top of the screen, the
Today’s Attendance sub-module will appear. Here, you can to see all absences, late
arrivals, ins and outs, and early dismissals for the day.

Note: The Attendance sub-module respects the school calendar, as set up in
Maintenance. This includes grade-specific calendar entries, such as days where all
students in a certain grade level are scheduled to be out of school (all ninth graders are
on a school trip, or Regents testing days, for example).

Today’s Attendance Sub-module
When you select the Attendance module link at the top of the screen, the Today’s
Attendance sub-module will appear. Here, you’ll be able to see all absences, late arrivals,
ins and outs, and early dismissals for the day.

Daily Roster Report Sub-module
Use the Daily Roster Report sub-module to generate lists of rosters which can be given
to substitute teachers.
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1. Select the Cycle Day, Period, and Semester for which you will generate one or
more rosters.

2. Select a Course from the drop-down list. The default is to print rosters for ALL
courses. If you select a single course, only rosters for that course will appear.

3. Select a Faculty from the drop-down list. The default is to print rosters for ALL
faculty. If you select a single faculty, only rosters for that faculty’s courses will
appear.

4. If you wish to show students' Home Districts on the report, check that option
on the pre-screen.

5. Click once on Run Report. The Daily Roster report will appear in a separate
report viewer. This report contains a listing of all students in the course, includ-
ing their IDs, gender, grade, counselor (if assigned), dates of birth, and Home
District (if assigned). Totals for the class, and gender breakdown appear at the
bottom of each roster report.

8
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Note: This module may or not be available to you. Please contact your
SchoolTool liaison for more information about this sub-module.

Discipline Incidents
Teachers can generally access a student's Discipline record from within the Discipline
tab on the student record by navigating to the appropriate student record from within
the Roster tab.

A student's Discipline tab shows a history of discipline incidents you have entered (if
any), and, if the district uses points for discipline incidents, the student’s accumulated
points for that year. Use the year drop-down to review historical data for a previous year.

Depending on user permissions and district settings, users may be able to see all
incidents for that student or only those for which a “Date Seen” has been entered.

Faculty members can also see any incident they have submitted. In addition, some
users may also be able to add, edit, or delete student incidents from the My Home >
Discipline tab.

Viewing Incidents
1. Navigate to the Roster tab for the appropriate class. A list of students in the

class will appear.

2. Select a student by clicking the Select button to the right of the student’s
name. The student’s Personal Information record will appear.
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Note: If the student is not in one of your classes, you may need to use the
Search feature to find the student.

3. Select the Discipline tab from the group of tabs towards the bottom of the stu-
dent record. The discipline information will display.

Note: If there are no incident records, the tab will appear with headings only
and no data. Once an incident has been entered, existing records will display as
shown.

Entering a New Discipline Incident
1. Click the Create New button on the right side of the discipline tab and select

whether you wish to enter a classroom incident or a referral.
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2. Fill in all appropriate fields. All pink fields are required.
l Person Type (radio buttons): the default is the Offender, but you can

select the Victim radio button (referrals only)
l Building/School Level (required, drop-down lists): these values default to

the student’s Building/School Level, but may be changed to reflect the
incident location.

l Date of Incident (required, date field): the date will default to today’s date,
but you may alter it by choosing a new date from the pop-up calendar, or
by manually entering a new date in the mm/dd/yyyy format. Use the
checkbox to indicate if this incident occurred During School Hours. This
is selected by default.

l Time of Incident (drop-down lists): the time will default to the current
time, but may be modified by selecting new values from the drop-down
lists. Check the “Unknown” option if the time is unknown.

Note: This is an optional field that may not appear on all incidents
depending on district settings.

l Teacher: the Teacher’s name defaults to your name since you are enter-
ing the incident.

l Location (drop-down list): select the place where the offense occurred.
l Offense (drop-down list): select the student’s offense and wait for the

screen to refresh. Use the Add Additional Offenses button to add mul-
tiple offenses.

l Description of Incident (required, free-text, up to 255 characters): enter a
free-text description by typing into the field, or copying and pasting from
another source.

l Corrective Steps Taken (checkboxes): select the action(s) taken by the
faculty member entering the incident.
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l Previous Actions Taken (free text): This in an optional, free-text field
which allows you to detail any previous actions that may have been taken
and did not require an official record.

l Comments (optional, free-text): enter any comments.

Note: Use the Check Spelling button in the upper right corner of the
Discipline tab to check the spelling of any free-text comments. Once you
have saved your work, you cannot use this feature.

Note: SchoolTool allows any user with access to a discipline referral to
enter free-text comments into these fields. However, always follow
district procedures regarding the logging of incidents and the use of each
field. This may vary from building to building.

l Number of Non District Victims (required, numeric): this field defaults to
zero. This might be used if the incident happened on school grounds
when students from another school were visiting for a performance or
sporting event and were injured or victimized (referrals only).

l Number of Non District Offenders (required, numeric): this field defaults
to zero. This might be used if the incident happened on school grounds
when students from another school were visiting for a performance or
sporting event and committed some act of vandalism, theft, or violence
(referrals only).

l Victims (optional, batch selector): If there was a district victim involved in
this incident, you could add them to the discipline referral by clicking on
the Add Additional Victims button. This action opens up the Batch
Selector allowing you to search for the additional victims. Faculty can
also be added as Victims by clicking on the Add Faculty button (refer-
rals only).

l Offenders (optional, batch selector): If there are additional district offend-
ers involved in this incident, you could add them to the discipline referral
by clicking the Add Additional Offenders button. This action opens up
the Batch Selector allowing you to search for the additional offenders.
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Faculty can also be added as Offenders by clicking on the Add Faculty
button (referrals only).

l Attachments (optional): You can upload an attachment to any referral
record. Use the Browse button to locate the file (this could be a scanned
file of a threat, a .pdf file of a test the student cheated on, etc.). Once you
have located the file, click the Upload Attachment button (referrals only).

3. When you have completed the incident form, click once on the Save button in
the upper right corner of the record.

Note: If you try to save this record without completing the required fields, an
error will result.

After a successful save, the Discipline tab will refresh to show you what you
have entered in read-only format.

4. Click the Done button in the upper right corner of the Discipline tab. The tab
will refresh displaying the incident you added in a list format, along with any
other previously existing incidents.



Teacher User Guide Page 366 of 372
SchoolTool Version 20.0 © 2022 Mindex Modified 8/3/2022

Note: Depending on your district permissions, after you have saved the
incident, you may be able to view, edit, or delete your work. See your
SchoolTool liaison for more information on your rights.

Note: Teachers can only see incidents that they themselves have added for this
student. Incidents are considered confidential, and teachers are not granted
access to see the history of incidents for a student, as entered by other staff.
Only school disciplinarians can see a complete view of all incidents.

Note: Once the incident has been saved, it automatically appears in a list of
Students to See for the designated disciplinarian. This person can then review
the record, meet with the student, and assign a disposition for the offense.
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